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Network environment

 

Network and wireless models only (see "Features by models" on page 6)

 

You need to set up the network protocols on the machine to use it as your network machine. The following table shows the network 
environments supported by the machine.
 

Free HDD space Up to 100 MB

Items Specifications

Network interface • Ethernet 10/100 Base-TX Wired Lan

• 802.11b/g/n Wireless LAN

Network operating system • Windows 2000/Server 2003 /Server 2008/XP/Vista/7/Server 2008 R2

• Various Linux OS

• Mac OS X 10.4 ~ 10.6

• Unix

Items Requirements
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Network protocols • TCP/IPv4

• DHCP, BOOTP

• DNS, WINS, Bonjour, SLP, UPnP

• Standard TCP/IP Printing (RAW), LPR, IPP, WSD

• SNMPv 1/2/3, HTTP, IPSec

• TCP/IPv6 (DHCP, DNS, RAW, LPR, SNMPv 1/2/3, HTTP, IPSec)

Wireless security • Authentication: Open System, Shared Key, WPA Personal, WPA2 Personal (PSK)

• Encryption: WEP64, WEP128, TKIP, AES

Items Specifications
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This machine is designed for a normal work environment and 
certified with several regulatory statements.

5 

Laser safety statement

The printer is certified in the U.S. to conform to the requirements of 
DHHS 21 CFR, chapter 1 Subchapter J for Class I(1) laser products, 
and elsewhere is certified as a Class I laser product conforming to the 
requirements of IEC 60825-1 : 2007.

Class I laser products are not considered to be hazardous. The laser 
system and printer are designed so there is never any human access 
to laser radiation above a Class I level during normal operation, user 
maintenance or prescribed service condition.

Warning 

Never operate or service the printer with the protective cover 
removed from laser/scanner assembly. The reflected beam, 
although invisible, can damage your eyes.

When using this product, these basic safety precautions should 
always be followed to reduce risk of fire, electric shock, and injury to 
persons:

6 

Ozone safety

This product’s ozone emission rate is under 0.1 ppm. 
Because ozone is heavier than air, keep the product in 
a place with good ventilation.
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Mercury Safety

8 

Power saver

9 

Recycling

10 

China only

Contains Mercury, Dispose According to Local, State or 
Federal Laws.(U.S.A. only)

This printer contains advanced energy conservation 
technology that reduces power consumption when it is 
not in active use.

When the printer does not receive data for an extended 
period of time, power consumption is automatically 
lowered. 

ENERGY STAR and the ENERGY STAR mark are 
registered U.S. marks. 

For more information on the ENERGY STAR program 
see http://www.energystar.gov

Recycle or dispose of the packaging material for this 
product in an environmentally responsible manner.
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Correct disposal of this product (Waste 
electrical & electronic equipment)

(Applicable in the european union and other 
european countries with separate collection 
systems)

(The United States of America only)

Dispose unwanted electronics through an approved recycler. To find 
the nearest recycling location, go to our website: 
www.samsung.com/recyclingdirect Or call, (877) 278 - 0799

12 

Correct disposal of batteries in this product

(Applicable in the European Union and other 
European countries with separate battery return 
systems.)

This marking on the product, accessories or literature 
indicates that the product and its electronic accessories (e.g. 
charger, headset, USB cable) should not be disposed of with 
other household waste at the end of their working life. To 
prevent possible harm to the environment or human health 
from uncontrolled waste disposal, please separate these 
items from other s of waste and recycle them responsibly to 
promote the sustainable reuse of material resources.

Household users should contact either the retailer where they 
purchased this product, or their local government office, for 
details of where and how they can take these items for 
environmentally safe recycling.

Business users should contact their supplier and check the 
terms and conditions of the purchase contract. This product 
and its electronic accessories should not be mixed with other 
commercial wastes for disposal.

This marking on the battery, manual or packaging 
indicates that the batteries in this product should not be 
disposed with other household waste at the end of their 
working life. Where marked, the chemical symbols Hg, Cd 
or Pb indicate that the battery contains mercury, cadmium 
or lead above the reference levels in EC Directive 2006/66. 
If batteries are not properly disposed of, these substances 
can cause harm to human health or the environment. To 
protect natural resources and to promote material reuse, 
please separate batteries from other s of waste and recycle 
them through your local, free battery return system.
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Taiwan only

14 

Radio frequency emissions

FCC information to the user

This device complies with Part 15 of the FCC Rules. Operation is 
subject to the following two conditions: 

• This device may not cause harmful interference, and

• This device must accept any interference received, including 
interference that may cause undesired operation.

This equipment has been tested and found to comply with the limits 
for a Class B digital device, pursuant to Part 15 of the FCC Rules. 
These limits are designed to provide reasonable protection against 
harmful interference in a residential installation. This equipment 
generates, uses and can radiate radio frequency energy and, if not 
installed and used in accordance with the instructions, may cause 
harmful interference to radio communications. However, there is no 
guarantee that interference will not occur in a particular installation. 
If this equipment does cause harmful interference to radio or 
television reception, which can be determined by turning the 
equipment off and on, the user is encouraged to try to correct the 
interference by one or more of the following measures:

• Reorient or relocate the receiving antenna.

• Increase the separation between the equipment and receiver.

• Connect the equipment into an outlet on a circuit different from 
that to which the receiver is connected.

• Consult the dealer or experienced radio TV technician for help.

 

Change or modifications not expressly approved by the 
manufacturer responsible for compliance could void the 
user's authority to operate the equipment.
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Canadian radio interference regulations

This digital apparatus does not exceed the Class B limits for radio 
noise emissions from digital apparatus as set out in the interference-
causing equipment standard entitled “Digital Apparatus”, ICES-003 
of the Industry and Science Canada.

Cet appareil numérique respecte les limites de bruits 
radioélectriques applicables aux appareils numériques de Classe B 
prescrites dans la norme sur le matériel brouilleur: “Appareils 
Numériques”, ICES-003 édictée par l’Industrie et Sciences Canada.
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United States of America

Federal Communications Commission (FCC)

� Intentional emitter per FCC Part 15

Low power, Radio LAN  devices (radio frequency (RF) wireless 
communication devices), operating in the 2.4 GHz/5 GHz Band, may 
be present (embedded) in your printer system. This section is only 
applicable if these devices are present. Refer to the system label to 
verify the presence of wireless devices.

Wireless devices that may be in your system are only qualified for use 
in the United States of America if an FCC ID number is on the system 
label.

The FCC has set a general guideline of 20 cm (8 inches) separation 
between the device and the body, for use of a wireless device near 
the body (this does not include extremities). This device should be 
used more than 20 cm (8 inches) from the body when wireless 
devices are on. The power output of the wireless device (or devices), 
which may be embedded in your printer, is well below the RF 
exposure limits as set by the FCC.

This transmitter must not be collocated or operation in conjunction 
with any other antenna or transmitter.

Operation of this device is subject to the following two conditions: 
(1) This device may not cause harmful interference, and (2) this 
device must accept any interference received, including interference 
that may cause undesired operation of the device.

 

Wireless devices are not user serviceable. Do not modify 
them in any way. Modification to a wireless device will void 
the authorization to use it. Contact manufacturer for service.
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FCC Statement for Wireless LAN use:

 

While installing and operating this transmitter and antenna 
combination the radio frequency exposure limit of 1m W/
cm2 may be exceeded at distances close to the antenna 
installed. Therefore, the user must maintain a minimum 
distance of 20cm from the antenna at all times. This device 
cannot be colocated with another transmitter and 
transmitting antenna.

 

16 

Russia only

17 

Germany only

18 

Turkey only

19 

Canada only

This product meets the applicable Industry Canada technical 
specifications. / Le present materiel est conforme aux specifications 
techniques applicables d’Industrie Canada.
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The Ringer Equivalence Number (REN) is an indication of the 
maximum number of devices allowed to be connected to a 
telephone interface. The termination of an interface may consist of 
any combination of devices subject only to the requirement that the 
sum of the RENs of all the devices not exceed five. / L’indice 
d’equivalence de la sonnerie (IES) sert a indiquer le nombre maximal 
de terminaux qui peuvent etre raccordes a une interface 
telephonique. La terminaison d’une interface peut consister en une 
combinaison quelconque de dispositifs, a la seule condition que la 
somme d’indices d’equivalence de la sonnerie de tous les dispositifs 
n’excede pas cinq.

20 

Fax Branding

The Telephone Consumer Protection Act of 1991 makes it unlawful 
for any person to use a computer or other electronic device to send 
any message via a telephone facsimile machine unless such message 
clearly contains in a margin at the top or bottom of each transmitted 
page or on the first page of the transmission the following 
information:

1 the date and time of transmission

2 identification of either business, business entity or individual 
sending the message; and

3 telephone number of either the sending machine, business, 
business entity or individual.

The Telephone Company may make changes in its communications 
facilities, equipment operations or procedures where such action is 
reasonably required in the operation of its business and is not 
inconsistent with the rules and regulations in FCC Part 68. If such 
changes can be reasonably expected to render any customer 
terminal equipment incompatible with telephone company 
communications facilities, or require modification or alteration of 
such terminal equipment, or otherwise materially affect its use or 
performance, the customer shall be given adequate notice in 
writing, to allow the customer an opportunity to maintain 
uninterrupted service

21 

Ringer Equivalence Number

The Ringer Equivalence Number and FCC Registration Number for 
this machine may be found on the label located on the bottom or 
rear of the machine. In some instances you may need to provide 
these numbers to the telephone company.
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The Ringer Equivalence Number (REN) is a measure of the electrical 
load placed on the telephone line, and is useful for determining 
whether you have “overloaded” the line. Installing several s of 
equipment on the same telephone line may result in problems 
making and receiving telephone calls, especially ringing when your 
line is called. The sum of all Ringer Equivalence Numbers of the 
equipment on your telephone line should be less than five in order 
to assure proper service from the telephone company. In some cases, 
a sum of five may not be usable on your line. If any of your telephone 
equipment is not operating properly, you should immediately 
remove it from your telephone line, as it may cause harm to the 
telephone network.

The equipment complies with Part 68 of the FCC rules and the 
requirements adopted by the ACTA. On the rear of this equipment is 
a label that contains, among other information, a product identifier 
in the format US:AAAEQ##TXXXX. If requested, this number must be 
provided to the telephone company.

 

FCC Regulations state that changes or modifications to this 
equipment not expressly approved by the manufacturer 
could void the user’s authority to operate this equipment. In 
the event that terminal equipment causes harm to the 
telephone network, the telephone company should notify 
the customer that service may be stopped. However, where 
prior notice is impractical, the company may temporarily 
cease service, providing that they:
a promptly notify the customer.
b give the customer an opportunity to correct the 

equipment problem.
c inform the customer of the right to bring a complaint to 

the Federal Communication Commission pursuant to 
procedures set out in FCC Rules and Regulations Subpart E 
of Part 68.

 

You should also know that:

• Your machine is not designed to be connected to a digital PBX 
system.

• If you intend to use a computer modem or fax modem on the 
same phone line as your machine, you may experience 
transmission and reception problems with all the equipment. It is 
recommended that no other equipment, except for a regular 
telephone, share the line with your machine.



Regulatory information 1115. Appendix

• If your area experiences a high incidence of lightning or power 
surges, we recommend that you install surge protectors for both 
the power and the telephone lines. Surge protectors can be 
purchased from your dealer or telephone and electronic 
specialty stores.

• When programming emergency numbers and/or making test 
calls to emergency numbers, use a non-emergency number to 
advise the emergency service dispatcher of your intentions. The 
dispatcher will give you further instructions on how to actually 
test the emergency number.

• This machine may not be used on coin service or party lines.

• This machine provides magnetic coupling to hearing aids.

You may safely connect this equipment to the telephone network by 
means of a standard modular jack, USOC RJ-11C.

22 

Replacing the Fitted Plug (for UK Only)

Important

The mains lead for this machine is fitted with a standard (BS 1363) 13 
amp plug and has a 13 amp fuse. When you change or examine the 
fuse, you must re-fit the correct 13 amp fuse. You then need to 
replace the fuse cover. If you have lost the fuse cover, do not use the 
plug until you have another fuse cover. 

Contact the people from you purchased the machine.

The 13 amp plug is the most widely used  in the UK and should be 
suitable. However, some buildings (mainly old ones) do not have 
normal 13 amp plug sockets. You need to buy a suitable plug 
adaptor. Do not remove the moulded plug.

 

If you cut off the moulded plug, get rid of it straight away.

You cannot rewire the plug and you may receive an electric 
shock if you plug it into a socket.

 

Important warning: 

If the wires in the mains lead do not match the colors marked in your 
plug, do the following:

You must connect the green and yellow wire to the pin marked by 
the letter “E” or by the safety ‘Earth symbol’ or colored green and 
yellow or green.

You must earth this machine.

The wires in the mains lead have the following color code:

• Green and Yellow: Earth

• Blue: Neutral

• Brown: Live
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You must connect the blue wire to the pin which is marked with the 
letter “N” or colored black.

You must connect the brown wire to the pin which is marked with 
the letter “L” or colored red.

You must have a 13 amp fuse in the plug, adaptor, or at the 
distribution board.

23 

Declaration of conformity (European 
countries)

Approvals and Certifications

January 1, 1995: Council Directive 2006/95/EC Approximation of 
the laws of the member states related to low voltage equipment.

January 1, 1996: Council Directive 2004/108/EC, approximation of 
the laws of the Member States related to electromagnetic 
compatibility.

March 9, 1999: Council Directive 1999/5/EC on radio equipment 
and telecommunications terminal equipment and the mutual 
recognition of their conformity. A full declaration, defining the 
relevant Directives and referenced standards can be obtained from 
your Samsung Electronics Co., Ltd. representative.

EC Certification

Certification to 1999/5/EC Radio Equipment & Telecommunications 
Terminal Equipment Directive (FAX)

This Samsung product has been self-certified by Samsung for pan-
European single terminal connection to the analogue public 
switched telephone network (PSTN) in accordance with Directive 
1999/5/EC. The product has been designed to work with the national 
PSTNs and compatible PBXs of the European countries:

In the event of problems, you should contact the Euro QA Lab of 
Samsung Electronics Co., Ltd. in the first instance.

• Hereby, Samsung Electronics, declares that this [SCX-
472xFD Series, SCX-472xFH Series] is in compliance with 
the essential requirements and other relevant provisions 
of R&TTE Directive 1999/5/EC.

• Hereby, Samsung Electronics, declares that this [SCX-
472xFW Series] is in compliance with the essential 
requirements and other relevant provisions of R&TTE 
Directive 1999/5/EC.

The declaration of conformity may be consulted at 
www.samsung.com/printer, go to Support > Download 
center and enter your printer (MFP) name to browse the 
EuDoC. 
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The product has been tested against TBR21. To assist in the use and 
application of terminal equipment which complies with this 
standard, the European Telecommunication Standards Institute 
(ETSI) has issued an advisory document (EG 201 121) which contains 
notes and additional requirements to ensure network compatibility 
of TBR21 terminals. The product has been designed against, and is 
fully compliant with, all of the relevant advisory notes contained in 
this document.

European radio approval information (for products 
fitted with EU-approved radio devices)

Low power, Radio LAN type devices (radio frequency (RF) wireless 
communication devices), operating in the 2.4 GHz/5 GHz band, may 
be present (embedded) in your printer system which is intended for 
home or office use. This section is only applicable if these devices are 
present. Refer to the system label to verify the presence of wireless 
devices.

The power output of the wireless device or devices that may be 
embedded in you printer is well below the RF exposure limits as set 
by the European Commission through the R&TTE directive.

� European states qualified under wireless approvals:

EU countries

� European states with restrictions on use:

EU

In France, the frequency range is restricted to 2454-2483.5 MHz for 
devices above 10 mW transmitting power such as wireless

EEA/EFTA countries

No limitations at this time

24 

Israel only

Wireless devices that may be in your system are 
only qualified for use in the European Union or 
associated areas if a CE mark with a Notified 
Body Registration Number and the Alert 
Symbol is on the system label.
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Regulatory compliance statements

Wireless guidance

Low power, Radio LAN  devices (radio frequency (RF) wireless 
communication devices), operating in the 2.4 GHz/5 GHz Band, may 
be present (embedded) in your printer system. The following section 
is a general overview of considerations while operating a wireless 
device.

Additional limitations, cautions, and concerns for specific countries 
are listed in the specific country sections (or country group sections). 
The wireless devices in your system are only qualified for use in the 
countries identified by the Radio Approval Marks on the system 
rating label. If the country you will be using the wireless device in, is 
not listed, contact your local Radio Approval agency for 
requirements. Wireless devices are closely regulated and use may 
not be allowed.

The power output of the wireless device or devices that may be 
embedded in your printer is well below the RF exposure limits as 
known at this time. Because the wireless devices (which may be 
embedded into your printer) emit less energy than is allowed in 
radio frequency safety standards and recommendations, 
manufacturer believes these devices are safe for use. Regardless of 
the power levels, care should be taken to minimize human contact 
during normal operation.

As a general guideline, a separation of 20 cm (8 inches) between the 
wireless device and the body, for use of a wireless device near the 
body (this does not include extremities) is typical. This device should 
be used more than 20 cm (8 inches) from the body when wireless 
devices are on and transmitting.

This transmitter must not be collocated or operation in conjunction 
with any other antenna or transmitter.

Some circumstances require restrictions on wireless devices. 
Examples of common restrictions are listed below:

Radio frequency wireless communication can interfere with 
equipment on commercial aircraft. Current aviation 
regulations require wireless devices to be turned off while 
traveling in an airplane. IEEE 802.11 (also known as wireless 
Ethernet) and Bluetooth communication devices are 
examples of devices that provide wireless communication.
In environments where the risk of interference to other 
devices or services is harmful or perceived as harmful, the 
option to use a wireless device may be restricted or 
eliminated. Airports, Hospitals, and Oxygen or flammable gas 
laden atmospheres are limited examples where use of 
wireless devices may be restricted or eliminated. When in 
environments where you are uncertain of the sanction to use 
wireless devices, ask the applicable authority for 
authorization prior to use or turning on the wireless device.
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Every country has different restrictions on the use of wireless 
devices. Since your system is equipped with a wireless device, 
when traveling between countries with your system, check 
with the local Radio Approval authorities prior to any move or 
trip for any restrictions on the use of a wireless device in the 
destination country.
If your system came equipped with an internal embedded 
wireless device, do not operate the wireless device unless all 
covers and shields are in place and the system is fully 
assembled.
Wireless devices are not user serviceable. Do not modify them 
in any way. Modification to a wireless device will void the 
authorization to use it. Contact manufacturer for service.
Only use drivers approved for the country in which the device 
will be used. See the manufacturer System Restoration Kit, or 
contact manufacturer Technical Support for additional 
information.
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China only
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© 2010 Samsung Electronics Co., Ltd. All rights reserved.

This user’s guide is provided for information purposes only. All information included herein is subject to change without notice.

Samsung Electronics is not responsible for any direct or indirect damages, arising from or related to use of this user’s guide.

• Samsung and the Samsung logo are trademarks of Samsung Electronics Co., Ltd.

• Microsoft, Windows, Windows Vista, Windows 7, and Windows Server 2008 R2 are either registered trademarks or trademarks of Microsoft 
Corporation.

• True, LaserWriter, and Macintosh are trademarks of Apple Computer, Inc.

• All other brand or product names are trademarks of their respective companies or organizations.

Refer to the 'LICENSE.txt' file in the provided CD-ROM for the open source license information.

REV. 0.98
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1. Software installation
This chapter provides instructions for installing essential and helpful software 
for use in an environment where the machine is connected via a cable. A locally 
connected machine is a machine directly attached to your computer using the 
cable. If your machine is attached to a network, skip the following steps below 
and go on to installing a network connected machine’s driver (see "Installing 
driver over the network" on page 17).

• Installation for Macintosh 5

• Reinstallation for Macintosh 7

• Installation for Linux 8

• Reinstallation for Linux 10

� • If you are a Windows OS user, refer to the Basic Guide for installing the 
machine’s driver.

• Only use a USB cable no longer then 3 meter (118 inches).



51. Software installationInstallation for Macintosh

1 Make sure that the machine is connected to your computer 
and powered on.

2 Insert the supplied software CD into your CD-ROM drive.

3 Double-click the CD-ROM icon that appears on your 
Macintosh desktop.

4 Double-click the MAC_Installer folder > Installer OS X icon.

5 Click Continue.

6 Read the license agreement and click Continue.

7 Click Agree to agree to the license agreement.

8 When the message that warns that all applications will close 
on your computer appears, click Continue.

9 Click Continue on the User Options Pane.

10 Click Install. All components necessary for machine 
operations will be installed.

If you click Customize, you can choose individual 
components to install.

11 Enter the password and click OK.

12 Installing software requires you to restart your computer. Click 
Continue Installation.

13 After the installation is finished, click Restart.

14 Open the Applications folder > Utilities > Print Setup 
Utility.

• For Mac OS X 10.5 -10.6, open the Applications folder > 
System Preferences and click Print & Fax.

15 Click Add on the Printer List.

• For Mac OS X 10.5 -10.6, click the “+” folder icon; a display 
window will pop up.

16 Click Default Browser and find the USB connection.

• For Mac OS X 10.5-10.6, click Default and find the USB 
connection.

17 For Mac OS X 10.4, if Auto Select does not work properly, select 
Samsung in Print Using and your machine name in Model.

• For Mac OS X 10.5-10.6, if Auto Select does not work 
properly, select Select a driver to use... and your machine 
name in Print Using. 

Your machine appears on the Printer List, and is set as the 
default machine.
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18 Click Add.



71. Software installationReinstallation for Macintosh

If the printer driver does not work properly, uninstall the driver and 
reinstall it.

1 Make sure that the machine is connected to your computer 
and powered on.

2 Insert the supplied software CD into your CD-ROM drive.

3 Double-click the CD-ROM icon that appears on your 
Macintosh desktop.

4 Double-click the MAC_Installer folder > Uninstaller OS X 
icon.

5 Enter the password and click OK.

6 When the uninstall is done, click OK.

 

If a machine has already been added, delete it from the Print 
Setup Utility or Print & Fax.

 



81. Software installationInstallation for Linux

You need to download Linux software packages from the Samsung 
website to install the printer software (http://www.samsung.com/
printer).

1 

Installing the Unified Linux Driver

1 Make sure that the machine is connected to your computer 
and powered on.

2 When the Administrator Login window appears, type “root” 
in the Login field and enter the system password.

 

You must log in as a super user (root) to install the machine 
software. If you are not a super user, ask your system 
administrator.

 

3 From the Samsung website, download the Unified Linux 
Driver package to your computer.

4 Right-click the Unified Linux Driver package and extract the 
package. 

5 Double click cdroot > autorun.

6 When the welcome screen appears, click Next.

7 When the installation is complete, click Finish.

The installation program added the Unified Driver Configurator 
desktop icon and the Unified Driver group to the system menu for 
your convenience. If you have any difficulties, consult the on-screen 
help that is available through your system menu or from the driver 
package Windows applications, such as Unified Driver 
Configurator or Image Manager.

2 

Installing the Smart Panel

1 Make sure that the machine is connected to your computer 
and powered on.

2 When the Administrator Login window appears, type in root 
in the Login field and enter the system password.

 

You must log in as a super user (root) to install the machine 
software. If you are not a super user, ask your system 
administrator.

 

3 From the Samsung website, download the Smart Panel 
package to your computer.
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4 Right-click the Smart Panel package and extract the package. 

5 Double click cdroot > Linux > smartpanel > install.sh.

3 

Installing the Printer Settings Utility

1 Make sure that the machine is connected to your computer 
and powered on.

2 When the Administrator Login window appears, type “root” 
in the Login field and enter the system password.

 

You must log in as a super user (root) to install the machine 
software. If you are not a super user, ask your system 
administrator.

 

3 From the Samsung website, download the Printer Settings 
Utility package to your computer.

4 Right-click the Printer Settings Utility package and extract 
the package. 

5 Double click cdroot > Linux > psu > install.sh.
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If the printer driver does not work properly, uninstall the driver and 
reinstall it. 

1 Make sure that the machine is connected to your computer 
and powered on.

2 When the Administrator Login window appears, type “root” 
in the Login field and enter the system password.

You must log in as a super user (root) to uninstall the printer 
driver. If you are not a super user, ask your system 
administrator.

3 Click the icon at the bottom of the desktop. When the 
Terminal screen appears, type in the following.

[root@localhost root]#cd /opt/Samsung/mfp/uninstall/

[root@localhost uninstall]#./uninstall.sh

4 Click Uninstall.

5 Click Next. 

6 Click Finish.



2. Using a network-connected 
machine

This chapter gives you step-by-step instructions for setting up a network 
connected machine and software.

• Useful network programs 12

• Wired network setup 13

• Installing driver over the network 17

• IPv6 configuration 28

• Wireless network setup 31

� Supported optional devices and features may differ according to your 
model.
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There are several programs available to setup the network settings 
easily in a network environment. For the network administrator 
especially, managing several machines on the network is possible. 

 

Before using the programs below, set the IP address first. 

 

1 

SyncThru™ Web Service

The web server embedded on your network machine allows you to 
do the following tasks (see "Using SyncThru™ Web Service" on page 
130):

• Check the supplies information and status.

• Customize machine settings.

• Set the email notification option. When you set this option, the 
machine status (toner cartridge shortage or machine error) will 
be sent to a certain person's email automatically.

• Configure the network parameters necessary for the machine to 
connect to various network environments.

2 

SyncThru™ Web Admin Service

Web-based machine management solution for network 
administrators. SyncThru™ Web Admin Service provides you with an 
efficient way of managing network devices and lets you remotely 
monitor and troubleshoot network machines from any site with 
corporate internet access. Download this program from http://
solution.samsungprinter.com.

3 

SetIP Wired network setup

This utility program allows you to select a network interface and 
manually configure the IP addresses for use with the TCP/IP protocol.

• See "IPv4 configuration using SetIP (Windows)" on page 13.

• See "IPv4 configuration using SetIP (Macintosh)" on page 14.

• See "IPv4 configuation using SetIP (Linux)" on page 15.

 

TCP/IPv6 is not supported by this program.
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You must set up the network protocols on your machine to use it on 
your network.

You can use network after connecting network cable to a 
corresponding port on your machine. 

• For models that do not have the display screen on the control 
panel, use the SyncThru™ Web Service or SetIP program.

- See "Using SyncThru™ Web Service" on page 130.

- See "Setting IP address" on page 13.

• For models that have the display screen on the control panel, 
configure the network setting by pressing  (Menu) button > 

Network on the control panel (see "Network setup" on page 80).

4 

Printing a network configuration report

You can print Network Configuration Report from the machine’s 
control panel that will show the current machine’s network settings. 
This will help you to set up a network.

• The machine has the display screen: Press the  (Menu) 
button on the control panel and select Network > Network 
Conf. (Network Configuration) > Yes. 

• The machine does not have the display screen: Press the  
(Cancel or Stop/Clear) button for more than five seconds on the 
control panel.

Using this Network Configuration Report, you can find your 
machine’s MAC address and IP address.

For example:

• MAC Address: 00:15:99:41:A2:78

• IP Address: 192.0.0.192

5 

Setting IP address

First, you have to set up an IP address for network printing and 
managements. In most cases a new IP address will be automatically 
assigned by a DHCP (Dynamic Host Configuration Protocol) server 
located on the network.

IPv4 configuration using SetIP (Windows)

Before using the SetIP program, disable the computer firewall from 
Control Panel > Security Center > Windows Firewall.

1 Install this program from the supplied CD-ROM by double-
click Application > SetIP > Setup.exe.

2 Follow the instructions in the installation window.

3 Connect your machine to the network with a network cable.
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4 Turn on the machine.

5 From the Windows Start menu, select All Programs > 
Samsung Printers > SetIP > SetIP.

6 Click the  icon (third from left) in the SetIP window to open 
the TCP/IP configuration window.

7 Enter the machine’s new information into the configuration 
window as follows. In a corporate intranet, you may need to 
have this information assigned by a network manager before 
proceeding.

 

Find the machine’s MAC address from the Network 
Configuration Report (see "Printing a network 
configuration report" on page 13) and enter it without the 
colons. For example, 00:15:99:29:51:A8 becomes 
0015992951A8.

 

8 Click Apply, and then click OK. The machine will automatically 
print the Network Configuration Report. Confirm that all the 
settings are correct.

IPv4 configuration using SetIP (Macintosh)

Before using the SetIP program, disable the computer firewall from 
System Preferences > Security > Firewall.

 

The following instructions may vary from your model.

 

1 Connect your machine to the network with a network cable.

2 Insert the Installation CD-ROM, and open the disk window, 
select MAC_Installer > MAC_Printer > SetIP > 
SetIPapplet.html.
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3 Double-click the file and Safari will automatically open, then 
select Trust. The browser will open the SetIPapplet.html 
page that shows the printer’s name and IP address 
information. 

4 Click the  icon (third from left) in the SetIP window to open 
the TCP/IP configuration window.

5 Enter the machine’s new information into the configuration 
window. In a corporate intranet, you may need to have this 
information assigned by a network manager before 
proceeding.

 

Find the machine’s MAC address from the Network 
Configuration Report (see "Printing a network 
configuration report" on page 13) and enter it without the 
colons. For example, 00:15:99:29:51:A8 becomes 
0015992951A8.

 

6 Select Apply, then OK, and OK again.

7 Quit Safari.

IPv4 configuation using SetIP (Linux)

Before using the SetIP program, disable the computer firewall from 
System Preferences or Administrator.

 

The following instructions may vary from your model or 
operating systems.

 

1 Open /opt/Samsung/mfp/share/utils/.

2 Double-click the SetIPApplet.html file. 

3 Click to open the TCP/IP configuration window. 

4 Enter the machine’s new information into the configuration 
window. In a corporate intranet, you may need to have this 
information assigned by a network manager before 
proceeding.

 

Find the machine’s MAC address from the Network 
Configuration Report (see "Printing a network 
configuration report" on page 13) and enter it without the 
colons. For example, 00:15:99:29:51:A8 becomes 
0015992951A8.
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5 The machine will automatically print the Network 
Configuration Report. 



172. Using a network-connected machineInstalling driver over the network
6 

Windows

1 Make sure that the machine is connected to the network and 
powered on. Also, your machine’s IP address should have 
been set (see "Setting IP address" on page 13).

 

If the “Found New Hardware Wizard” appears during the 
installation procedure, click Cancel to close the window.

 

2 Insert the supplied software CD into your CD-ROM drive.

The software CD should automatically run and an installation 
window will appear.

3 Select Install Now.

 

The Custom Installation allows you to select the machine’s 
connection and choose individual components to install. 
Follow the instructions on the window.

 

4 Read License Agreement, and select I accept the terms of 
the License Agreement. Then, click Next.

The program searches for the machine.

 

If your machine is not found on the network or locally, an 
error message appears. Select the option you want and click 
Next.

 

5 The searched machines will be shown on the screen. Select 
the one you wish to use and click OK.

 

If the driver searched only one machine, the confirmation 
window appears.

 

6 Follow the instructions in the installation window.

Silent installation Mode

Silent installation mode is an installation method that does not 
require any user intervention. Once you start the installation, the 
machine driver and software are automatically installed on you 
computer. You can start the silent installation by typing /s or /S in the 
command window.

� Command-line Parameters

Following table shows commands that can be used in the command 
window.
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Following command-line are effective and operated when 
command is used with /s or /S. But /h, /H or /? are exceptional 
commands that can be operated solely.

 

Command- line Definition Description

/s or

/S

Starts silent 
installation. 

Installs machine drivers 
without prompting any 
UIs or user intervention.

/p”<port name>” 
or

/P”<port name>”

Specifies printer port.

 

Network 
Port will be 
created by 
use of 
Standard 
TCP/IP Port 
monitor. 
For local 
port, this 
port must 
exist on 
system 
before 
being 
specified 
by 
command.

 

Printer port name can be 
specified as IP address, 
hostname, USB local 
port name or IEEE1284 
port name.

For example

•  /p”xxx.xxx.xxx.xxx” in 
where, 
“xxx.xxx.xxx.xxx” 
means IP address for 
network printer. /
p”USB001”, /P”LPT1:”, 
/p”hostname”

• When installing the 
driver silently in 
Korean, type in-
Setup.exe /s /
L"0x0012” or 
Setup.exe /s /L"18” .

Command- line Definition Description
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/a”<dest_path>” 
or

/A”<dest_path>”

Specifies destination 
path for installation. 

 

The 
destination 
path 
should be a 
fully 
qualified 
path.

 

Since machine drivers 
should be installed on 
the OS specific location, 
this command applies to 
only application 
software.

Command- line Definition Description

/i”<script 
filename>” or

/I”<script 
filename>”

Specifies customized 
install script file for 
custom operation.

 

The script 
filename 
should be a 
fully 
qualified 
filename.

 

Customized script file 
can be assigned for 
customized silent 
installation. This script 
file can be created or 
modified through 
provided installer 
customizing utility or by 
text editor.

Note: This customized 
script file is prior than 
default installer setting 
in setup package but not 
prior than command-
line parameters.

/n”<Printer 
name>” or

/N”<Printer 
name>”

Specifies printer 
name. Printer 
instance shall be 
created as specified 
printer name.

With this parameter, you 
can add printer 
instances as your wishes.

Command- line Definition Description
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/nd or

/ND

Commands not to set 
the installed driver as 
a default machine 
driver.

It indicates installed 
machine driver will not 
be the default machine 
driver on your system if 
there are one or more 
printer drivers installed. 
If there is no installed 
machine driver on your 
system, then this option 
won’t be applied 
because Windows OS 
will set installed printer 
driver as a default 
machine driver.

/x or

/X

Uses existing 
machine driver files to 
create printer 
instance if it is already 
installed.

This command provides 
a way to install a printer 
instance that uses 
installed printer driver 
files without installing 
an additional driver.

Command- line Definition Description

/up”<printer 
name>” or

/UP”<printer 
name>”

Removes only 
specified printer 
instance and not the 
driver files.

This command provides 
a way to remove only 
specified printer 
instance from your 
system without 
effecting other printer 
drivers. It will not 
remove printer driver 
files from your system. 

/d or

/D

Uninstalls all device 
drivers and 
applications from 
your system.

This command will 
remove all installed 
device drivers and 
application software 
from your system.

/v”<share name>” 
or

/V”<share name>”

Shares installed 
machine and add 
other available 
platform drivers for 
Point & Print.

It will install all 
supported Windows OS 
platform’s machine 
drivers to system and 
share it with specified 
<share name> for point 
and print.

/o or 

/O

Opens Printers and 
Faxes folder after 
installation.

This command will open 
Printers and Faxes 
folder after the silent 
installation.

Command- line Definition Description



Installing driver over the network 212. Using a network-connected machine

� Language code

/f”<log filename>” 
or

/F”<log 
filename>”

Specifies log 
filename.

The default log file is 
created in the system 
temp folder if not 
specified.

It will create a log file to a 
specified folder.

/h, /H or /? Shows Command-line 
Usage.

Code Language

0X0009 English

0X0012 Korean

0X0804 Simplified Chinese

0X0404 Traditional Chinese

0x040c French

0X0007 German

0X0010 Italian

0X000a Spanish

0X0013 Dutch

Command- line Definition Description

0X001D Swedish

0X0006 Danish

0X000b Finnish

0X0014 Norwegian

0X0019 Russian

0X0005 Czech

0X000e Hungarian

0X0008 Greek

0X0816 Standard Portuguese

0X0416 Brazilian Portuguese

0X0015 Polish

0X001F Turkish

0X0001 Arabic

0X000D Hebrew

0x0424 Slovenian 

0X0418 Romanian 

0X0402 Bulgarian 

0X041A Croatian 

Code Language
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7 

Macintosh

1 Make sure that the machine is connected to your network and 
powered on.

2 Insert the supplied software CD into your CD-ROM drive.

3 Double-click the CD-ROM icon that appears on your 
Macintosh desktop.

4 Double-click the MAC_Installer folder > Installer OS X icon.

5  Click Continue.

6 Read the license agreement and click Continue.

7 Click Agree to agree to the license agreement.

8 When the message which warns that all applications will close 
on your computer appears, click Continue.

9 Click Continue on the User Options Pane.

 

If you have not set the IP address yet, click Set IP address and 
refer to "IPv4 configuration using SetIP (Macintosh)" on page 
14. If you want to set the wireless setting, refer to "Setup 
using Macintosh" on page 46.

 

10 Click Install. All components necessary for machine 
operations will be installed.

If you click Customize, you can choose individual 
components to install.

11 Enter the password and click OK.

12 Installing software requires you to restart your computer. Click 
Continue Installation.

13 After the installation is finished, click Restart.

0X081A Serbian 

0X0422 Ukraine 

0X041B Slovakia 

0X0421 Indonesian 

0x041E Thai

0X0429 Farsi

Code Language
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14 Open the Applications folder > Utilities > Print Setup 
Utility.

• For Mac OS X 10.5-10.6, open the Applications folder > 
System Preferences and click Print & Fax.

15 Click Add on the Printer List.

• For Mac OS X 10.5-10.6, click the “+” icon. A display window 
will pop up. 

16 For Mac OS X 10.4, click IP Printer.

• For Mac OS X 10.5-10.6, click IP.

17 Select HP Jetdirect - Socket in Protocol.

 

When printing a document containing many pages, printing 
performance may be enhanced by choosing Socket for 
Printer Type option.

 

18 Enter the machine’s IP address in the Address input field.

19 Enter the queue name in the Queue input field. If you cannot 
determine the queue name for your machine server, try using 
the default queue first.

20 For Mac OS X 10.4, if Auto Select does not work properly, select 
Samsung in Print Using and your machine name in Model. 

• For Mac OS X 10.5-10.6, if Auto Select does not work 
properly, choose Select Printer Software and your 
machine name in Print Using.

21 Click Add.

Your machine appears in the Printer List, and is set as the 
default machine.

8 

Linux

You need to download Linux software packages from the Samsung 
website to install the printer software (http://www.samsung.com/
printer).

 

To install other software:

• See "Installing the Smart Panel" on page 8.

• See "Installing the Printer Settings Utility" on page 9.
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Install the Linux driver and add network printer

1 Make sure that the machine is connected to your network and 
powered on. Also, your machine’s IP address should have 
been set. 

2 Download the Unified Linux Driver package from the 
Samsung website.

3 Extract the UnifiedLinuxDriver.tar.gz file and open the new 
directory.

4 Double-click the Linux folder > install.sh icon.

5 The Samsung installer window opens. Click Continue.

6 The add printer wizard window opens. Click Next.

7 Select network printer and click Search button.

8 The machine’s IP address and model name appears on list 
field.

9 Select your machine and click Next.

10 Input the printer description and Next.

11 After the machine is added, click Finish.

12 When installation is done, click Finish.

Add a network printer

1 Double-click the Unified Driver Configurator.

2 Click Add Printer.

3 The Add printer wizard window opens. Click Next.

4 Select Network printer and click the Search button.

5 The printer’s IP address and model name appears on list field.

6 Select your machine and click Next.

7 Enter the printer description and click Next.

8 After the machine is added, click Finish.
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9 

UNIX

 

Make sure your machine supports the UNIX operating 
system before installing the UNIX printer driver (see basic 
guide)

 

To use the UNIX printer driver, you have to install the UNIX printer 
driver package first, then setup the printer. You can download the 
UNIX printer driver package from the Samsung website.

Installing the UNIX printer driver package

The installation procedure is common for all variants of UNIX OS 
mentioned.

1 From the Samsung website, download and unpack the UNIX 
Printer Driver package to your computer. 

2 Acquire root privileges.

su -

3 Copy the appropriate driver archive to the target UNIX 
computer.

 

See administration guide of your UNIX OS for details.

 

4 Unpack the UNIX printer driver package.

For example, on IBM AIX, use the following commands 
(without “”).

gzip -d < "package name" | tar xf -

5 Go to the unpacked directory.

6 Run the install script.

./install

install is the installer script file which is used to install or 
uninstall the UNIX Printer Driver package.

Use “chmod 755 install” command to give the permission to 
the installer script.

7 Execute the “. /install –c” command to verify installation 
results.

8 Run ‘installprinter’ from the command line. This will bring up 
the Add Printer Wizard window. Setup the printer in this 
window referring to the following procedures.
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On some UNIX OS, for example on Solaris 10, just added 
printers may not be enabled and/or may not accept jobs. In 
this case run the following two commands on the root 
terminal:

accept <printer_name>

enable <printer_name>

 

Uninstalling the printer driver package

 

The utility should be used to delete the printer installed in 
the system.
a Run “uninstallprinter” command from the terminal.

It will open the Uninstall Printer Wizard.
The installed printers are listed in the drop-down list.

b Select the printer to be deleted.
c Click Delete to delete the printer from the system.
d Execute the “. /install –d” command to uninstall the whole 

package.
e To verify removal results, execute the “. /install –c” 

command.
 

To re-install it, use the command “. /install” to reinstall the binaries.

Setting up the printer

To add the printer to your UNIX system, run ‘installprinter’ from the 
command line. This will bring up the Add Printer Wizard window. 
Setup the printer in this window according to the following steps:

1 Type the name of the printer.

2 Select the appropriate printer model from the model list.

3 Enter any description corresponding to the type of the printer 
in the Type field. This is optional.

4 Specify any printer description in the Description field. This is 
optional.

5 Specify the printer location in the Location field.

6 Type the IP address or DNS name of the printer in the Device 
textbox for network-connected printers. On IBM AIX with 
jetdirect Queue type, only the DNS name is possible-numeric 
IP address is not allowed.

7 Queue type shows the connection as lpd or jetdirect in the 
corresponding list box. Additionally, usb type is available on 
Sun Solaris OS.
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8 Select Copies to set the number of copies.

9 Check the Collate option to receive copies already sorted.

10 Check the Reverse Order option to receive copies in the 
reverse order.

11 Check the Make Default option to set this printer as default.

12 Click OK to add the printer.
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IPv6 is supported properly only in Windows Vista or higher.

 

 

If the IPv6 network seems to not be working, set all the 
network setting to the factory defaults and try again using 
Clear Setting.

 

In the IPv6 network environment, follow the next procedure to use 
the IPv6 address.

10 

From the control panel

1 Connect your machine to the network with a network cable.

2 Turn on the machine.

3 Print a Network Configuration Report that will check IPv6 
addresses (see "Printing a network configuration report" on 
page 13).

4 Select Start > Control Panel > Printers and Faxes.

5 Click Add a printer in the left pane of the Printers and Faxes 
windows.

6 Click Add a local printer in the Add Printer windows.

7 The Add Printer Wizard window appears. Follow the 
instructions in the window.

 

If the machine does not work in the network environment, 
activate IPv6. Refer to the next section followed by.

 

Activating IPv6

1 Press the  (Menu) button on the control panel.

2 Press Network > TCP/IP (IPv6) > IPv6 Activate.

3 Select On and press OK.

4 Turn the machine off and turn it on again.

5 Reinstall your printer driver.
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Setting IPv6 addresses

The machine supports the following IPv6 addresses for network 
printing and managements.

• Link-local Address: Self-configured local IPv6 address (Address 
starts with FE80).

• Stateless Address: Automatically configured IPv6 address by a 
network router.

• Stateful Address: IPv6 address configured by a DHCPv6 server.

• Manual Address: Manually configured IPv6 address by a user.

� DHCPv6 address configuration (Stateful)

If you have a DHCPv6 server on your network, you can set one of the 
following options for default dynamic host configuration.

1 Press the  (Menu) button on the control panel.

2 Press Network > OK > TCP/IP (IPv6) > OK > DHCPv6 Config.

3 Press OK to select the required value you want.

• DHCPv6 Addr.: Always use DHCPv6 regardless of router 
request.

• DHCPv6 Off: Never use DHCPv6 regardless of router 
request.

• Router: Use DHCPv6 only when requested by a router.

11 

From the SyncThru™ Web Service

 

For models that do not have the display screen on the 
control panel, you need to access SyncThru™ Web Service 
first using the IPv4 address and follow the below procedure 
to use IPv6.

 

1 Access a web browser, such as Internet Explorer, from 
Windows. Enter the machine IP address (http://
xxx.xxx.xxx.xxx) in the address field and press the Enter key or 
click Go.

2 If it’s your first time logging into SyncThru™ Web Service you 
need to log-in as an administrator. T

• ID: admin

• Password: sec00000 

3 When the SyncThru™ Web Service window opens, move the 
mouse cursor over the Settings of the top menu bar and then 
click Network Settings.
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4 Click TCP/IPv6 on the left pane of the website.

5 Check the IPv6 Protocol check box to activate IPv6.

6 Check the Manual Address check box. Then, the Address/
Prefix text box is activated.

7 Enter the rest of the address (e.g.,:3FFE:10:88:194::AAAA. “A” is 
the hexadecimal 0 through 9, A through F).

8 Choose the DHCPv6 configuration.

9 Click the Apply button.

Using SyncThru™ Web Service

1 Start a web browser, such as Internet Explorer, that supports 
IPv6 addressing as a URL.

2 Select one of the IPv6 addresses (Link-local Address, 
Stateless Address, Stateful Address, Manual Address) from 
Network Configuration Report (see "Printing a network 
configuration report" on page 13).

3 Enter the IPv6 addresses (e.g.,: http://
[FE80::215:99FF:FE66:7701]).

 

Address must be enclosed in '[ ]' brackets.

 



312. Using a network-connected machineWireless network setup
 

Make sure your machine supports a wireless network. 
Wireless network may not be available depending on the 
model.

 

12 

Getting started

Understanding your network type

Typically, you can only have one connection between your 
computer and the machine at a time.

Wireless network name and network key

Wireless networks require higher security, so when an access point is 
first set up, a network name (SSID), the type of security used, and a 
Network Key are created for the network. Locate this information 
before proceeding with the machine installation.

13 

Choosing the installation type

You can install a wireless network from the machine’s control panel 
or the computer. 

From the control panel

You can configure wireless parameters with the control panel.

• See "Using the WPS button" on page 32.

• See "Using the menu button" on page 36.

From the computer

From the computer, we recommend using a USB cable with the 
program provided in the supplied software CD 

• See "Setup using Windows" on page 38.

• See "Setup using Macintosh" on page 46.

Infrastructure mode

This is an environment generally used for homes and 
SOHOs (Small Office/ Home Office). This mode uses 
an access point to communicate with the wireless 
machine.

Ad hoc mode

This mode does not use an access point. The wireless 
computer and wireless machine communicates 
directly. 
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• With a USB cable: You can simply set up a wireless network 
using the program on the supplied software CD. Only Windows 
and Macintosh operating systems are supported (see "Setup 
using Windows" on page 38 or "Setup using Macintosh" on page 
46).

 

You can also install a wireless network in Printer Settings 
Utility with a USB cable after installing the driver (Windows 
and Macintosh operating systems are supported).

 

• With a network cable: You can set up a wireless network using 
the SyncThru™ Web Service program (see "Using a network 
cable" on page 52).

14 

Using the WPS button 

If your machine and an access point (or wireless router) support Wi-
Fi Protected Setup™ (WPS), you can easily configure the wireless 
network settings by pressing the  (WPS) button on the control 
panel without a computer.

 

If you want to use the wireless network using the 
infrastructure mode, make sure that the network cable is 
disconnected from the machine. Using the WPS (PBC) 
button or entering the PIN from the computer to connect to 
the access point (or wireless router) varies depending on the 
access point (or wireless router) you are using. Refer to the 
user's guide of the access point (or wireless router) you are 
using.

 

Items to prepare

• Check if the access point (or wireless router) supports Wi-Fi 
Protected Setup™ (WPS).

• Check if your machine supports Wi-Fi Protected Setup™ (WPS).

• Networked computer (PIN mode only)

Choosing your type

There are two methods available to connect your machine to a 
wireless network using the  (WPS) button on the control panel.
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The Push Button Configuration (PBC) method allows you to 
connect your machine to a wireless network by pressing both the  
(WPS) button on the control panel of your machine and the WPS 
(PBC) button on a Wi-Fi Protected Setup™ (WPS)-enabled access 
point (or wireless router) respectively.

The Personal Identification Number (PIN) method helps you 
connect your machine to a wireless network by entering the 
supplied PIN information on a Wi-Fi Protected Setup™ (WPS)-
enabled access point (or wireless router).

Factory default in your machine is PBC mode, which is 
recommended for a typical wireless network environment.

 

To change the WPS mode , press  (Menu) > Network >

Wireless > OK > WPS Setting.

 

Machines with an display screen

� Connecting in PBC mode

1 Press and hold the  (WPS) button on the control panel for 
more than 2 seconds.

The machine starts waiting for up to two minutes until you 
press the WPS (PBC) button on the access point (or wireless 
router).

2 Press the WPS (PBC) button on the access point (or wireless 
router).

The messages are displayed on the display screen in the order 
below:

a Connecting: The machine is connecting to the access 
point (or wireless router).

b Connected: When the machine is successfully connected 
to the wireless network, the WPS LED light stays on.

c AP SSID: After completing the wireless network 
connection process, the AP’s SSID information appears on 
the display.
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� Connecting in PIN mode

1 Press and hold the  (WPS) button on the control panel for 
more than 2 seconds.

2 The eight-digit PIN appears on the display. 

You need to enter the eight-digit PIN within two minutes to 
the computer which is connected to the access point (or 
wireless router).

The messages are displayed on the display screen in the order 
below:

a Connecting: The machine is connecting to the wireless 
network.

b Connected: When the machine is successfully connected 
to the wireless network, the WPS LED light stays on.

c AP SSID: After completing the wireless network 
connection process, the AP’s SSID information is diplayed 
on the LCD display.

Machines without an display screen

� Connecting in PBC mode

1 Press and hold the  (WPS) button on the control panel for 
about 2 - 4 seconds until the status LED blinks quickly.

The machine starts connecting to the wireless network. The 
LED blinks slowly for up to two minutes until you press the PBC 
button on the access point (or wireless router).

2 Press the WPS (PBC) button on the access point (or wireless 
router).

a The light blinks fast on the WPS LED. The machine is 
connecting to the access point (or wireless router). 

b When the machine is successfully connected to the 
wireless network, the WPS LED light stays on.
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� Connecting in PIN mode

1 The network configuration report, including PIN, must be 
printed. 

In ready mode, press and hold the  (Cancel or Stop/Clear) 
button on the control panel for about 5 seconds. You can find 
your machine’s PIN number.

2 Press and hold the  (WPS) button on the control panel for 
more than 4 seconds until the status LED stays on.

The machine starts connecting to the access point (or wireless 
router).

3 You need to enter the eight-digit PIN within two minutes on 
the computer that is connected to the access point (or 
wireless router).

The LED blinks slowly for up to two minutes until you enter the 
eight-digit PIN.

The WPS LED blinks in the order below:

a The light blinks fast on the WPS LED. The machine is 
connecting to the access point (or wireless router).

b When the machine is successfully connected to the 
wireless network, the WPS LED light stays on.

Re-connecting to a network

When the wireless function is off, the machine automatically tries to 
re-connect to the access point (or wireless router) with the 
previously used wireless connection settings and address.

 

In the following cases, the machine automatically re-
connects to the wireless network:

• The machine is turned off and on again.

• The access point (or wireless router) is turned off and on 
again.

 

Canceling the connection process

To cancel the wireless network connection when the machine is 
connecting to the wireless network, press and release the  (Cancel 
or Stop/Clear) button on the control panel. You need to wait 2 
minuites to re-connect to the wireless network.
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Disconnecting from a network

To disconnect the wireless network connection, press the  (WPS) 
button on the control panel for more than two seconds.

• When the Wi-Fi network is in idle mode: The machine is 
immediately disconnected from the wireless network, and the 
WPS LED is off.

• When the Wi-Fi network is being used: While the machine 
waits until the current job is finished, the light blinks fast on the 
WPS LED. Then, the wireless network connection is automatically 
disconnected. The WPS LED is off.
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Using the menu button

Before starting, you will need to know the network name (SSID) of 
your wireless network and the network key if it is encrypted. This 
information was set when the access point (or wireless router) was 
installed. If you do not know about your wireless environment, 
please ask the person who set up your network.

 

After completing the wireless network connection, you need 
to install a machine driver to print from an application (see 
"Installing driver over the network" on page 17).

 

1 Select  (Menu) > Network > OK > Wireless > OK > WLAN 
Settings > OK on the control panel.

2 Press the OK to select the setup method you want.

• Wizard: The wireless network interface card in your 
machine searches for wireless networks in the area and 
shows the results.

• Custom: You can configure the according to your needs.

Wizard mode

1 The wireless network interface card on your machine searches 
for wireless networks in the area and shows the results.

2 Press Search List > OK > select the network > OK.

You can select a network using SSID.

3 Press WLAN Security > OK > None > OK. 

If you see another message, go to the next step.
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4 According to the network you selected, the WLAN security 
encryption type will be WEP or WPA.

• In case of WEP, press the Open System or SharedKey.

- Open System: Authentication is not used, and 
Encryption may or may not be used, depending on the 
need for data security. Enter the WEP Key after 
selecting Open System.

- SharedKey: Authentication is used. A device that has 
a proper WEP Key can access the network. Enter the 
WEP Key after selecting SharedKey.

• In case of WPA, enter the WPA Key. The key length should 
be between 8 and 63 characters long.

5 Press OK.

Custom mode

1 Enter the SSID when Edit SSID appears on the top line of the 
display, the name that identifies a wireless network. SSID is 
case-sensitive so you need to enter it carefully. Press OK.

2 Select the type of wireless connections. 

3 Press OK to select the method of Operation Mode.

• Ad-hoc: Allows wireless devices to communicate directly 
with each other in a peer-to-peer environment. Go to step 
4.

• Infrastructure: Allows wireless devices to communicate 
with each other through an access point. Go to step 5.

4 Press OK to select the method of Channel. 

If you select Auto, the wireless network interface card on your 
machine will automatically adjust the channels.

5 Press OK to select the method of WLAN Security.

• None: This is used when the validation of a wireless 
device’s identity and data encryption are not required for 
your network. Open system is used for IEEE 802.11 
authentication.

• Static WEP: This uses the WEP (Wired Equivalent Privacy) 
algorithm suggested by IEEE 802.11 standard for security. 
Static WEP security mode requires a proper WEP key for 
data encryption, decryption, and IEEE 802.11 
authentication. Press OK to select the setup method in 
Authentication

- Open System: Authentication is not used, and 
encryption may or may not be used, depending on the 
need for data security. Enter the WEP Key.
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- SharedKey: Authentication is used. Enter the WEP 
Key after selecting SharedKey.

• WPA-PSK or WPA2-PSK: You can select WPA-PSK or 
WPA2-PSK to authenticate the print server based on WPA 
Pre-Shared Key. This uses a shared secret key (generally 
called Pre-Shared Key passphrase), which is manually 
configured on the access point and each of its clients.

a Press OK when WPA-PSK or WPA2-PSK appears of on 
the display.

b Press OK to select TKIP or AES in Encryption. If you 
select WPA2-PSK, press OK to select AES or TKIP + 
AES in Encryption.

c Enter the WPA Key.

6 Press OK.

 

Disconnect the network cable (standard or crossover). Your 
machine should then start communicating wirelessly with 
the network. In case of Ad-hoc mode, you can use a wireless 
LAN and wired LAN simultaneously.
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Setup using Windows

 

Shortcut to Wireless Setting program without CD: If you 
have installed the printer driver once, you can access the 
Wireless Setting program without CD. From the Start menu, 
select Programs or All Programs > Samsung Printers > 
your printer driver name > Wireless Setting Program.

 

Access point via USB cable

� Items to prepare

• Access point

• Network-connected computer

• Software CD that was provided with your machine

• The machine installed with a wireless network interface

• USB cable

� Creating the infrastructure network

1 Check whether the USB cable is connected to the machine.

2 Turn on your computer, access point, and machine.
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3 Insert the supplied software CD into your CD-ROM drive.

Click Start > All programs > Accessories > Run.

Type X:\Setup.exe replacing “X” with the letter, which 
represents your CD-ROM drive and click OK.

4 Select the Wireless Setting and Installation option.

• Install Now: If you have already set up the wireless 
network, click this button to install the machine’s driver to 
use the wireless network machine. If you have not set up 
the wireless network, click the Wireless Setting and 
Installation button to set up the wireless network before 
you click this button. 

• Wireless Setting and Installation: Configure the wireless 
network settings of your machine with a USB cable then 
install the machine driver. This is only for users who have 
not set up the wireless connection before.

5 Read the License Agreement, and select I accept the terms 
of the License Agreement. Then, click Next.

6 The software searches the wireless network.

 

If the search has failed, you may check if the USB cable is 
properly connected between the computer and machine, 
and follow the instructions on the window.

 

7 After searching, the window shows the wireless network 
devices. Select the name (SSID) of the access point you are 
using and click Next.

 

If you cannot find the network name you want to choose, or 
if you want to set the wireless configuration manually, click 
Advanced Setting.

• Enter the wireless Network Name: Enter the SSID of 
access point you want (SSID is case-sensitive).

• Operation Mode: Select Infrastructure.
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• Authentication: Select an authentication type.
Open System: Authentication is not used, and encryption 
may or may not be used, depending on the need for data 
security.
Shared Key: Authentication is used. A device that has a 
proper WEP key can access the network.
WPA Personal or WPA2 Personal: Select this option to 
authenticate the print server based on WPA Pre-Shared 
Key. This uses a shared secret key (generally called Pre- 
Shared Key pass phrase) which is manually configured on 
the access point and each of its clients.

• Encryption: Select the encryption (None, WEP64, 
WEP128, TKIP, AES, TKIP AES).

• Network Key: Enter the encryption network key value.

• Confirm Network Key: Confirm the encryption network 
key value.

• WEP Key Index: If you are using WEP Encryption, select 
the appropriate WEP Key Index.

 

 

The wireless network security window appears when the 
access point has security settings.

The wireless network security window appears. The window 
may differ according to its security mode: WEP, or WPA.

• WEP
Select Open System or Shared Key for the authentication 
and enter the WEP security key. Click Next.
WEP (Wired Equivalent Privacy) is a security protocol 
preventing unauthorized access to your wireless network. 
WEP encrypts the data portion of each packet exchanged 
on a wireless network using a 64-bit or 128-bit WEP 
encryption key.

• WPA
Enter the WPA shared key and click Next.
WPA authorizes and identifies users based on a secret key 
that changes automatically at regular intervals. WPA also 
uses TKIP (Temporal Key Integrity Protocol) and AES 
(Advanced Encryption Standard) for data encryption.
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8 The window shows the wireless network settings and checks 
if the settings are correct. Click Next.

• For the DHCP method

If the IP address assignment method is DHCP, check if 
DHCP is shown in the window. If it shows Static, click 
Change TCP/IP to change the assignment method to 
DHCP.

• For the Static method

If the IP address assignment method is Static, check if 
Static is shown in the window. If it shows DHCP, click 
Change TCP/IP to enter the IP address and other network 
configuration values for the machine. Before entering the 
IP address for the machine, you must know the computer’s 
network configuration information. If the computer is set 
to DHCP, you must contact the network administrator to 
get the static IP address.

For example:

If the computer’s network information is as shown below:

- IP address: 169.254.133.42

- Subnet Mask: 255.255.0.0

Then, the machine’s network information should be as 
follows:

- IP address: 169.254.133.43 

- Subnet Mask: 255.255.0.0 (Use the computer’s subnet 
mask.)

- Gateway: 169.254.133.1

9 When the wireless network setting is completed, disconnect 
the USB cable between the computer and machine. Click 
Next.

10 The Wireless Network Setting Complete window appears.

Select Yes if you accept the current settings and continue the 
setup procedure.

Select No if you want to return to the beginning screen. 

Then, click Next.

11 Click Next when the Confirm Printer Connection window 
appears.

12 Select the components to be installed. Click Next.

13 After selecting the components, you can also change the 
machine name, set the machine to be shared on the network, 
set the machine as the default machine, and change the port 
name of each machine. Click Next.
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14 After the installation is finished, a window asking you to print 
a test page appears. If you want to print a test page, click Print 
a test page.

Otherwise, just click Next and go to step 16.

15 If the test page prints out correctly, click Yes.

If not, click No to reprint it.

16 To register as a user of the machine in order to receive 
information from Samsung, click On-line Registration.

17 Click Finish.

Ad hoc via USB cable

If you do not have an access point (AP), you may still connect the 
machine wirelessly to your computer by setting up an ad-hoc 
wireless network by following the simple steps below.

� Items to prepare

• Network-connected computer

• Software CD that was provided with your machine

• The machine installed with a wireless network interface

• USB cable

� Creating the ad hoc network in Windows

1 Check whether the USB cable is connected to the machine.

2 Turn on your computer and the wireless network machine.

3 Insert the supplied software CD into your CD-ROM drive.

Click Start > All programs > Accessories > Run.

Type X:\Setup.exe replacing “X” with the letter, which 
represents your CD-ROM drive and click OK.
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4 Select the Wireless Setting and Installation option.

• Install Now: If you have set the wireless network, click this 
button to install the machine’s driver to use the wireless 
network machine. If you have not set the wireless network, 
click Wireless Setting and Installation button to set the 
wireless network before you click this button. 

• Wireless Setting and Installation: Configure the wireless 
network settings of your machine’s with a USB cable then 
install the machine driver. This only for users who have not 
set up the wireless connection before.

5 Read the License Agreement, and select I accept the terms 
of the License Agreement. Then, click Next.

6 The software searches the wireless network.

 

If the software has failed to search the network, check if the 
USB cable is connected properly between the computer and 
machine, and follow the instruction in the window.

 

7 After searching the wireless networks, a list of wireless 
networks your machine has searched appears. 

If you want to use the Samsung default ad hoc setting, select 
the last wireless network on the list, Network Name(SSID) is 
portthru and Signal is Printer Self Network.

Then, click Next.

If you want to use other ad hoc settings, select another 
wireless network from the list. 

 

If you want to change ad hoc settings click the Advanced 
Setting button. 

• Enter the wireless Network Name: Enter the SSID name 
you want (SSID is case-sensitive).

• Operation Mode: Select ad hoc.

• Channel: Select the channel. (Auto Setting or 2412 MHz 
to 2467 MHz).
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• Authentication: Select an authentication type.
Open System: Authentication is not used, and encryption 
may or may not be used, depending on the need for data 
security.
Shared Key: Authentication is used. A device that has a 
proper WEP key can access the network.

• Encryption: Select the encryption (None, WEP64, 
WEP128).

• Network Key: Enter the encryption network key value.

• Confirm Network Key: Confirm the encryption network 
key value.

• WEP Key Index: If you are using WEP Encryption, select 
the appropriate WEP Key Index.

The wireless network security window appears when the ad 
hoc network has security setting.

The wireless network security window appears. Select Open 
System or Shared Key for the authentication and click Next.

• WEP (Wired Equivalent Privacy) is a security protocol 
preventing unauthorized access to your wireless network. 
WEP encrypts the data portion of each packet exchanged 
on a wireless network using a 64-bit or 128-bit WEP 
encryption key.

 

8 The window showing the wireless network setting appears. 
Check the settings and click Next.
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Before entering the IP address for the machine, you must 
know the computer’s network configuration information. If 
the computer’s network configuration is set to DHCP, the 
wireless network setting should also be DHCP. Likewise, if 
the computer’s network configuration is set to Static, the 
wireless network setting should also be Static.

If your computer is set to DHCP and you want to use the 
Static wireless network setting, you must contact the 
network administrator to get the static IP address.

• For the DHCP method
If the IP address assignment method is DHCP, check if 
DHCP is shown in the Wireless Network Setting Confirm 
window. If it shows Static, click Change TCP/IP to change 
the assignment method to Receive IP address 
automatically (DHCP).

• For the Static method
If the IP address assignment method is Static, check if 
Static is shown in the Wireless Network Setting Confirm 
window. If it shows DHCP, click Change TCP/IP to enter 
the IP address and other network configuration values for 
the machine.
For example:
If the computer’s network information is as shown follows:
- IP address: 169.254.133.42
- Subnet Mask: 255.255.0.0
Then, the machine’s network information should be as 
below:

- IP address: 169.254.133.43
- Subnet Mask: 255.255.0.0 (Use the computer’s subnet 

mask.)
- Gateway: 169.254.133.1

 

9 When the wireless network settings are completed, 
disconnect the USB cable between the computer and 
machine. Click Next.

 

If the Change PC Network Setting window appears, follow 
the steps in the window.

Click Next if you are finished with the computer’s wireless 
network settings.

If you set the computer’s wireless network on DHCP, it will 
take several minutes to receive the IP address.

 

10 The Wireless Network Setting Complete window appears.

Select Yes if you accept the current settings and continue the 
setup procedure.

Select No if you want to return to the beginning screen. 

Then, click Next.

11 Click Next when the Confirm Printer Connection window 
appears.
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12 Select the components to be installed. Click Next.

After selecting the components, you can also change the 
machine name, set the machine to be shared on the network, 
set the machine as the default machine, and change the port 
name of each machine. Click Next.

13 After the installation is finished, a window asking you to print 
a test page appears. If you want to print a test page, click Print 
a test page.

Otherwise, just click Next and go to step 15.

14 If the test page prints out correctly, click Yes.

If not, click No to reprint it.

15 To register as a user of the machine in order to receive 
information from Samsung, click On-line Registration.

16 Click Finish.

17 

Setup using Macintosh

Items to prepare

• Access point

• Network-connected computer

• Software CD that was provided with your machine

• The machine installed with a wireless network interface

• USB cable

Access point via USB cable

1 Check whether the USB cable is connected to the machine.

2 Turn on your computer, access point, and machine.

3 Insert the supplied software CD into your CD-ROM drive.

4 Double-click the CD-ROM icon that appears on your 
Macintosh desktop.

5 Double-click the MAC_Installer folder.

6 Double-click the Installer OS X icon.
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7  Click Continue.

8 Read the license agreement and click Continue.

9 Click Agree to agree to the license agreement.

10 When the message that warns that all applications will close 
on your computer appears, click Continue.

11 Select the Wireless Network Setting.

12 The software searches the wireless network.

 

If the search has failed, you may check if the USB cable is 
connected between the computer and machine properly, 
and follow the instructions in the window.

 

13 After searching, the window shows the wireless network 
devices. Select the name (SSID) of the access point you are 
using and click Next.

 

When you set the wireless configuration manually, click 
Advanced Setting.

• Enter the wireless Network Name: Enter the SSID of the 
access point you want with (SSID is case-sensitive).

• Operation Mode: Select Infrastructure.

• Authentication: Select an authentication type.
Open System: Authentication is not used, and encryption 
may or may not be used, depending on the need for data 
security.
Shared Key: Authentication is used. A device that has a 
proper WEP key can access the network.
WPA Personal or WPA2 Personal: Select this option to 
authenticate the print server based on WPA Pre-Shared 
Key. This uses a shared secret key (generally called Pre- 
Shared Key pass phrase) that is manually configured on 
the access point and each of its clients.

• Encryption: Select the encryption. (None, WEP64, 
WEP128, TKIP, AES, TKIP, AES)

• Network Key: Enter the encryption network key value.

• Confirm Network Key: Confirm the encryption network 
key value.

• WEP Key Index: If you are using WEP Encryption, select 
the appropriate WEP Key Index.
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The wireless network security window appears when the 
access point has security setting.

The wireless network security window appears. The window 
may differ according to its security mode: WEP or WPA.

• WEP
Select Open System or Shared Key for the authentication 
and enter the WEP security key. Click Next.
WEP (Wired Equivalent Privacy) is a security protocol 
preventing unauthorized access to your wireless network. 
WEP encrypts the data portion of each packet exchanged 
on a wireless network using a 64-bit or 128-bit WEP 
encryption key.

• WPA
Enter the WPA shared key and click Next.
WPA authorizes and identifies users based on a secret key 
that changes automatically at regular intervals. WPA also 
uses TKIP (Temporal Key Integrity Protocol) and AES 
(Advanced Encryption Standard) for data encryption.

 

14 The window shows the wireless network settings and check if 
settings are right. Click Next.

• For the DHCP method

If the IP address assignment method is DHCP, check if 
DHCP is shown in the window. If it shows Static, click 
Change TCP/IP to change the assignment method to 
DHCP.

• For the Static method

If the IP address assignment method is Static, check if 
Static is shown in the window. If it shows DHCP, click 
Change TCP/IP to enter the IP address and other network 
configuration values for the machine. Before entering the 
IP address for the machine, you must know the computer’s 
network configuration information. If the computer is set 
to DHCP, you must contact the network administrator to 
get the static IP address.

For example:

If the computer’s network information is as shown follows:

- IP address: 169.254.133.42

- Subnet Mask: 255.255.0.0

Then, the machine’s network information should be as 
follows:

- IP address: 169.254.133.43
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- Subnet Mask: 255.255.0.0 (Use the computer’s subnet 
mask.)

- Gateway: 169.254.133.1

15 The wireless network connects according to the network 
configuration.

16 When the wireless network settings are completed, 
disconnect the USB cable between the computer and 
machine. 

17 Follow the instructions on the screen to complete the 
installation. After the installation is finished, click Quit or 
Restart.

Ad hoc via USB cable

If you do not have an access point (AP), you may still connect the 
machine wirelessly to your computer by setting up an ad hoc 
wireless network by following these simple directions.

� Items to prepare

• Network-connected computer

• Software CD that provided with your machine

• The machine installed with a wireless network interface

• USB cable

� Creating the ad hoc network in Macintosh

1 Check whether the USB cable is connected to the machine.

2 Turn on your computer and machine.

3 Insert the supplied software CD into your CD-ROM drive.

4 Double-click the CD-ROM icon that appears on your 
Macintosh desktop.

5 Double-click the MAC_Installer folder > Installer OS X icon.

6 Click Continue.

7 Read the license agreement and click Continue.

8 Click Agree to agree to the license agreement.

9 When the message that warns that all applications will close 
on your computer appears, click Continue.

10 Click Wireless Network Setting and Installation.

11 The software searches the wireless network devices.
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If the search has failed, check if the USB cable is connected 
between the computer and machine properly, and follow 
the instructions in the window.

 

12 After searching the wireless networks, a list of wireless 
networks your machine has searched appears. 

If you want to use the Samsung default ad hoc setting, select 
the last wireless network on the list, which Network 
Name(SSID) is portthru and Signal is Printer Self Network.

Then, click Next.

If you want to use other ad hoc settings, select another 
wireless network from the list. 

 

If you want to change ad hoc settings click the Advanced 
Setting button. 

• Enter the wireless Network Name: Enter the SSID name 
you want (SSID is case-sensitive).

• Operation Mode: Select ad hoc.

• Channel: Select the channel (Auto Setting or 2412 MHz 
to 2467 MHz).

• Authentication: Select an authentication type.
Open System: Authentication is not used, and encryption 
may or may not be used, depending on the need for data 
security.
Shared Key: Authentication is used. A device that has a 
proper WEP key can access the network.

• Encryption: Select the encryption (None, WEP64, 
WEP128).

• Network Key: Enter the encryption network key value.

• Confirm Network Key: Confirm the encryption network 
key value.

• WEP Key Index: If you are using WEP Encryption, select 
the appropriate WEP Key Index.

 

 

The wireless network security window appears when the ad 
hoc network has security setting.

The wireless network security window appears. Select Open 
System or Shared Key for the authentication and click Next.

• WEP (Wired Equivalent Privacy) is a security protocol 
preventing unauthorized access to your wireless network. 
WEP encrypts the data portion of each packet exchanged 
on a wireless network using a 64-bit or 128-bit WEP 
encryption key.
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13 The window showing the wireless network settings appears. 
Check the settings and click Next.
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Before entering the IP address for the machine, you must 
know the computer’s network configuration information. If 
the computer’s network configuration is set to DHCP, the 
wireless network setting should also be DHCP. Likewise, if 
the computer’s network configuration is set to Static, the 
wireless network setting should also be Static.

If your computer is set to DHCP and you want to use Static 
wireless network setting, you must contact the network 
administrator to get the static IP address.

• For the DHCP method
If the IP address assignment method is DHCP, check if 
DHCP is shown in the Wireless Network Setting Confirm 
window. If it shows Static, click Change TCP/IP to change 
the assignment method to Receive IP address 
automatically (DHCP).

• For the Static method
If the IP address assignment method is Static, check if 
Static is shown in the Wireless Network Setting Confirm 
window. If it shows DHCP, click Change TCP/IP to enter 
the IP address and other network configuration values for 
the machine.
For example:
If the computer’s network information is as shown follows:
- IP address: 169.254.133.42
- Subnet Mask: 255.255.0.0
Then, the machine’s network information should be as 
below:

- IP address: 169.254.133.43
- Subnet Mask: 255.255.0.0 (Use the computer’s subnet 

mask.)
- Gateway: 169.254.133.1

 

14 The wireless network connects according to the network 
configuration.

15 When the wireless network setting is completed, disconnect 
the USB cable between the computer and machine. 

16 Follow the instructions on the screen to complete the 
installation. After the installation is finished, click Quit or 
Restart.

18 

Using a network cable

Your machine is a network compatible machine. To enable your 
machine to work with your network, you will need to perform some 
configuration procedures.



Wireless network setup 532. Using a network-connected machine

 

• After completing the wireless network connection, you 
need to install a machine driver to print from an 
application (See "Installing driver over the network" on 
page 17).

• See your network administrator, or the person that set up 
your wireless network, for information about your 
network configuration.

 

Items to prepare

• Access point

• Network-connected computer

• Software CD that was provided with your machine

• The machine installed with a wireless network interface

• Network cable

Printing a network configuration report

You can identify the network settings of your machine by printing a 
network configuration report.

See "Printing a network configuration report" on page 13.

IP setting using SetIP Program (Windows)

This program is used to manually set the network IP address of your 
machine using its MAC address to communicate with the machine. 
The MAC address is the hardware serial number of the network 
interface and can be found in the Network Configuration Report. 

See "Setting IP address" on page 13.

Configuring the machine’s wireless network

Before starting you will need to know the network name (SSID) of 
your wireless network and the network key if it is encrypted. This 
information was set when the access point (or wireless router) was 
installed. If you do not know about your wireless environment, 
please ask the person who set up your network.

To configure wireless parameters, you can use SyncThru™ Web 
Service.

Using SyncThru™ Web Service

Before starting wireless parameter configuration, check the cable 
connection status. 
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1 Check whether or not the network cable is connected to the 
machine. If not, connect the machine with a standard network 
cable.

2 Start a web browser such as Internet Explorer, Safari or Firefox 
and enter your machine’s new IP address in the browser 
window.

For example,

3 Click Login on the upper right of the SyncThru™ Web Service 
website.

4 Type in the ID and Password then click Login.

• ID: admin 

• Password: sec00000

5 When the SyncThru™ Web Service window opens, click 
Network Settings.

6 Click Wireless > Wizard.

 

Wizard will help you setup the wireless network 
configuration. However, if you want to set the wireless 
network directly, select Custom.

 

7 Select the one Network Name(SSID) in the list.

• SSID: SSID (Service Set Identifier) is a name that identifies a 
wireless network, access points, and wireless devices 
attempting to connect to a specific wireless network must 
use the same SSID. The SSID is case-sensitive.

• Operation Mode: Operation Mode refers to the type of 
wireless connections (See "Wireless network name and 
network key" on page 31).

- Ad-hoc: Allows wireless devices to communicate 
directly with each other in a peer-to-peer environment.

- Infrastructure: Allows wireless devices to 
communicate with each other through an access point.

 

If your network’s Operation Mode is Infrastructure, select 
the SSID of the access point. If the Operation Mode is Ad-
hoc, select the machine’s SSID. Note that “portthru” is the 
default SSID of your machine.
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8 Click Next.

If the wireless security setting window appears, enter the 
registered password (network key) and click Next.

9 The confirmation window appears, please check your wireless 
setup. If the setup is right, click Apply.

 

Disconnect the network cable (standard or network). Your 
machine should then start communicating wirelessly with 
the network. In case of Ad-hoc mode, you can use a wireless 
LAN and wired LAN simultaneously.
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Turning the Wi-Fi network on/off

 

You can also turn on/off the Wi-Fi from the machine’s control 
panel using the Network menu.

 

1 Check whether the network cable is connected to the 
machine. If not, connect the machine with a standard network 
cable.

2 Start a web browser such as Internet Explorer, Safari or Firefox 
and enter your machine’s new IP address in the browser 
window.

For example,

3 Click Login on the upper right of the SyncThru™ Web Service 
website.

4 Type in the ID and Password then click Login.

• ID: admin 

• Password: sec00000 

5 When the SyncThru™ Web Service window opens, click 
Network Settings.

6 Click Wireless > Custom.

You can also turn the Wi-Fi network on/off.
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Troubleshooting

Problems during setup or driver installation

� Printers Not Found

• Your machine may not be turned on. Turn on your computer and 
the machine.

• USB cable is not connected between your computer and 
machine. Connect machine to your computer using the USB 
cable.

• The machine does not support a wireless network. Check the 
machine's user's guide included on the software CD supplied 
with your machine and prepare a wireless network machine.

� Connecting Failure - Not Found SSID

• The machine is unable to search the network name (SSID) you 
have selected or entered. Check the network name (SSID) on your 
access point and try connecting again. 

• Your access point is not turned on. Turn on your access point.

� Connecting Failure - Invalid Security

• You configured security incorrectly. Check the configured 
security on your access point and machine.

� Connecting Failure - General Connection Error

• Your computer is not receiving a signal from your machine. 
Check the USB cable and your machine’s power.

� Connecting Failure - Connected Wired Network

• Your machine is connected with a wired network cable. Remove 
the wired network cable from your machine.

� PC Connection Error

• The configured network address is unable to connect between 
your computer and machine.

- For a DHCP network environment

The receives the IP address automatically (DHCP) when 
computer is configured to DHCP.

- For a Static network environment

The machine uses the static address when the computer is 
configured to static address.

For example:

If the computer’s network information is as shown below:

� IP address: 169.254.133.42
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� Subnet Mask: 255.255.0.0

Then, the machine’s network information should be as below:

� IP address: 169.254.133.43

� Subnet Mask: 255.255.0.0 (Use the computer’s subnet 
mask.)

� Gateway: 169.254.133.1

Other problems

If problems occur while using the machine on a network, check the 
following: 

 

For information on the access point (or wireless router), refer 
to its own user's guide. 

 

• Your computer, access point (or wireless router), or machine may 
not be turned on.

• Check the wireless reception around the machine. If the router is 
far from the machine or there is an obstacle, you might have 
difficulty receiving the signal. 

• Cycle the power for the access point (or wireless router), machine, 
and computer. Sometimes cycling the power can recover 
network communication.

• Check whether firewall software (V3 or Norton) is blocking the 
communication. 

If the computer and the machine are connected on the same 
network and it cannot be found when searching, firewall 
software might be blocking the communication. Refer to the 
user's guide for the software to turn it off and try searching for the 
machine again.

• Check whether the machine's IP address is allocated correctly. 
You can check the IP address by printing the network 
configuration report.

• Check whether the access point (or wireless router) has a 
configured security (password). If it has a password, refer to the 
access point (or wireless router) administrator.

• Check the machine's IP address. Reinstall the machine driver and 
change the settings to connect to the machine on the network. 
Due to the characteristics of DHCP, the allocated IP address could 
change if the machine is not used for a long time or if the access 
point has been reset.

• Check the wireless environment. You might not be able to 
connect to the network in the infrastructure environment where 
you need to type in a user's information before connecting to 
access point (or wireless router).

• This machine only supports IEEE 802.11 b/g/n and Wi-Fi. Other 
wireless communication types (e.g., Bluetooth) are not 
supported.
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• When using the ad hoc mode, in operating systems such as 
Windows Vista, you might need to set the wireless connection 
setting every time you use the wireless machine. 

• You cannot use Infrastructure mode and Ad hoc mode at the 
same time for Samsung wireless network machines.

• The machine is within the range of the wireless network.

• The machine is located away from obstacles that could block the 
wireless signal.

Remove any large metal objects between the access point (or 
wireless router) and the machine.

Make sure the machine and wireless access point (or wireless 
router) are not separated by poles, walls, or support columns 
containing metal or concrete.

• The machine is located away from other electronic devices that 
may interfere with the wireless signal.

Many devices can interfere with the wireless signal, including a 
microwave oven and some Bluetooth devices.



3. Useful setting menus
This chapter explains how to browse the current status of your machine, and the 
method of setting for advanced machine setup. 

• Print menu 60

• Copy menu 61

• Fax menu 66

• Scan menu 69

• System setup 71 

• Admin setup 82

• Custom setup 83

� The control panel provides access to various menus to set up the 
machine or use the machine’s functions. These menus can be accessed 
by pressing  (Menu).
• An asterisk (*) appears next to the currently selected menu.
• Some menus may not appear on the display depending on options or 

models. If so, it is not applicable to your machine.
• For models that do not have the display screen on the control panel, 

this feature is not applicable.
• Some menu names may differ from your machine depending on its 

options or the models.
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Item Description

Orientation
Selects the direction in which information is 
printed on a page.

Copies 
You can enter the number of copies using the 
number keypad.

Resolution
Specifies the number of dots printed per inch 
(dpi). The higher the setting, the sharper printed 
characters and graphics.

Darkness
Lightens or darkens the print on the page. The 
Normal setting usually produces the best result. 
Use the Light toner density setting to save toner.

Darken Text Prints text darker than on a normal document.

Emulation Sets the emulation type and option.
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Copy Feature

Item Description

Scan Size

Original Size

Sets the image size.

Copies 
You can enter the number of copies using the 
number keypad.

Reduce/Enlarge Reduces or enlarges the size of a copied image.

Darkness
Adjusts the brightness level to make a copy 
that is easier to read, when the original 
contains faint markings and dark images.

Contrast 
Adjusts the contrast level to scan an original 
that is easier to read, when the original 
contains too faint or too dark contents.

Original Type
Improves the copy quality by selecting the 
document type for the current copy job.

Original 
Orientation

Sets the original image’s orientation.

Layout
Adjusts the layout format such as poster, clone, 
ID copy, 2/4-up, booklet, etc.

Copy Collation

Collate Copy

Set the machine to sort the copy job. For 
example, if you make 2 copies of a 3 page 
original, one complete 3 page document will 
print followed by a second complete 
document. 

• On: Prints output in sets to match the 
sequence of originals.

• Off: Prints output sorted into stacks of 
individual pages.

2-up or 4-up 
Copying

N-up Copy

Reduces the size of the original images and 
prints 2 or 4 pages onto one sheet of paper. 
This copy feature is available only when you 
load originals into the document feeder.

Item Description

1
2

1 2

3 4
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Poster Copy

Prints a single-page document onto 4 (Poster 
2x2), 9 (Poster 3x3), or 16 (Poster 4x4) sheets of 
paper, for the purpose of pasting the sheets 
together to form one poster-size document.

This copy feature is available only when you 
place originals on the scanner glass. 

Clone Copy

Prints multiple original images on a single 
page. The number of images is automatically 
determined by the original image and the 
paper size.

This copy feature is available only when you 
place originals on the scanner glass. 

Item Description

Book Copy

The Book Copy feature allows you to copy an 
entire book. If the book is too thick, lift the 
cover until its hinges are caught by the stopper 
and then close the cover. If the book or 
magazine is thicker than 30 mm, start copying 
with the cover open.

This copy feature is available only when you 
place originals on the scanner glass.

• Off: Does not use this feature.

• Left Page: Use this option to print left page 
of the book.

• Right Page: Use this option to print right 
page of the book.

• Both Page: Use this option to print both 
pages of the book.

Item Description
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Booklet

The machine automatically prints on one or 
both sides of the paper, which are then folded 
to produce a booklet with all of the pages in the 
correct sequence.

The machine will reduce and correctly adjust 
the position of each image to fit on the selected 
paper.

Adjust Bkgd

Prints an image without its background. This 
copy feature removes the background color 
and can be helpful when copying an original 
containing color in the background, such as a 
newspaper or a catalog.

• Off: Does not use this feature.

• Auto: Optimizes the background.

• Enhance Lev.1~2: The higher the number is, 
the more vivid the background is.

• Erase Lev.1~4: The higher the number is, 
the lighter the background is.

Item Description

Margin Shift 
copying

Allows you to create a binding edge for the 
document. The image can be adjusted up or 
down on the page and/or shifted to the right or 
left.

• Off: Does not use this feature.

• Auto Center: Automatically copy in the 
center of the paper. This feature is available 
only when you place originals on the 
scanner glass.

• Custom Margin: Enter the left, right, top, 
bottom margin using Number keypad.

Item Description
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Edge Erase 
copying

Allows you to erase spots, drill holes, fold 
creases and staple marks along any of the four 
edges of a document.

• Off: Does not use this feature.

• Small Original: rases the edge of the 
original if it is small. This feature is available 
only when you place originals on the 
scanner glass.

• Hole Punch: Erases the marks of 
bookbinding holes.

• Book Center: Erases the middle part of the 
paper which is black and horizontal, when 
you copy a book. This feature is available 
only when you place originals on the 
scanner glass.

• Border Erase: Enter the left, right, top, 
bottom margin using Number keypad.

Gray Eenhance 
copying

When you make a copy in gray scale, use this 
feature to get better quality of copy-output.

Item Description

Watermark 
copying

The watermark option allows you to print text 
over an existing document. For example, you 
use it when you want to have large gray letters 
reading “DRAFT” or “CONFIDENTIAL” printed 
diagonally across the first page or all pages of a 
document. Enter a text message in the 
Message option, and assign the page on which 
you want to print.

Duplex

print copies on both sides of paper.

• Off: Prints in normal mode.

• 1->2Side Short

• 1->2Side Long

Item Description

2

5
3
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Copy Setup

Duplex (continue)

• 2->1Side

• 2->2Side

• 2->1Side ROT2

Item Description

Change Default
Resets the value or setting to the printer’s out-
of-box state.

Item Description
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Fax Feature

Item Description

Scan Size

Original Size

Sets the image size.

Contrast 
Adjusts the contrast level to scan an original 
that is easier to read, when the original 
contains too faint or too dark contents.

Darkness
Adjusts the brightness level to scan an original 
that is easier to read, when the original 
contains faint markings and dark images.

Resolution

The default document settings proceduce 
good results when using typical text-based 
originals. However, if you send originals that 
are of poor quality, or contain photographs, 
you can adjust the resolution to produce a 
higher quality fax.

Duplex prints the received fax on both sides of paper.

Multi Send

Sends a fax to multiple destinations.

 

You cannot send a color fax using 
this feature. 

 

Delay Send

Sets your machine to send a fax at a later time 
when you will not be present. 

 

You cannot send a color fax using 
this feature. 

 

Priority Send

Scans the original into memory and 
immediately transmits it when the current 
operation is finished. Priority transmission will 
interrupt a sending to multiple destinations 
between stations (example, when the 
transmission to station A ends, before 
transmission to station B begins) or between 
redial attempts.

Forward

Forwards the received or sent fax to other 
destination by a fax, an email or a server. If you 
are out of office but have to receive the fax, this 
feature may be useful.

Item Description
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Sending Setup

5 

Receiving Setup

Secure Receive

Stores the received fax in memory without 
printing out. To print received documents, you 
need to enter the password. You can prevent 
your received faxes from being accessed by 
unauthorized people.

Add Page
Adds additional documents to a reserved delay 
fax job.

Cancel Job
Cancels the delayed fax job which is saved in 
memory.

Item Description

Redial Times
Sets the number of redial attempts. If you enter 
0, the machine will not redial.

Redial Term
Sets the time interval before automatic 
redialling. 

Prefix Dial

Sets a prefix of up to five digits. This number 
dials before any automatic dial number is 
started. It is useful for accessing a PABX 
exchange.

Item Description

ECM Mode
Sends faxes using error correction mode (ECM) 
to makes sure the faxes are sent smoothly 
without any error. It may take more time.

Send Report
Prints a confirmation report showing whether a 
transmission was successful, how many pages 
were sent, and more.

Image TCR
Prints a transmission report with a minimized 
image of the first page of the fax sent. 

Dial Mode
Sets the dialing mode to either tone or pulse. 
This setting may not be available depending on 
your country.

Toll Save
Sends faxes at a preset toll-saving time to save 
on call costs. This setting may not be available 
depending on your country.

Setup Wizard
Makes it easy to configure the necessary fax 
options such as Machine ID, Fax Number, etc.

Item Description

Receive Mode Selects the default fax receiving mode.

Item Description
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Ring To Answer
Specifies the number of times the machine 
rings before answering an incoming call.

Stamp RCV Name

Stamp Rcvd Name

Automatically prints the page number, and the 
date and time of reception at the bottom of 
each page of a received fax.

Rcv Start Code

Initiates fax reception from an extension phone 
plugged into the EXT socket on the back of the 
machine. If you pick up the extension phone 
and hear fax tones, enter the code. It is preset to 
*9* at the factory.

Auto Reduction
Automatically reduces an incoming fax page to 
fit the size of the paper loaded in the machine.

Discard Size
Discards a specific length from the end of the 
received fax.

Junk Fax Setup

Blocks any unwanted faxes that you stored in 
the memory as junk fax numbers. This setting 
may not be available depending on your 
country.

DRPD Mode

 Enables a user to use a single telephone line to 
answer several different telephone numbers. 
You can set the machine to recognize different 
ring patterns for each number. This setting may 
not be available depending on your country.

Item Description

Duplex Print
Prints the received fax data on both sides of the 
paper. You can save the paper usage.

Doc Box Saving

Document Box 
Saving

Stores received faxes in the common box. This 
menu only appears when an optional hard disk 
drive has been installed.

Item Description
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Scan Feature

7 

Scan Setup

Item Description

USB Default

USB

Sets scan destination to a USB. You scan the 
originals and save the scanned image to a USB 
device.

Email Default

Send Email

Custom Email

Sets scan destination to an email. You scan the 
originals and email the scanned image to 
destinations.

FTP Default

FTP

Sets scan destination to an FTP server. You scan 
the originals and send the scanned image to an 
FTP server.

SMB Default

SMB

Sets scan destination to an SMB server. You 
scan the originals and send the scanned image 
to an SMB server.

Send Report
Prints a confirmation report showing whether 
the scanned image sending was successful.

Local PC

Sets scan destination to a usb-connected 
computer. You scan the originals and save the 
scanned image to a directory such as My 
Documents.

Network PC

Sets scan destination to a network-connected 
computer. You scan the originals and save the 
scanned image to a directory such as My 
Documents.

Document Box

Sets scan destination to a Document Box. You 
scan the originals and send the scanned image 
to the storage which called Document Box in 
the machine.

Shared Boxes
Sets scan destination to a shared folder. You 
can create and use the shared folder (see 
"Using shared folder features" on page 123). 

Item Description

Scan Size

Original Size

Sets the image size.

Original Type Sets the original document’s type.

Resolution Sets the image resolution.

Color Mode Sets the color mode.

Item Description
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File Format
Sets the file format in which the image is to be 
saved. If you select BMP, JPEG, TIFF, or PDF, you 
can select to scan multiple pages.

Darkness Adjusts the brightness level to scan.

Contrast
Adjust the contrast level to scan lighter or 
darker than the original.

Item Description
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Machine Setup

Item Description

Machine ID
Sets the machine ID which will be printed at the 
top of each fax page that you send.

Fax Number
Sets the fax number which will be printed at the 
top of each fax page that you send.

Date & Time Sets the date and time.

Clock Mode
Selects the format for displaying time between 
12 hr and 24 hr. 

Form Menu

• Off: Prints in normal mode.

• Single Form: Prints all page using the first 
form.

• Double Form: Prints the front page using the 
first form and the back page using the second 
form.

Select Form
Form overlay is images stored on the printer’s 
hard disk as a special file format that can be 
printed in layers on any document. 

HDD Spooling
When On, stores documents on the hard disk 
drive (HDD) for network printing.

Language
Sets the language of the text that appears on the 
control panel display.

Default Mode
Sets the machine’s default mode among fax 
mode, copy mode, or scan mode.

Default Paper 
Size

You can set the default paper size to use.

Power Save

Sets how long the machine waits before going to 
power save mode.

When the machine does not receive data for an 
extended period of time, power consumption is 
automatically lowered. 

Scan PWR Save

Sets how long the machine’s scanner part waits 
before going to power save mode.

When the scanner does not receive data for an 
extended period of time, power consumption is 
automatically lowered. 

System Timeout
Sets the time that the machine remembers 
previously used copy settings. After the timeout, 
the machine restores the dafault copy settings.

Job Timeout
Sets the length of time the printer waits before 
printing the last page of a print job that does not 
end with a command to print the page.

Item Description
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Wakeup Event

You can set the condition to wake up from 
power-save mode. Set the item on.

• Button Press: When you press any button 
except power button, the machine wake up 
from the power save mode.

• Printer: When you open or close the paper 
tray, the machine wake up from the power 
save mode.

Auto Continue

Determine whether or not the machine 
continues printing when it detects the paper 
does not match the paper settings.

• Off: If a paper mismatch occurs, the machine 
waits until you insert the correct paper. 

• On: If a paper mismatch occurs, an error 
message will display. The machine waits for 
about 30 second, then automatically clear the 
message and continue printing. 

Altitude Adj.

Altitude 
Adjustment

Optimize print quality according to the 
machine’s altitude.

Auto CR
Allows you to append the required carriage 
return to each line feed, which is useful for Unix 
or DOS users.

Item Description

Firmware 
Version

Shows the product’s firmware version.

AutoComplete

Provides sugestions while you type an email 
address or fax number. This enables you to find 
and select the data without typing it in 
completely.

Tray Chaining

Auto Tray Switch

Determine whether or not the machine 
continues printing when it detects the paper 
does not match.

Paper 
Substitution

Automatically substitutes the printer driver’s 
paper size to prevent the paper mismatch 
between Letter and A4. For example, if you have 
A4 paper in the tray but you set the paper size to 
Letter in the printer driver, the machine prints on 
A4 paper and vice versa.

Paper Mismatch

Determine whether to disregard the paper 
mismatch error or not. Select Off, then the 
machine does not stop printing even if the paper 
mismatches.

Print Blank Page
The printer detects the printing data from 
computer whether a page is empty or not. You 
can set to print or skip the blank page.

Item Description
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Multi-Bin
• Mode: Selects the mult-bin mode you want to 

use. 

• Default Bin: Selects the bin to use as a default.

Default Source Sets the tray to use as a default.

Address Book
Views or prints the phonebook or email address 
list.

Item Description

Maintenance

• Clean Drum: Cleans the OPC drum of the 
cartridge by printing a sheet.

• Clean Fuser: Cleans the fuser by printing a 
sheet.

• CLR Empty Msg.:  This option appears only 
when toner cartridge is empty.

• Supplies Info.: Allows you to check how 
many pages are printed and how much toner 
is left in the cartridge. 

• TonerLow Alert: If toner in the cartridge has 
run out, a message informing the user to 
change the toner cartridge appears. You can 
set the option for this message to appear or 
not.

• Paper Stacking: If you use a machine in a 
humid area, or you are using the damp print 
media caused by a high humidity, the print-
outs on the output tray may be curled and 
may not be stacked properly. In this case, you 
can set the machine to use this function to let 
print-outs stacked firmly. But, using this 
function will make the print speed slow.

Import Setting
Imports data stored on a USB memory stick to 
the machine.

Item Description
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Paper Setup

Export Setting
Exports data stored on a USB memory stick to the 
machine.

Toner Save

Activating this mode extends the life of your 
toner cartridge and reduces your cost per page 
beyond what one would experience in the 
normal mode, but it reduces print quality.

Quiet Mode
You can reduce the printing noise by turning this 
menu on. However, the printing speed and 
quality may be declined. 

Eco

Eco Setup

Allows you to save print resources and enables 
eco-friendly printing. 

• Default Mode: Select whether to turn the Eco 
mode on or off.

 

On force (On-Forced): Sets the Eco 
mode on with password. If a user 
wants to turn the Eco mode on/off, the 
user needs to enter the password.

 

• Change Template: Selects the eco template 
set from the SyncThru™ Web Service.

Barcode 
FreeScape

You can set the freescape for barcodes. Enable 
this option to set the freescape code.

Item Description

Clear Setting Restores the machine’s factory default settings. 

Item Description

Paper Size
Sets the paper size as A4, Letter, or other paper 
sizes, according to your requirements.

Paper Type Chooses the type of the paper for each tray.

Paper Source Selects from which tray the paper is used.

Margin Sets the margins for the document.

Tray Confirm

Activates the tray confirmation message. If you 
open and close a tray, a window asking you 
whether to set the paper size and type for the 
tray just opened appears.

Item Description
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Sound / Volume

11 

Report

Item Description

Key Sound
Turns the key sound on or off. With this option 
set to on, a tone sounds each time a key is 
pressed.

Alarm Sound
Turns the alarm sound on or off. With this option 
set to on, an alarm tone sounds when an error 
occurs or fax communication ends.

Speaker

Turns on or off the sounds from the telephone 
line through the speaker, such as a dial tone or a 
fax tone. With this option set to Comm. which 
means the speaker is on until the remote 
machine answers.

 

You can adjust the volume level using 
On Hook Dial.

 

Ringer
Adjusts the ringer volume. For the ringer 
volume, you can select off, low, middle, and high 
level.

Item Description

Menu Map
Prints the menu map which shows the layout 
and current settings of this machine.

All Reports
Prints all kinds of reports that this machine 
provides.

Configuration
Prints a report on the machine's overall 
configuration.

Supplies Info.

Supplies 
Information

Prints supplies’ information page. 

Address Book 
Prints all of the email addresses currently 
stored in the machine’s memory.

Demo Page
Prints the demo page to check whether your 
machine is printing properly or not.
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Fax Send

Prints a transmission report including the fax 
number, the number of pages, the elapsed 
time of the job, the communication mode, and 
the communication results for fax job. You can 
set up your machine to automatically print a 
transmission confirmation report after each fax 
job. 

Fax Sent

Prints information on the faxes you have 
recently sent. You can set the machine to 
automatically print this report every 50 
communications.

Fax Received
Prints information on the faxes you have 
recently received.

Email Sent

Prints information on the emails you have 
recently sent. You can set the machine to 
automatically print this report every 50 
communications.

Scheduled Jobs

Fax Scheduled 
Jobs

Prints the document list currently stored for 
delayed faxes along with the starting time and 
type of each operation.

JunkFax
Prints the fax numbers specified as junk fax 
numbers.

Item Description

Network Conf. 

Network 
Configuration 

Prints information on your machine’s network 
connection and configuration.

User Auth

Local User 
Authentication

Prints the authorized users who are allowed to 
use the email function.

PCL Font Prints the PCL font list.

PS Font

PS3 Font

Prints the PS/PS3 font list.

EPSON Font Prints the EPSON font list.

KSC5843 Font Prints the KS font list.

KSC5895 Font Prints the KS5895 font list.

KSSM Font Prints the KSSM font list.

Net User Auth

Network User 
Authentication

Prints the users and their IDs who logged in the 
domain.

Usage Counter
Prints a u16

 sage page. The usage page contains the total 
number of pages printed.

Fax Options Prints the information of a fax reports.

Item Description
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Maintenance

13 

Clear Setting

Stored Job List

Stored Jobs

Prints jobs currently stored in the optional 
memory or on a hard disk (HDD).

Completed Job

Completed Jobs

Prints list of completed jobs.

Accounting Report

Accounting

This is used only available when Job 
Accounting is enabled from the SyncThru™ 
Web Admin Service. You can print a report of 
printout counts for each user.

Item Description

CLR Empty Msg.
When toner cartridge is empty, this option 
appears. You can clear the empty message.

Ignore Toner
You can set the machine to ingore the toner 
empty message and continue printing except 
incoming faxes.

Supplies Life Shows the supply life indicators.

Toner Low Alert
Customizes the level to alert toner low or toner 
empty.

Item Description

Serial Number
Shows the machine’s serial number. When you 
call for service or register as a user on the 
Samsung website, you can find this.

Paper Stacking

Enables the automatic linking feature for trays. 
when one tray is not available for paper empty or 
mismatch, this option allows your printer to feed 
paper from another available tray.

Color
Allows you to adjust the color setting such as 
contrast level, color registration, color density, 
etc.

Ram Disk

Sets some part of ram disk to the job storage 
area. Using the storage area activates the job 
manage menu (see "Job Manage" on page 78). 
This allows the data from your computer to be 
sent to the print queue of the ram disk. 

Item Description

All Setting
Clears all of the data stored in memory and resets 
all of your settings to the factory default.

Item Description
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Job Manage

Printer Setup
Restores all of the printer options to the factory 
default.

Paper Setup
Restores all of the paper options to the factory 
default.

Tray Behaviour
Restores all of the tray behaviour settings to the 
factory default.

Fax Setup

Fax Default

Restores all of the fax options to the factory 
default.

Copy Setup

Copy Default

Restores all of the copy options to the factory 
default.

Scan Setup

Scan Default

Restores all of the scan options to the factory 
default.

System Setup
Restores all of the system options to the factory 
default.

Network Setup
Restores all of the network options to the factory 
default. (Reboot required.)

Address Book
Clears all of the email address entries stored in 
memory.

Fax Sent

Sent Report

Clears all records of sent faxes.

Item Description

Email Sent Clears all records of sent emails.

Fax Rcv Report

Rcvd Report

Clears all records of received faxes.

Item Description

Active Job
Shows the print job lists that are waiting to be 
printed.

Store Job
Shows the print job lists that are stored on the 
disk.

File Policy
If the memory already has the same name when 
you entered a new file name, you can rename or 
overwrite it.

Item Description
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ImageOverwrite

16 

USB setup

17 

Emulation setup

18 

Email setup

Item Description

Manual
You can overwrite the embedded USB memory 
to clear all of the data stored in.

Option Description

Print From Views the file list from the File Navigation. 
Select a file to print.

Scan to USB
Sets scan destination to a USB. You scan the 
originals and save the scanned image to a USB 
device.

File Manage Views the file list from the File Navigation. 
Select a file to delete. You can format the USB 
device.

Show Space Shows the remaining space.

Item Description

Emulation Type
The machine language defines how the 
computer communicates with the machine.

Setup
Sets the detailed settings for the selected 
emulation type.

Option Description

SMTP Server Sets the SMTP server configuration.

Send to Self
Sets to send the mail to yourself so that you can 
back up the email or use as a reminder.

Default To 
Address

Sets an email destination address as a default 
one.

Default From Sets a sender’s email address as a default one.

Default Subject Sets an email’s subject as a default one.
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Address book setup

20 

Document Box setup

Doc Box Feature

Doc Box Setup

21 

Network setup

Option Description

PhoneBook
Adds, views, prints or deletes the the phonebook 
list. You also can create a group.

Email
Adds, views, prints or deletes the the email list. 
You also can create a group.

Option Description

Add From Scan Stores scanned documents in a box. The stored 
file will be named automatically as 
"yearmonthdayhourminutesecond".

Task From Box Prints a document from a box.

Option Description

Add From Scan
Sets the default options for storing the 
document to a box.

Task From Box
Sets the default options for printing the 
document from a box.

Option Description

TCP/IP (IPv4)

Selects the appropriate protocol and configure 
parameters to use the network environment.

 

There are lots of parameters to be set. 
If you are not sure, leave as is, or 
consult the network administrator.

 

TCP/IP (IPv6)
Selects this option to use the network 
environment through IPv6 (see "IPv6 
configuration" on page 28).
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Ethernet Speed Configure the network transmission speed.

802.1x
You can selects the user authentication for 
network communication. For detailed 
information consult the network administrator.

Wireless Selects this option to use the wireless network.

Clear Setting
Reverts the network settings to the default 
values. (Reboot required.)

Network Conf. 
(Network 
Configuration)

This list shows information on your machine’s 
network connection and configuration.

Net. Activate You can sets whether to use Ethernet on or off.

Http Activate
You can sets whether to use SyncThru™ Web 
Service or not.

Option Description
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Item Description

Password 
Protect

Sets the password to access the Admin Setup 
menu. Select On to use this option and enter the 
password

Change 
Password

Changes the machine’s password for accessing the 
Admin Setup.

Maintenance

• Clean Fuser: Cleans the fuser by printing a 
sheet. The printed sheet has toner debris on it. 

• CLR Empty Msg.: Prevents the TonerLow Alert 
message from appearing on the display.

• Supplies Info.: Allows you to check how many 
pages are printed and how much toner is left in 
the cartridge. 

• TonerLow Alert: If toner in the cartridge has run 
out, a message informing the user to change the 
toner cartridge appears. You can set the option 
for this message to appear or not.

• Ram Disk: Enables/disables RAM disk to manage 
jobs. Depending on the installed optional 
memory size, you can set the RAM disk size to 
between 32 and 64 MB. This option does not 
appear if you have installed hard disk drive 
(HDD). 



833. Useful setting menusCustom setup

This menu appears only when the XOA (eXtensible Open 
Architecture) web application is installed. Contact the administrator 
to use this menu.



4. Special features
This chapter explains special copying, scanning, faxing, and printing features.

• Altitude adjustment 85

• Changing the font setting 86

• Storing email address 87

• Entering various characters 89

• Setting up the address book 90

• Registering authorized users 93

• Printing features 94

• Fax features 111

• Scan features 114

• Using shared folder features 123

• Using memory/hard drive features 124

� • The procedures in this chapter are mainly based on Windows 7.
• It may be necessary to press OK to navigate to lower-level menus for 

some models.
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Print quality is affected by atmospheric pressure, which is 
determined by the height of the machine above sea level. The 
following information will guide you on how to set your machine for 
the best print quality.

Before you set the altitude value, determine the altitude where you 
are.

You can set the altitude value from Device Settings or Machine 
section in Printer Settings Utlity program.

• For Windows and Macintosh users, see "Device Settings" on page 
135.

• For Linux users, see "Using Smart Panel ( Linux only)" on page 
137.

 

• If your machine is connected to the network, you can set 
the altitude via SyncThru™ Web Service.

• You can also set the altitude in System Setup option on 
the machine’s display.

 

1 High 3
2 High 2
3 High 1
4 Normal0

4,000 m
(13,123 ft) 

3,000 m
(9,842 ft) 

2,000 m
(6,561 ft) 

1,000 m
(3,280 ft) 

4

3

2

1



864. Special featuresChanging the font setting

Your machine has preset the font for your region or country.

If you want to change the font or set the font for special condition, 
such as the DOS environment, you can change the font setting from 
Emulation section in Printer Settings Utility program.

• For Windows and Macintosh users, see "Advanced settings user 
interface overview" on page 135.

• For Linux, or Unix OS users, see "Using Smart Panel ( Linux only)" 
on page 137.

 

• If your machine is connected to the network, you can set 
the font setting via SyncThru™ Web Service.

• You can also change the font setting in Emulation option 
on the machine’s display.

• The following information shows the proper font list for 
corresponding languages.
- Russian: CP866, ISO 8859/5 Latin Cyrillic
- Hebrew: Hebrew 15Q, Hebrew-8, Hebrew-7 (Israel only)
- Greek: ISO 8859/7 Latin Greek, PC-8 Latin/Greek
- Arabic & Farsi: HP Arabic-8, Windows Arabic, Code 

Page 864, Farsi, ISO 8859/6 Latin Arabic
- OCR: OCR-A, OCR-B

 



874. Special featuresStoring email address

You can set up address book with the email addresses you use 
frequently via SyncThru™ Web Service and then easily and quickly 
enter email addresses by entering the location numbers assigned to 
them in address book.

1 

Storing on your local machine

1 Access the SyncThru™ Web Service (see "Using SyncThru™ 
Web Service" on page 130).

2 Click Login on the upper right of the SyncThru™ Web Service 
website.

3 Type in the ID and Password then click Login.

• ID: admin 

• Password: sec00000

4 Click Address Book > Individual > Add.

5 Select the Speed No. and enter e-mail address and fax 
number.

 

• If you need to set SMB or FTP sever information, check SMB 
or FTP and set the information. 

 

6 Click Apply.

7 If you make a group, click Address Book > E-mail Group > 
Add Group.

8 Select the Speed No. and enter Group Name.

 

• You can easily add individual address if you check Yes for 
Add individual(s) after this group is created. 

 

9 Click Apply.

2 

Searching for an address

Searching sequentially through memory

1 Select (Scan) > Address Book > Search & Send > Select an 
address group > All on the control panel.

Or select Setup > Machine Setup > Next > Address Book > 
Email > View List > Individual or Group on the touch screen.

2  Search upwards or downwards through the entire memory in 
index (numerical) order, and select the name and address you 
want.
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Searching with a particular first letter

1 Select (Scan) > Address Book > Search & Send > Select an 
address group > ID on the control panel.

2  Enter the first few letters of the name you want.

3  Search upwards or downwards, and select the name and 
address you want.
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As you perform various tasks, you may need to enter names and 
numbers. For example, when you set up your machine, you enter 
your name or your company’s name, and the fax number. When you 
store fax numbers or email addresses in memory, you may also enter 
the corresponding names.

3 

Entering alphanumeric characters

Press the button until the correct letter appears on the display. For 
example, to enter the letter O, press 6, labeled with MNO. Each time 
you press 6, the display shows a different letter, M, N, O, m, n, o and 
finally 6. To find the letter that you want to enter, see "Keypad letters 
and numbers" on page 89.

 

• You can enter a space by pressing 1 twice.

• To delete the last digit or character, press the left/right or 
up/down arrow button.

 

4 

Keypad letters and numbers

Special character sets may differ from your machine depending on 
its options or the models.

Key Assigned numbers, letters, or characters

1 @ / . ‘ 1

2 A B C a b c 2

3 D E F d e f 3

4 G H I g h i 4

5 J K L j k l 5

6 M N O m n o 6

7 P Q R S p q r s 7

8 T U V t u v 8

9 W X Y Z w x y z 9

0 & + - , 0

*
* % ^ _ ~ ! # $ ( ) [ ]

(These symbols are available when you type for 
network authentication.)

#
# = | ? " : { } < > ;

(These symbols are available when you type for 
network authentication.)
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You can set up speed number with the fax numbers you use 
frequently via SyncThru™ Web Service and then easily and quickly 
enter fax numbers by entering the location numbers assigned to 
them in address book.

5 

Registering a speed dial number

1 Select  (Fax) > Address Book > New & Edit > Speed Dial 
on the control panel. 

Or select Setup > Machine Setup > Next > Address Book > 

Phone Book > View List > Individual > (options) > 
Add on the touch screen.

2 Enter a speed dial number and press OK.

 

If an entry is already stored in the number you choose, the 
display shows the message to allow you to change it. To start 
over with another speed dial number, press  (Back). 

 

3 Enter the name you want and press OK.

4 Enter the fax number you want and press OK.

5 Press the  (Cancel or Stop/Clear) button to return to ready 
mode.

6 

Using speed dial numbers

When you are prompted to enter a destination number while 
sending a fax, enter the speed dial number at which you stored the 
number you want.

 

• For a one-digit (0-9) speed dial number, press and hold the 
corresponding digit button on the number keypad. 

• For a two- or three-digit speed dial number, press the first 
digit button(s) and then hold down the last digit button. 

• You can print the address book list by selecting  (Fax) 
> Address Book > Print. 
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7 

Editing speed dial numbers

1 Select  (Fax) > Address Book > New & Edit > Speed Dial 
on the control panel. 

Or select Setup > Machine Setup > Next > Address Book > 
Phone Book > View List > Individual on the touch screen.

2 Enter the speed dial number you want to edit and press OK.

3 Change the name and press OK.

4 Change the fax number and press OK.

5 Press  (Cancel or Stop/Clear) to return to ready mode.

8 

Registering a group dial number

1 Select  (Fax) > Address Book > New & Edit > Group Dial 
on the control panel. 

Or select Setup > Machine Setup > Next >Address Book > 

Phone Book > View List > Group> (options) > Add on 
the touch screen.

2 Enter a group dial number and press OK.

 

If an entry is already stored in the number you choose, the 
display shows the message to allow you to change it. To start 
over with another speed dial number, press  (Back). 

 

3 Search by entering the first few letters of the speed dial’s 
name to put in the group.

4 Select the name and number you want and press OK.

5 Select Yes when Another Number? appears.

6 Repeat step 3 to include other speed dial numbers into the 
group.



Setting up the address book 924. Special features

7 When you have finished, select No when Another Number? 
appears and press OK.

8 Press  (Cancel or Stop/Clear) to return to ready mode.

9 

Editing group dial numbers

1 Select  (Fax) > Address Book > New & Edit > Group Dial 
on the control panel. 

Or select Setup > Machine Setup > Next > Address Book > 
Phone Book > View List > Group on the touch screen.

2 Enter the group dial number you want to edit and press OK.

3 Enter a new speed dial number to add and press OK, then 
Add? appears.

Enter a speed dial number stored in the group and press OK, 
Delete? appears.

4 Press OK to add or delete the number.

5 Repeat step 3 to add or delete more numbers.

6 Select No at the Another Number? and press OK.

7 Press  (Cancel or Stop/Clear) to return to ready mode.



934. Special featuresRegistering authorized users

If you have connected your machine to a network and set up the 
network parameters correctly, you can scan and send images over 
the network. To send a scanned image through email or via network 
server safely, you must register account information of authorized 
users to your local machine using SyncThru™ Web Service.

1 Access the SyncThru™ Web Service (see "Using SyncThru™ 
Web Service" on page 130).

2 Click Login on the upper right of the SyncThru™ Web Service 
website.

3 Type in the ID and Password then click Login.

• ID: admin 

• Password: sec00000

4 Click Security > User Access Control > Authentication.

5 Select Local Authentication in the the Authentication 
Method, and click Apply.

6 Click OK in the confirmation pop-up window.

7 Click User Profile > Add.

8 Enter User Name, Login ID, Password, Confirm Password, E-
mail Address, and Fax Number.

 

You can easily add individual address if you check Yes for 
Add individual(s) after this group is created. 

 

9 Click Apply.
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10 

Changing the default print settings

1 Click the Windows Start menu. 

2 Select Control Panel > Devices and Printers.

3 Right-click on your machine.

4 Select Printing preferences.

 

If Printing preferences has a , you can select other printer 
drivers connected to the selected printer.

 

5 Change the settings on each tab. 

6 Click OK.

 

If you want to change the settings for each print job, change 
it in Printing Preferences. 

 

11 

Setting your machine as a default machine

1 Click the Windows Start menu.

2 Select Control Panel > Devices and Printers.

3 Select your machine.

4 Right-click your machine and select Set as Default Printer.

 

If Printing preferences has a , you can select other printer 
drivers connected to the selected printer.
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12 

Using advanced print features

 

XPS printer driver: used to print XPS file format. 

• The XPS printer driver can be installed only on Windows 
Vista OS or higher.

• You can install the XPS printer driver when you insert the 
software CD into your CD-ROM drive. When the 
installation window appears, select Advanced 
Installation > Custom Installation. You can select the 
XPS printer driver in the Select Software and Utilities to 
Install window.

• Install optional memory when an XPS job does not print 
because the printer is out of memory.

 

Printing to a file (PRN)

You will sometimes need to save the print data as a file. 

1 Check the Print to file box in the Print window.

2 Click Print.

3 Type in the destination path and the file name, and then click 
OK.

For example, c:\Temp\file name.

 

If you type in only the file name, the file is automatically 
saved in My Documents, Documents and Settings, or 
Users. The saved folder may differ, depending on your 
operating system or the application you are using.

 

Understanding special printer features

You can use advanced printing features when using your machine.
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To take advantage of the printer features provided by your printer driver, click Properties or Preferences in the application’s Print window 
to change the print settings. The machine name, that appears in the printer properties window may differ depending on the machine in use.
 

Item Description

Multiple Pages per Side Selects the number of pages to print on a single sheet of paper. To print more than one page per sheet, the pages will 
be reduced in size and arranged in the order you specify. You can print up to 16 pages on one sheet. 

Poster Printing
Prints a single-page document onto 4 (Poster 2x2), 9 (Poster 3x3), or 16 (Poster 4x4) sheets of paper, for the purpose 
of pasting the sheets together to form one poster-size document.

Select the Poster Overlap value. Specify Poster Overlap in millimeters or inches by selecting the radio button on the 
upper right of Basic tab to make it easier to paste the sheets together.
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Booklet Printing

Prints your document on both sides of a sheet of paper and arranges the pages so that the paper can be folded in half 
after printing to produce a booklet.

If you want to make a booklet, you need to print on Letter, Legal, A4, US Folio, or Oficio sized print media. 

 

The Booklet Printing option is not available for all paper sizes. Select the available paper Size option under 
the Paper tab to see what paper sizes are available.

If you select an unavailable paper size, this option can be automatically canceled. Select only available 
paper (paper without  or  mark).

 

Double-sided Printing

Print on both sides of a sheet of paper (duplex). Before printing, decide how you want your document oriented. 

 

• You can use this feature with Letter, Legal, A4, US Folio or Oficio sized paper 

• If your machine does not have a duplex unit, you should complete the printing job manually. The 
machine prints every other page of the document first. After that, a message appears on your computer.

• Skip Blank Pages feature does not work when you select the duplex option.

 

Item Description

8 9
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Double-sided Printing 
(continue)

• Printer Default: If you select this option, this feature is determined by the settings you have selected on the 
control panel of the machine. This option is available only when you use the PCL/XPS printer driver.

• None: Disables this feature.

• Long Edge: This option is the conventional layout used in bookbinding.

• Short Edge: This option is the conventional layout used in calendars.

• Reverse Double-Sided Printing: Check this option to reverse the print order when duplex printing.

Paper Options Changes the size of a document to appear larger or smaller on the printed page by entering in a percentage by which 
to enlarge or decrease the document.

Watermark The watermark option allows you to print text over an existing document. For example, you use it when you want to 
have large gray letters reading “DRAFT” or “CONFIDENTIAL” printed diagonally across the first page or all pages of a 
document. 

Item Description
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Watermark

(Creating a watermark)

a To change the print settings from your software application, access Printing Preferences.
b Click the Advanced tab, select Edit from the Watermark drop-down list. The Edit Watermarks window appears.
c Enter a text message in the Watermark Message box. 

You can enter up to 256 characters. The message displays in the preview window.

Watermark

(Editing a watermark)

a To change the print settings from your software application, access Printing Preferences.
b Click the Advanced tab, select Edit from the Watermark drop-down list. The Edit Watermarks window appears. 
c Select the watermark you want to edit from the Current Watermarks list and change the watermark message and 

options. 
d Click Update to save the changes.
e Click OK or Print until you exit the Print window. 

Watermark

(Deleting a watermark)

a To change the print settings from your software application, access Printing Preferences.
b Click the Advanced tab, select Edit from the Watermark drop-down list. The Edit Watermarks window appears. 
c Select the watermark you want to delete from the Current Watermarks list and click Delete. 
d Click OK or Print until you exit the Print window.

Item Description
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Overlay

This option is available only when you use the PCL printer driver.

An overlay is text and/or images stored in the computer hard disk drive (HDD) as a special file format that can be 
printed on any document. Overlays are often used to take the place of letterhead paper. Rather than using preprinted 
letterhead, you can create an overlay containing exactly the same information that is currently on your letterhead. To 
print a letter with your company’s letterhead, you do not need to load preprinted letterhead paper in the machine: 
just print the letterhead overlay on your document.

To use a page overlay, you must create a new page overlay containing your logo or image.

 

• The overlay document size must be the same as the document you print with the overlay. Do not create 
an overlay with a watermark.

• The resolution of the overlay document must be the same as that of the document you will print with 
the overlay.

 

Overlay

(Creating a new page 
overlay)

a To save the document as an overlay, access Printing Preferences.
b Click the Advanced tab, and select Edit from the Text drop-down list. Edit Overlay window appears.
c In the Edit Overlay window, click Create. 
d In the Save As window, type a name up to eight characters in the File name box. Select the destination path, if 

necessary (The default is C:\Formover).
e Click Save. The name appears on the Overlay List. 
f Click OK or Print until you exit the Print window.

The file is not printed. Instead, it is stored on your computer hard disk drive.

Item Description
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Overlay

(Using a page overlay)

a Click the Advanced tab. 
b Select the desired overlay from the Text drop-down list. 
c If the overlay file you want does not appear in the Text drop-down list, select Edit... from the list and click Load. 

Select the overlay file you want to use. 
If you have stored the overlay file you want to use in an external source, you can also load the file when you access 
the Open window. 
After you select the file, click Open. The file appears in the Overlay List box and is available for printing. Select the 
overlay from the Overlay List box. 

d If necessary, check Confirm Page Overlay When Printing box. If this box is checked, a message window appears 
each time you submit a document for printing, asking you to confirm printing an overlay on your document. 
If this box is not checked and an overlay has been selected, the overlay automatically prints with your document. 

e Click OK or Print until you exit the Print window. 

Overlay

(Deleting a page 
overlay)

a In the Printing Preferences window, click the Advanced tab. 
b Select Edit in the Text drop down list. 
c Select the overlay you want to delete from the Overlay List box. 
d Click Delete. 
e When a confirming message window appears, click Yes.
f Click OK or Print until you exit the Print window. You can delete page overlays that you no longer use.

Item Description
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Print Mode

 

•  This feature is available only if you have installed the optional memory or hard disk, or set the RAM disk.

• Some menus may not appear on the display depending on options or models. If so, it is not applicable 
to your machine.

 

• Print Mode: The default Print Mode is Normal, which is for printing without saving the printing file in the 
memory. 
- Normal: This mode prints without storing your document in the optional memory. 
- Proof: This mode is useful when you print more than one copy. You can print one copy first to check, then print 

the rest of the copies later. 
- Confidential: This mode is used for printing confidential documents. You need to enter a password to print. 
- Store: Select this setting to save a document in the hard disk without printing. 
- Store and Print: This mode is used when printing and storing document at the same time. 
- Spool: This option can be useful when handling large amounts of data. If you select this setting, the printer 

spools the document into the hard disk and then prints it from the hard disk queue, decreasing the computer’s 
work load.

- Print Schedule: Select this setting to print the document at a specified time.

• User ID: This option is used when you need to find a saved file using the control panel. 

• Job Name: This option is used when you need to find a saved file using the control panel. 

Item Description
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Using Direct Printing Utility (Windows only)

What is Direct Printing Utility?

Direct Printing Utility is a program that sends the PDF files directly to your machine to print without having to opening the file.

To install this program, select Advanced Installation > Custom Installation and put a check mark in this program when you install the 
printer driver.

 

• HDD should be installed on your machine, to print files using this program. 

• You cannot print PDF files that are restricted. Deactivate the printing restriction feature and retry printing.

• You cannot print PDF files that are restricted by a password. Deactivate the password feature, and retry printing.

Job Encryption

Encrypts printing data first, and transmits it to the machine. This feature protects the printing information even 
though the data is snatched on a network.

 

Job Encryption feature is enabled only when the hard drive is installed. The hard drive is used to decrypt 
the printing data.

 

Item Description
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• Whether or not a PDF file can be printed using the Direct 
Printing Utility program depends on how the PDF file was 
created.

• The Direct Printing Utility program supports PDF version 
1.7 and below. For higher versions, you must open the file 
to print it.

 

Printing

There are several ways you can print using the Direct Printing Utility.

1 From the Start menu select Programs or All Programs > 
Samsung Printers > Direct Printing Utility > Direct Printing 
Utility.

The Direct Printing Utility window appears.

2 Select your machine from the Select Printer drop-down list 
and click Browse.

3 Select the file you wish to print and click Open.

The file is added in the Select Files section.

4 Customize the machine settings for your needs. 

5 Click Print. The selected PDF file is sent to the machine.

Using the right-click menu

1 Right-click on the PDF file to print and select Direct Printing.

The Direct Printing Utility window appears with the PDF file is 
added.

2 Select the machine to use.

3 Customize the machine settings. 

4 Click Print. The selected PDF file is sent to the machine.
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Macintosh printing

Printing a document

When you print with a Macintosh, you need to check the printer 
driver settings in each application you use. Follow the steps below to 
print from a Macintosh:

1 Open the document to print.

2 Open the File menu and click Page Setup (Document Setup 
in some applications).
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3 Choose your paper size, orientation, scaling, other options, 
and make sure that your machine is selected. Click OK.

4 Open the File menu and click Print. 

5 Choose the number of copies and indicate which pages to 
print. 

6 Click Print.

Changing printer settings

You can use advanced printing features when using your machine.

Open an application and select Print from the File menu. The 
machine name, which appears in the printer properties window, 
may differ depending on the machine in use. Except for the name, 
the composition of the printer properties window is similar to the 
following.

Printing multiple pages on one sheet 

You can print more than one page on a single sheet of paper. This 
feature provides a cost-effective way to print draft copies.

1 Open an application, and select Print from the File menu.

2 Select Layout from the drop-down list under Orientation. In 
the Pages per Sheet drop-down list, select the number of 
pages you want to print on one sheet of paper.

3 Select the other options to use.

4 Click Print. 

The machine prints the selected number of pages to print on 
one sheet of paper.

Printing on both sides of the paper

Before printing in the duplex mode, decide on which edge you will 
be binding your finished document. The binding options are, as 
follows:

• Long-Edge Binding: This option is the conventional layout used 
in book binding.

• Short-Edge Binding: This option is the type often used with 
calendars.

1 From your Macintosh application, select Print from the File 
menu.

2 Select Layout from the drop-down list under Orientation. 
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3 Select a binding orientation from the Two-Sided option.

4 Select the other options to use.

5 Click Print and the machine prints on both sides of the paper.

 

If you print more than 2 copies, the first copy and the second 
copy might print on the same sheet of paper. Avoid printing 
on both sides of paper when you are printing more than 1 
copy.

 

Using help

Click the question mark on the bottom-left corner of the window and 
click on the topic you want to know about. A pop-up window 
appears with information about that option's feature, which is 
provided from the driver. 
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Linux printing

Printing from applications

There are a lot of Linux applications that allow you to print using 
Common UNIX Printing System (CUPS). You can print on your 
machine from any such application.
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1 Open an application, and select Print from the File menu

2 Select Print directly using lpr.

3 In the LPR GUI window, select the model name of your 
machine from the printer list and click Properties.

4 Change the print job properties using the following four tabs 
displayed at the top of the window.

• General: Changes the paper size, the paper type, and the 
orientation of the documents. It enables the duplex 
feature(if your machine supports it), adds start and end 
banners, and changes the number of pages per sheet.

• Text: Specifies the page margins and set the text options, 
such as spacing or columns.

• Graphics: Sets image options that are used when printing 
image files, such as color options, image size, or image 
position.

• Advanced: Sets the print resolution, paper source, and 
destination.

5 Click Apply to apply the changes and close the Properties 
window.

6 Click OK in the LPR GUI window to start printing.

7 The Printing window appears, allowing you to monitor the 
status of your print job.

To abort the current job, click Cancel.

Printing files

You can print many different types of files on your machine using the 
standard CUPS, directly from the command line interface. The CUPS 
lpr utility allows you to do that, but the driver’s package replaces the 
standard lpr tool by a much more user-friendly LPR GUI program.

To print any document file:

1 Enter lpr <file_name> from the Linux shell command line and 
press Enter. The LPR GUI window appears.

When you type only lpr and press Enter, the Select file(s) to 
print window appears first. Just select any files you want to 
print and click Open.

2 In the LPR GUI window, select your machine from the list, and 
change the print job properties.

3 Click OK to start printing.
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Configuring Printer Properties

Using the Printer Properties window provided by the Printers 
configuration, you can change the various properties for your 
machine as a printer.

1 Open the Unified Driver Configurator.

If necessary, switch to Printers configuration.

2 Select your machine on the available printers list and click 
Properties.

3 The Printer Properties window appears.

The following five tabs display at the top of the window:

• General: Allows you to change the printer location and 
name. The name entered in this tab displays on the printer 
list in Printers configuration.

• Connection: Allows you to view or select another port. If 
you change the machine port from USB to parallel or vice 
versa while in use, you must re-configure the machine port 
in this tab.

• Driver: Allows you to view or select another machine 
driver. By clicking Options, you can set the default device 
options.

• Jobs: Shows the list of print jobs. Click Cancel job to cancel 
the selected job and select the Show completed jobs 
check box to see previous jobs on the job list.

• Classes: Shows the class that your machine is in. Click Add 
to Class to add your machine to a specific class or click 
Remove from Class to remove the machine from the 
selected class.

4 Click OK to apply the changes and close the Printer 
Properties window.
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Unix printing 

Proceeding the print job

After installing the printer, choose any of the image, text, PS or HPGL 
files to print.

1 Execute “printui <file_name_to_print>” command.

For example, if you are printing “document1”

printui document1

This will open the UNIX Printer Driver Print Job Manager in 
which the user can select various print options.

2 Select a printer that has been already added.



Printing features 1094. Special features

3 Select the printing options from the window such as Page 
Selection.

4 Select how many copies are needed in Number of Copies.

 

To take advantage of the printer features provided by your 
printer driver, press Properties (see "Changing printer 
settings" on page 105).

 

5 Press OK to start the print job.

Changing the machine settings

The UNIX printer driver Print Job Manager in which the user can 
select various print options in printer Properties.

The following hot keys may also be used: “H” for Help, “O” for OK, “A” 
for Apply, and “C” for Cancel.

� General tab

• Paper Size: Set the paper size as A4, Letter, or other paper sizes, 
according to your requirements.

• Paper Type: Choose the type of the paper. Options available in 
the list box are Printer Default, Plain, and Thick.

• Paper Source: Select from which tray the paper is used. By 
default, it is Auto Selection.

• Orientation: Select the direction in which information is printed 
on a page.

• Duplex: Print on both sides of paper to save paper.

• Multiple pages: Print several pages on one side of the paper.

• Page Border: Choose any of the border styles (e.g., Single-line 
hairline, Double-line hairline)

� Image tab

In this tab, you can change the brightness, resolution, or image 
position of your document.

� Text  tab

Set the character margin, line space, or the columns of the actual 
print output.

� HPGL/2 tab

• Use only black pen: To print all graphics in black.

• Fit plot to page: Fit the entire graphic into a single page.
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� Margins tab

• Use Margins: Set the margins for the document. By default, 
margins are not enabled. The user can change the margin 
settings by changing the values in the respective fields. Set by 
default, these values depend on the page size selected.

• Unit: Change the units to points, inches, or centimeters.

� Printer-Specific Settings tab

Select various options in the JCL and General frames to customize 
various settings. These options are specific to the printer and depend 
on the PPD file.
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Automatic redialing

When the number you have dialed is busy or there is no answer 
when you send a fax, the machine automatically redials the number. 
The redial time depends on the country's factory default setting. To 
change the time interval between redials and the number of redial 
attempts. 

When the display shows Retry Redial?, press Start button to redial 
the number without waiting. To cancel the automatic redialing, 
press  (Cancel or Stop/Clear). 

18 

Redialing the last number

1 Press Redial/Pause on the control panel. 

2 When an original is loaded in the document feeder, the 
machine automatically begins to send.

If an original is placed on the scanner glass, select Yes to add 
another page. Load another original and press OK. When you 
have finished, select No when Another Page? appears.
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Receiving manually in Tel mode

You can receive a fax call by pressing On Hook Dial and then 
pressing Start when you hear a fax tone.
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Receiving in Answering Machine/Fax mode

To use this mode, you must attach an answering machine to the EXT 
socket on the back of your machine. If the caller leaves a message, 
the answering machine stores the message. If your machine detects 
a fax tone on the line, it automatically starts to receive the fax.

 

• If you have set your machine to this mode and your 
answering machine is switched off, or no answering 
machine is connected to EXT socket, your machine 
automatically goes into Fax mode after a predefined 
number of rings.

• If the answering machine has a user-selectable ring 
counter, set the machine to answer incoming calls within 
1 ring.

• If the machine is in Tel mode, disconnect or switch off the 
answering machine with the fax machine. Otherwise, the 
outgoing message from the answering machine will 
interrupt your phone conversation.
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Receiving faxes with an extension telephone

When you are using an extension telephone connected to the EXT 
socket, you can receive a fax from someone you are talking to on the 
extension telephone, without going to the fax machine.

When you receive a call on the extension phone and hear fax tones, 
press the keys *9* on the extension phone. The machine receives the 
fax.

*9* is the remote receive code preset at the factory. The first and the 
last asterisks are fixed, but you can change the middle number to 
whatever you want.

 

While you are talking over the telephone connected to the 
EXT socket, copy and scan features are not available.
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Receiving faxes using DRPD mode

Distinctive Ring is a telephone company service which enables an 
user to use a single telephone line to answer several different 
telephone numbers. This feature is often used by answering services 
who answer telephones for many different clients and need to know 
which number someone is calling in on to properly answer the 
phone.

1 Select  (Fax) > Menu > Fax Setup > Receiving > DRPD 
Mode > Waiting Ring on the control panel. 

Or select Setup > Machine Setup > Next > Default Setting > 
Fax Default > Common > Receive Mode > DRPD on the 
touch screen.

2 Call your fax number from another telephone. 

3 When your machine begins to ring, do not answer the call. The 
machine requires several rings to learn the pattern.

When the machine completes learning, the display shows 
Completed DRPD Setup. If the DRPD setup fails, Error DRPD 
Ring appears.

4 Press OK when DRPD appears and start over from step 2.

 

• DRPD must be set up again if you re-assign your fax 
number, or connect the machine to another telephone 
line.

• After DRPD has been set up, call your fax number again to 
verify that the machine answers with a fax tone. Then have 
a call placed to a different number assigned to that same 
line to be sure the call is forwarded to the extension 
telephone or answering machine plugged into the EXT 
socket.
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5 Select  (Fax) > Menu > Fax Setup > Receiving > Receive 
Mode > DRM mode on the control panel. 
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Receiving in secure receiving mode

You may need to prevent your received faxes from being accessed 
by unauthorized people. Turn on secure receiving mode, then all 
incoming faxes go into memory. You can print the incoming faxes 
with entering the password. 

 

To use the secure receiving mode, activate the menu from 

 (Fax) > Menu > Fax Feature > Secure Receive on the 
control panel. 

Or select Setup > Machine Setup > Next > Fax Setup > 
Secure Receive on the touch screen.

 

Printing received faxes

1 Select  (Fax) > Menu > Fax Feature > Secure Receive > 
Print on the control panel. 

Or select Setup > Machine Setup > Next > Fax Setup > 
Secure Receive > Print on the touch screen.

2 Enter a four-digit password and press OK. 

3 The machine prints all of the faxes stored in memory.
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Scanning from network connected machine

Make sure the printer driver is installed on your computer using the 
software CD, since the printer driver includes the scan program (see 
Basic Guide).

1 Place a single document face down on the document glass, or 
load the documents face up into the ADF.

2 Select (Scan) > Scan to PC > Network PC on the control 
panel.

Or select Scan  > Network PC on the touch screen.

 

If you see Not Available message, check the port 
connection.

 

3 Select your registered computer ID, and enter the Password if 
necessary.

 

• ID is the same ID as the registered Computer ID for 
Samsung Easy Printer Manager.

• Password is the 4 digit number registered Password for 
Samsung Easy Printer Manager.

 

4 Select the application program you want and press OK.

Default setting is My Documents.

5 Select the option you want and press OK.

 

• Scan Format appears only when you selected the Scan 
destination to My Documents.

• If you want to scan from the default setting, press Start.

 

6 Scanning begins.
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Scanning to email

Setting up an email account

1 Access the SyncThru™ Web Service (see "Using SyncThru™ 
Web Service" on page 130).

2 Select Settings > Network Settings and Outgoing Mail 
Server(SMTP).

3 Enter the IP address in dotted decimal notation or as a host 
name.
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4 Enter the server port number, from 1 to 65535.

5 Check the box next to SMTP Requires Authentication to 
require authentication.

6 Enter the SMTP server login name and password.

7 Press Apply.

 

• If the authentication method of SMTP server is POP3 
before SMTP, put a check mark of SMTP Requires POP 
Before SMTP Authentication.

• Enter the IP address and port number. 

 

Scanning and sending an email

1 Place a single document face down on the document glass, or 
load the documents face up into the ADF.

2 Select (Scan) > Scan to Email on the control panel.

Or select Scan  > Send Email on the touch screen.

3 Enter the login name and password if you configured on 
SyncThru™ Web Service.

4 Enter the sender’s and recipient’s email address.

 

• You can send an email to yourself by activating the Auto 
Send To Self option in the Settings > Scan > Scan To E-
mail on SyncThru™ Web Service.

 

5 Enter an email subject and press OK.

6 Select the file format to scan, and press OK.

7 Enter the SMTP server login name and password.

8 The machine begins scanning and then sends the email.
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Scanning to FTP/SMB server

Setting up an FTP/SMB server

1 Access the SyncThru™ Web Service (see "Using SyncThru™ 
Web Service" on page 130).

2 Select Address Book > Individual > Add.

3 Check the box next to Add FTP or Add SMB.
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4 Enter the IP address in dotted decimal notation or as a host 
name.

5 Enter the server port number, from 1 to 65535.

6 Check the box next to Anonymous, then the server permits 
the access of unauthorized people.

7 Enter the login name and password.

8 Enter the domain name if your server is joined to the certain 
domain, otherwise just enter your computer name which is 
registered to the SMB server.

9 Enter the path for saving the scanned image. 

 

• The folder to save the scanned image must be on the root.

• The folder properties need to be setup as a share.

• Your user name should have the rights to read and write 
the folder.

 

10 Press Apply.

Scanning and sending to FTP/SMB server

1 Make sure that your machine is connected to a network.

2 Place a single document face down on the document glass, or 
load the documents face up into the ADF.

3 Select (Scan) > Scan to SMB or Scan to FTP on the control 
panel.

Or select Scan  > SMB or FTP on the touch screen.

4 Select a server and scan format you want.

5 The machine begins scanning and then sends the scanned 
image to the specified server.
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Scanning from image editing program

You also can scan and import documents at the image editing 
software such as Adobe Photoshop, if the software is TWAIN-
compliant. Follow the steps below to scan with TWAIN-compliant 
software:
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1 Make sure that the machine is connected to your computer 
and powered on.

2 Place a single document face down on the document glass, or 
load the documents face up into the ADF.

3 Open an application, such as Adobe Photoshop.

4 Click File > Import, and select the scanner device.

5 Set the scan options.

6 Scan and save your scanned image.
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Scanning using the WIA driver

Your machine also supports the Windows Image Acquisition (WIA) 
driver for scanning images. WIA is one of the standard components 
provided by Microsoft Windows 7 and works with digital cameras 
and scanners. Unlike the TWAIN driver, the WIA driver allows you to 
scan and easily adjust images without using additional software:

 

The WIA driver works only on Windows OS with a USB port.

 

1 Make sure that the machine is connected to your computer 
and powered on.

2 Place a single document face down on the document glass, or 
load the documents face up into the ADF.

3 Click Start > Control Panel > Hardware and Sound > 
Devices and Printers.

4 Right-click on device driver icon in Printers and Faxes > Start 
Scan.

5 New Scan application appears.

6 Choose your scanning preferences and click Preview to see 
your preferences affect the picture.

7 Scan and save your scanned image.
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Scanning with Samsung Scan Assistant

1 Make sure that the machine is connected to your computer 
and powered on.

2 Place a single document face down on the document glass, or 
load the documents face up into the ADF.



Scan features 1184. Special features

3 Click Start > All programs > Samsung Printers, and start 
Samsung Scan Assistant.

 

Click the Help ( ) button from the upper-right corner of the 
window and click on any option you want to know about. 

 

4 Set the scan options.

5 Click Scan.
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Scanning with SmarThru 4

1 Make sure that the machine is connected to your computer 
and powered on.

2 Place a single document face down on the document glass, or 
load the documents face up into the ADF.

3 Double-click the SmarThru 4 icon.

4 The SmarThru appears.

• Scan to:  You can scan an image and save it to an 
application or folder, email it, or publish it on a web site.

• Image:  You can edit an image and send it to a selected 
application or folder, email it, or publish it on a web site.

• Print:  You can print images you have saved.

 

Click the Help button from the upper-right corner of the 
window and click on any option you want to know about. 

 

5 Click Scan to.

6 Select destination among Application, E-mail, Folder, OCR, 
or Web.

7 If needed, click Settings to customize the settings.

8 Click Scan.
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Scanning with SmarThru Office

 

• To use SmarThru Office, you have to install the program 
manually from the supplied CD. Select Advanced 
Installation > Custom Installation and choose SmarThru 
Office to install.

• You can use the OCR (Optical Character Reader) feature 
from SmarThru Office program.

 

1 Make sure that the machine is connected to your computer 
and powered on.

2 Place a single document face down on the document glass, or 
load the documents face up into the ADF.

3 Double-click the SmarThru Office icon.

4 The SmarThru Office appears.

 

Click the Help ( ) button from the upper-right corner of the 
window and click on any option you want to know about. 

 

5 Click the SmarThru Office icon ( ) in the tray area of the 
Windows taskbar to activate the SmarThru Office launcher.

6 Click the scanning icon ( ) to open the scanning window.

7 The Scan Setting window opens.

8 Set scan settings and click Scan.
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Macintosh scanning

Scanning from USB connected machine

1 Make sure that the machine is connected to your computer 
and powered on.

2 Place a single document face down on the document glass, or 
load the documents face up into the ADF.

3 Start Applications and click Image Capture. 

 

If No Image Capture device connected message appears, 
disconnect the USB cable and reconnect it. If the problem 
continues, refer to the Image Capture’s help.

 



Scan features 1204. Special features

4 Select the option you want. 

5 Scan and save your scanned image.

 

If scanning does not operate in Image Capture, update Mac 
OS to the latest version. Image Capture operates properly in 
Mac OS X 10.4.7 or higher.

 

Scanning from network connected machine

 

The procedures in this user’s guide are mainly based on Mac 
OS X 10.6.

 

1 Make sure that your machine is connected to a network.

2 Place a single document face down on the document glass, or 
load the documents face up into the ADF.

3 Start Applications and click Image Capture. 

4  According to OS, follow steps below. 

• For 10.4

- Click Devices > Browse Devices on Menu bar.

- Select your machine in Twain devices option. Make 
sure that Use TWAIN software checkbox is checked.

-  Click Connect.

If a warning message appears, click Change Port.. to 
select port, or If TWAIN UI appears, click Change Port.. 
from the Preference tab and select a new port.

• For 10.5

- Click Devices > Browse Devices on Menu bar.

- Make sure that Connected checkbox is checked beside 
your machine in Bonjour Devices.

-  If you want to scan using TWAIN, refer to the Mac OS 
X10.4 steps above.

• For 10.6, select your device below SHARED.

5 Set the scan options on this program.

6 Scan and save your scanned image.

 

• If scanning does not operate in Image Capture, update 
Mac OS to the latest version. Image Capture operates 
properly Mac OS X 10.4.7 or higher.

• For more information, refer to the Image Capture’s help.

• You can also scan using TWAIN-compliant software, such 
as Adobe Photoshop.
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Linux scanning

Scanning

1 Make sure that the machine is connected to your computer 
and powered on.

2 Double-click the Unified Driver Configurator on your 
desktop. 

3 Click the  button to switch to Scanners Configuration. 

4 Select the scanner on the list.

5 Click Properties. 

6 Place a single document face down on the document glass, or 
load the documents face up into the ADF.

7 From the Scanner Properties window, click Preview.
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8 The document is scanned and the image preview appears in 
the Preview Pane.

9 Drag the pointer to set the image area to be scanned in the 
Preview Pane.

10 Select the option you want. 

11 Scan and save your scanned image.

 

For later use, you can save as your scan settings and add it to 
the Job Type drop-down list. 

 

Editing an image with Image Manager

The Image Manager application provides you with menu commands 
and tools to edit your scanned image.
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This feature allows you to use the machine’s memory as a shared 
folder. The advantage of this feature is that you can conveniently use 
the shared folder through your computer’s window.

 

• You can use this feature in the models that have a mass 
storage device.

• The administrator can set the ID and password to restrict 
the user’ s access and also set the maximum number of 
simultaneous users.
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Creating a shared folder

1 Open the Windows Explore window from the computer.

2 Enter address  example:  in the 
address field and press the Enter key or click Go.

3 Create a new folder under nfsroot directory.
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Using the shared folder

You can use the shared folder in the same way exactly like the normal 
computer. Create, edit and delete the folder or file as a normal 
Windows folder. You also store the scanned data in the shared folder. 
You can directly print files stored on a the shared folder. You can 
print TIFF, BMP, JPEG and PRN files.
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Some menus may not appear on the display depending on 
options or models. If so, it is not applicable to your machine.
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From the printer driver

After installing the optional memory, you can use advanced printing 
features, such as proofing a job and specifying of printing a private 
job in the Print window. Select Properties or Preference, and 
configure the printing mode.
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From the control panel

If your machine has optional memory or an optional hard drive, you 

can use these features from the Menu button System Setup

> Job Management.

• Active Job All of the print jobs waiting to be printed are listed in 
the active job queue in the order you sent them to the printer. 
You can delete a job from the queue before printing, or promote 
a job to print sooner.

• File Policy You can choose the file policy for generating file 
name before you proceed with the job through optional 
memory. If the optional memory already has the same name 
when you entered a new file name, you can rename or overwrite 
it.

• Stored Job: You can print or delete a stored job.

 

After installing the hard drive, you can also print the 

predefined document templates from the  (Menu) button 
> System Setup > Form Menu.
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1265. MaintenanceStoring the toner cartridge

Toner cartridges contain components that are sensitive to light, 
temperature and humidity. Samsung suggests users follow these 
recommendations to ensure optmal performance, highest quality, 
and longest life from your new Samsung toner cartridge.

Store this cartridge in the same environment in which the printer will 
be used. This should be in controlled temperature and humidity 
conditions. The toner cartridge should remain in its original and 
unopened package until installation – if original packaging is not 
available, cover the top opening of the cartridge with paper and 
store in a dark cabinet.

Opening the cartridge package prior to use dramatically shortens its 
useful shelf and operating life. Do not store on the floor. If the toner 
cartridge is removed from the printer, follow the instructions below 
to store the toner cartridge properly.

• Store the cartridge inside the protective bag from the original 
package. 

• Store lying flat (not standing on end) with the same side facing 
up as if it were installed in the machine.

• Do not store consumables in any of the following conditions:

- Temperature greater than 40°C (104°F).

- Humidity range not less than 20% and not greater than 80%.

- An environment with extreme changes in humidity or 
temperature.

- Direct sunlight or room light.

- Dusty places.

- A car for a long period of time.

- An environment where corrosive gases are present.

- An environment with salty air.

1 

Handling instructions

• Do not touch the surface of the photoconductive drum in the 
cartridge.

• Do not expose the cartridge to unnecessary vibrations or shock.

• Never manually rotate the drum, especially in the reverse 
direction; this can cause internal damage and toner spillage.

2 

Toner cartridge usage

Samsung Electronics does not recommend or approve the use of 
non-Samsung brand toner cartridges in your printer including 
generic, store brand, refilled, or remanufactured toner cartridges.
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Samsung’s printer warranty does not cover damage to the 
machine caused by the use of a refilled, remanufactured, or 
non-Samsung brand toner cartridges.

 

3 

Estimated cartridge life

Estimated cartridge life (the life of the toner cartridge yield) depends 
on the amount of toner that print jobs require. The actual print yield 
may vary depending on the print density of the pages you print on, 
operating environment, printing interval, media type and/or media 
size. For example, if you print a lot of graphics, the consumption of 
the toner is higher and you may need to change the cartridge more 
often.



1285. MaintenanceTips for moving & storing your machine

• When moving the machine, do not tilt or turn it upside down. 
Otherwise, the inside of the machine may be contaminated by 
toner, which can cause damage to the machine or reduce print 
quality.

• When moving the machine, make sure at least two people are 
holding the machine securely. 
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Easy Capture Manager

Capture your screen and launch Easy Capture Manager by simply 
pressing the Print Screen key. Now you can easily print your captured 
screen as captured or edited.

5 

Samsung AnyWeb Print

This tool helps you screen-capture, preview, scrap, and print 
Windows Internet Explorer pages more easily, than when you use an 
ordinary program. Click Start > All programs > Samsung Printers 
> Samsung AnyWeb Print > Download the latest version to link to 
the website where the tool is available for download.

6 

Using a fax in your computer

You can send a fax from your computer without going to the 
machine.

Sending a fax 

To send a fax from your computer, the Samsung Network PC Fax 
program must be installed. This program will be installed when you 
installed the printer driver. 

1 Open the document to be sent.

2 Select Print from the File menu. 

The Print window will be displayed. It may look slightly 
different depending on your application.

3 Select Samsung Network PC Fax from the Print window

4 Click Print or OK.

5 Enter the recipients’ numbers and select the option.

If you want to use a cover page, check Use cover page.

Check Notify me on delivery, when the fax delivered to the 
recipients successfully. 

6 Click Send.

7 

Easy Eco Driver

With the Easy Eco Driver, you can apply Eco features to save paper 
and toner before printing. To use this application, Start Easy Eco 
Driver before printing job checkbox in the printer properties 
should be checked. 
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Easy Eco Driver also allows you simple editing such as removing 
images and texts, changing fonts, and more. You can save frequently 
used settings as a preset.

How to use: 

1 Open a document to print.

2 Print the document.

A preview window appears.

3 Select the options you want to apply to the document.

You can see the preview of the applied features.

4 Click Print.

8 

Using SyncThru™ Web Service

 

• Internet Explorer 6.0 or higher is the minimum 
requirement for SyncThru™ Web Service.

• SyncThru™ Web Service explanation in this user’s guide 
may differ from your machine depending on its options or 
models.

• Network model only.

 

Accessing SyncThru™ Web Service

1 Access a web browser, such as Internet Explorer, from 
Windows.

Enter the machine IP address of your printer (http://
xxx.xxx.xxx.xxx) in the address field and press the Enter key or 
click Go.

2 Your machine’s embedded website opens.

� Logging into SyncThru™ Web Service

Before configuring options in SyncThru™ Web Service, you need to 
log-in as an administrator. You can still use SyncThru™ Web Service 
without logging in but you won’t have access to Settings tab and 
Security tab. 

1 Click Login on the upper right of the SyncThru™ Web Service 
website.

2 Type in the ID and Password then click Login.

• ID: admin 

• Password: sec00000
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SyncThru™ Web Service overview

 

Some tabs may not appear depending on your model.

 

� Information tab

This tab gives you general information about your machine. You can 
check things, such as remaining amount of toner. You can also print 
reports, such as an error report.

• Active Alerts: Shows the alerts that have occurred in the 
machine and their severity.

• Supplies: Shows how many pages are printed and amount of 
toner left in the cartridge.

• Usage Counters: Shows the usage count by print types: simplex 
and duplex.

• Current Settings: Shows the machine’s and network’s 
information. 

• Print information: Prints reports such as system related reports, 
e-mail address, and font reports.

� Settings tab

This tab allows you to set configurations provided by your machine 
and network. You need to log-in as an administrator to view this tab. 

• Machine Settings tab: Sets options provided by your machine. 

• Network Settings tab: Shows options for the network 
environment. Sets options such as TCP/IP and network protocols. 

� Security tab

This tab allows you to set system and network security information. 
You need to log-in as an administrator to view this tab.

• System Security: Sets the system administrator’s information 
and also enables or disables machine features.

• Network Security: Sets settings for HTTPs, IPSec, IPv4/IPv6 
filtering, 802.1x, and Authentication servers.

• User Access Control: Classifies users into several groups 
according to each user’s role. Each user’s authorization, 
authentication and accounting will be controlled by the group’s 
role definition.
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� Maintenance tab

This tab allows you to maintain your machine by upgrading firmware 
and setting contact information for sending emails. You can also 
connect to Samsung website or download drivers by selecting the 
Link menu.

• Firmware Upgrade: Upgrade your machine’s firmware.

• Contact Information: Shows the contact information.

• Link: Shows links to useful sites where you can download or 
check information.

E-mail notification setup

You can receive emails about your machine’s status by setting this 
option. By setting information such as IP address, host name, e-mail 
address and SMTP server information, the machine status (toner 
cartridge shortage or machine error) will be sent to a certain person's 
e-mail automatically. This option may be used more frequently by a 
machine administrator. 

1 Start a web browser, such as Internet Explorer, from Windows.

Enter the machine IP address (http://xxx.xxx.xxx.xxx) in the 
address field and press the Enter key or click Go.

2 Your machine’s embedded website opens.

3 From the Settings tab, select Machine Settings > E-mail 
Notification. 

 

If you have not configured outgoing server environment, go 
to Settings > Network Settings > Outgoing Mail 
Server(SMTP) to configure network environment before 
setting e-mail notification. 

 

4 Select Enable check box to use the E-mail Notification.

5 Click Add button to add e-mail notification user. 

Set the recipient name and e-mail address(es) with 
notification items you want to receive an alert for.

6 Click Apply.

 

If the firewall is activated, the e-mail may not be sent 
successfully. In that case, contact the a network 
administrator.

 

Setting the system administrator’s information

This setting is necessary for using the e-mail notification option.
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1 Start a web browser, such as Internet Explorer, from Windows.

Enter the machine IP address (http://xxx.xxx.xxx.xxx) in the 
address field and press the Enter key or click Go.

2 Your machine’s embedded website opens.

3 From the Security tab, select System Security > System 
Administrator

4 Enter the name of the administrator, phone number, location, 
and email address. 

5 Click Apply. 
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Using Samsung Easy Printer Manager 
(Windows and Macintosh only)

Samsung Easy Printer Manager is an application that combines 
Samsung machine settings into one location. Samsung Easy Printer 
Manager combines device settings as well as printing environments, 
settings/actions and launching. All of these features provide a 
gateway to conveniently use your Samsung machine. Samsung Easy 
Printer Manager provides two different user interfaces for the user to 
choose from: the basic user interface and the advanced user 
interface. Switching between the two interfaces is easy: just click a 
button.

 

For Windows, Internet Explorer 6.0 or higher is the minimum 
requirement for Samsung Easy Printer Manager.

 

Understanding Samsung Easy Printer Manager

To open the program: 

For Windows,

Select Start > Programs or All Programs > Samsung Printers > 
Samsung Easy Printer Manager > Samsung Easy Printer 
Manager.

For Macintosh,

Open the Applications folder > Samsung folder > Samsung Easy 
Printer Manager.

The Samsung Easy Printer Manager interface is comprised of various 
basic sections as described in the table that follows:
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The screenshot may differ depending on operating system 
you are using.

 

1
Printer list The Printer List displays the installed printer icons 

on your computer.

6

3

4

5

 21

2

Printer 
information

This area gives you general information about 
your machine. You can check information, such as 
the machine’s model name, IP address (or Port 
name), and machine status.

 

Troubleshooting button: This button 
opens Troubleshooting Guide when 
an error occurs. You can directly open 
the necessary section in the user’s 
guide. 

 

3

Application 
information

Includes links for changing to the advanced 
settings, preference, help, and about.

 

The  button is used to change the 
user interface to the advanced settings 
user interface ( see "Advanced settings 
user interface overview" on page 135).
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Click the Help ( ) button from the upper-right corner of the 
window and click on any option you want to know about. 

 

Advanced settings user interface overview

The advanced user interface is intended to be used by the person 
responsible for managing the network and machines.

� Device Settings

Click Device Settings > Link to Program button, you can configure 
various machine settings.

� Scan to PC Settings

This menu includes settings to create or delete scan to PC profiles. 

• Scan Activation: Determines whether or not scanning is enabled 
on the device.

• Profile: Displays the scanning profiles saved on the selected 
device.

• Basic tab:  Contains settings related general scan and device
settings.

• Image tab:  Contains settings related to image altering.

� Fax to PC Settings

This menu includes settings related to the basic fax functionality of 
the selected device. 

• Disable: If Disable is On, incoming faxes will not be received on 
this device.

• Enable Fax Receiving from Device: Enables faxing on the 
device and allow more options to be set.

4

Quick links Displays Quick links to machine specific 
functions. This section also includes links to 
applications in the advanced settings.

 

If you connect your machine to a 
network, the SyncThru™ Web Service 
window appears.

 

5

Contents 
area

Displays information about the selected machine, 
remaining toner level, and paper. The information 
will vary based on the machine selected. Some 
machines do not have this feature.

6
Order 
supplies

Click on the Order button from the supply 
ordering window. You can order replacement 
toner cartridge(s) from online.
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� Alert Settings(Windows only)

This menu includes settings related to error alerting. 

• Printer Alert: Provides settings related to when alerts will be 
received.

• Email Alert: Povides options relating to receiving alerts via email.

• Alert History:  Provides a history of device and toner related 
alerts.

� Job Accounting

Provides querying of quota information of the specified job 
accounting user. This quota information can be created and applied 
to devices by job accounting software such as SyncThru™ or 
CounThru™ admin software.

10 

Using Samsung Printer Status (Windows only)

The Samsung Printer Status is a program that monitors and informs 
you of the machine status. 

 

• The Samsung Printer Status window and its contents 
shown in this user’s guide may differ depending on the 
machine or operating system in use.

• Check the operating system(s) that are compatible with 
your machine (see Basic Guide).

 

Samsung Printer Status overview

If an error occurs while operating, you can check the error from the 
Samsung Printer Status. Samsung Printer Status is installed 
automatically when you install the machine software. 

You can also launch Samsung Printer Status manually. Go to the 
Printing Preferences , click the Basic tab > Printer Status button.

These icons appear on the Windows task bar:
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Using Smart Panel ( Linux only)

Smart Panel is a program that monitors and informs you of the 
machine’s status, and allows you to customize the machine’s 
settings. You can download Smart Panel from the Samsung website 
(see "Installing the Smart Panel" on page 8).

 

• The Smart Panel window and its contents shown in this 
user’s guide may differ depending on the machine or 
operating system in use.

• Check the operating system(s) that are compatible with 
your machine (see Basic Guide).

 

Icon Mean Description

Normal The machine is in ready mode and experiencing 
no errors or warnings.

Warning The machine is in a state where an error might 
occur in the future. For example, it might be in 
toner low status, which may lead to toner empty 
status. 

Error The machine has at least one error.

1

Toner Level You can view the level of toner remaining in 
each toner cartridge. The machine and the 
number of toner cartridge(s) shown in the 
above window may differ depending on the 
machine in use. Some machines do not have 
this feature.

1

3 4 2 5

2
Alert Settings Select the settings you want from the options 

window. 

3
Order Supplies You can order replacement toner cartridge(s) 

from online.

4
Troubleshooting You can directly open the troubleshooting 

section in the user’s guide.

5 Close Close the window.
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Smart Panel overview

If an error occurs while operating, you can check the error from the 
Smart Panel. You can also launch Smart Panel manually.

Double-click the Smart Panel icon( ) in the Notification Area.

Changing Smart Panel’s settings

Right-click in Linux on the Smart Panel icon and select Configure 
smart panel. Select the settings you want from the Configure smart 
panel window. 

1

Toner Level You can view the level of toner remaining in 
each toner cartridge. The machine and the 
number of toner cartridge(s) shown in the 
above window may differ depending on the 
machine in use. Some machines do not have 
this feature.

2
Buy Now You can order replacement toner cartridge(s) 

from online.

1

 2

3

4

3

User’s Guide You can view the online User’s Guide.

 

This button opens the 
Troubleshooting Guide when an 
error occurs. You can directly open 
the troubleshooting section in the 
user’s guide. 

 

4

Printer Setting You can configure various machine settings in 
the Printer Settings Utility window. Some 
machines do not have this feature.

 

If you connect your machine to a 
network, the SyncThru™ Web 
Service window appears instead of 
the Printer Settings Utility.
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Using the Linux Unified Driver Configurator

The Unified Driver Configurator is a tool primarily intended for 
configuring machine devices. You need to install Unified Linux 
Driver to use Unified Driver Configurator (see "Installation for Linux" 
on page 8).

After the driver is installed on your Linux system, the Unified Driver 
Configurator icon will automatically be created on your desktop.

Opening Unified Driver Configurator

1 Double-click the Unified Driver Configurator on the 
desktop.

You can also click the Startup Menu icon and select Samsung 
Unified Driver > Unified Driver Configurator.

2 Click each button on the left to switch to the corresponding 
configuration window.  

 

 To use the on screen help, click Help.

 

3 After changing the configurations, click Exit to close the 
Unified Driver Configurator.

Printers configuration

Printers configuration has the two tabs: Printers and Classes.

1 Printer Configuration 
2 Port Configuration 
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� Printers tab

View the current system’s printer configuration by clicking on the 
machine icon button on the left side of the Unified Driver 
Configurator window.

The printer control buttons are, as follows:

• Refresh: Renews the available machines list.

• Add Printer: Allows you to add a new machines.

• Remove Printer: Removes the selected machine.

• Set as Default: Sets the current selected machine as a default 
machine.

• Stop/Start: Stops/starts the machine.

• Test: Allows you to print a test page to ensure the machine is 
working properly.

• Properties: Allows you to view and change the printer’s 
properties. 

� Classes tab

The Classes tab shows a list of available machine classes.

1 Switches to Printers configuration.

2 Shows all of the installed machines.

3
Shows the status, model name, and URI of your 
machine.
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• Refresh: Renews the classes list.

• Add Class: Allows you to add a new machine class.

• Remove Class: Removes the selected machine class.

Ports configuration

In this window, you can view the list of available ports, check the 
status of each port and release a port that is stalled in a busy state 
when its owner has terminated the job for any reason.

• Refresh: Renews the available ports list.

• Release port: Releases the selected port.

1 Shows all of the machine classes.

2
Shows the status of the class and the number of 
machines in the class.

1 Switches to Ports configuration.

2 Shows all of the available ports.

3
Shows the port type, device connected to the 
port, and status.



6. Troubleshooting
This chapter gives helpful information for what to do if you encounter an error.

• Paper feeding problems 143

• Power and cable connecting problems 144

• Printing problems 145

• Printing quality problems 149

• Copying problems 157

• Scanning problems 158

• Faxing problems 160

• Operating system problems 162
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Condition Suggested solutions

Paper jams during printing. Clear the paper jam.

Paper sticks together. • Check the maximum paper capacity of the tray .

• Make sure that you are using the correct type of paper.

• Remove paper from the tray and flex or fan the paper.

• Humid conditions may cause some paper to stick together.

Multiple sheets of paper do not feed. Different types of paper may be stacked in the tray. Load paper of only one type, size, and weight.

Paper does not feed into the 
machine.

• Remove any obstructions from inside the machine.

• Paper has not been loaded correctly. Remove paper from the tray and reload it correctly.

• There is too much paper in the tray. Remove excess paper from the tray.

• The paper is too thick. Use only paper that meets the specifications required by the machine.

The paper keeps jamming. • There is too much paper in the tray. Remove excess paper from the tray. If you are printing on special 
materials, use the multi-purpose tray (or manual feeder).

• An incorrect type of paper is being used. Use only paper that meets the specifications required by the 
machine.

• There may be debris inside the machine. Open the front cover and remove any debris.

Transparencies stick together in the 
paper exit.

Use only transparencies specifically designed for laser printers. Remove each transparency as it exits 
from the machine.

Envelopes skew or fail to feed 
correctly.

Ensure that the paper guides are against both sides of the envelopes.
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Click this link to open an animation about solving power problems.

 

 

 

Condition Suggested solutions

The machine is not receiving power, 

or the connection cable between the 
computer and the machine is not 
connected properly.

• Connect the machine to the electricity supply first. If the machine has a  (Power) button on the 
control, press it. 

• Disconnect the machine’s cable and reconnect it.
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Condition Possible cause Suggested solutions

The machine does not 
print.

The machine is not receiving power. Connect the machine to the electricity supply first. If the machine has a  
(Power) button on the control, press it. 

The machine is not selected as the default 
machine.

Select your machine as your default machine in Windows.

Check the machine for the following:

• The front cover is not closed. Close the front cover.

• Paper is jammed. Clear the paper jam.

• No paper is loaded. Load paper.

• The toner cartridge is not installed. Install the toner cartridge.

If a system error occurs, contact your service representative.

The connection cable between the 
computer and the machine is not 
connected properly.

Disconnect the machine cable and reconnect it.

The connection cable between the 
computer and the machine is defective.

If possible, attach the cable to another computer that is working properly 
and print a job. You can also try using a different machine cable.

The port setting is incorrect. Check the Windows printer settings to make sure that the print job is sent 
to the correct port. If the computer has more than one port, make sure that 
the machine is attached to the correct one.

The machine may be configured 
incorrectly. 

Check the Printing Preferences to ensure that all of the print settings are 
correct.
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The machine does not 
print.

The printer driver may be incorrectly 
installed.

Uninstall and reinstall the machine’s driver.

The machine is malfunctioning. Check the display message on the control panel to see if the machine is 
indicating a system error. Contact a service representative.

The document size is so big that the hard 
disk space of the computer is insufficient 
to access the print job.

Get more hard disk space and print the document again.

The output tray is full. Once the paper is removed from the output tray, the machine resumes 
printing.

The machine selects 
print materials from 
the wrong paper 
source.

The paper option that was selected in the 
Printing Preferences may be incorrect.

For many software applications, the paper source selection is found under 
the Paper tab within the Printing Preferences. Select the correct paper 
source. See the printer driver help screen.

A print job is 
extremely slow.

The job may be very complex. Reduce the complexity of the page or try adjusting the print quality 
settings.

Half the page is blank. The page orientation setting may be 
incorrect.

Change the page orientation in your application. See the printer driver help 
screen.

The paper size and the paper size settings 
do not match.

Ensure that the paper size in the printer driver settings matches the paper 
in the tray.

Or, ensure that the paper size in the printer driver settings matches the 
paper selection in the software application settings you use.

Condition Possible cause Suggested solutions
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The machine prints, 
but the text is wrong, 
garbled, or 
incomplete.

The machine cable is loose or defective. Disconnect the machine cable and reconnect. Try a print job that you have 
already printed successfully. If possible, attach the cable and the machine 
to another computer that you know works and try a print job. Finally, try a 
new machine cable.

The wrong printer driver was selected. Check the applicatinon’s printer selection menu to ensure that your 
machine is selected.

The software application is 
malfunctioning.

Try printing a job from another application.

The operating system is malfunctioning. Exit Windows and reboot the computer. Turn the machine off and back on 
again.

If you are in a DOS environment, the font 
setting for your machine may be set 
incorrectly.

See "Changing the font setting" on page 86.

Pages print, but they 
are blank.

The toner cartridge is defective or out of 
toner.

Redistribute the toner, if necessary. 

If necessary, replace the toner cartridge.

The file may have blank pages. Check the file to ensure that it does not contain blank pages.

Some parts, such as the controller or the 
board, may be defective.

Contact a service representative.

Condition Possible cause Suggested solutions
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The machine does not 
print PDF files 
correctly. Some parts 
of graphics, text, or 
illustrations are 
missing.

Incompatibility between the PDF file and 
the Acrobat products.

Printing the PDF file as an image may enable the file to print. Turn on Print 
As Image from the Acrobat printing options. 

 

It will take longer to print when you print a PDF file as an image.

 

The print quality of 
photos is not good. 
Images are not clear.

The resolution of the photo is very low. Reduce the photo size. If you increase the photo size in the software 
application, the resolution will be reduced. 

Before printing, the 
machine emits vapor 
near the output tray.

Using damp paper can cause vapor during 
printing.

This is not a problem. Just keep printing.

The machine does not 
print special-sized 
paper, such as billing 
paper.

Paper size and paper size setting do not 
match.

Set the correct paper size in the Custom in Paper tab in Printing 
Preferences.

The printed billing 
paper is curled.

The paper type setting does not match. Change the printer option and try again. Go to Printing Preferences , click 
Paper tab, and set type to Thick.

Condition Possible cause Suggested solutions
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If the inside of the machine is dirty or paper has been loaded improperly, there might be a reduction in print quality. See the table below to 
clear the problem. 
 

Condition Suggested solutions

Light or faded print • If a vertical white streak or faded area appears on the page, the toner supply is low. Install a new toner cartridge.

• The paper may not meet paper specifications; for example, the paper may be too moist or rough.

• If the entire page is light, the print resolution setting is too low or the toner save mode is on. Adjust the print 
resolution and turn the toner save mode off. See the help screen of the printer driver.

• A combination of faded or smeared defects may indicate that the toner cartridge needs cleaning. Clean the 
inside of your machine.

• The surface of the LSU part inside the machine may be dirty. Clean the inside of your machine. If these steps do 
not correct the problem, contact a service representative.

The top half of the paper is 
printed lighter than the 
rest of the paper

The toner might not adhere properly to this type of paper.

• Change the printer option and try again. Go to Printing Preferences, click the Paper tab, and set the paper type 
to Recycled.
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Toner specks • The paper may not meet specifications; for example, the paper may be too moist or rough.

• The transfer roller may be dirty. Clean the inside of your machine.

• The paper path may need cleaning. Contact a service representative.

Dropouts If faded areas, generally rounded, occur randomly on the page:

• A single sheet of paper may be defective. Try reprinting the job.

• The moisture content of the paper is uneven or the paper has moist spots on its surface. Try a different brand of 
paper.

• The paper lot is bad. The manufacturing processes can cause some areas to reject toner. Try a different kind or 
brand of paper.

• Change the printer option and try again. Go to Printing Preferences, click the Paper tab, and set type to Thick.

If these steps do not correct the problem, contact a service representative.

White Spots If white spots appear on the page:

• The paper is too rough and a lot of dirt from paper falls to the inner components within the machine, so the 
transfer roller may be dirty. Clean the inside of your machine.

• The paper path may need cleaning. Clean the inside of your machine.

If these steps do not correct the problem, contact a service representative.

Condition Suggested solutions

A aB bC c
A aB bC c
A aB bC c
A aB bC c
A aB bC c

A a B b C
A a B b C
A a B b C
A a B b C
A a B b C
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Vertical lines If black vertical streaks appear on the page:

• The surface (drum part) of the toner cartridge inside the machine has probably been scratched. Remove the 
toner cartridge and install a new one.

If white vertical streaks appear on the page:

• The surface of the LSU part inside the machine may be dirty. Clean the inside of your machine. If these steps do 
not correct the problem, contact a service representative.

Black or color background If the amount of background shading becomes unacceptable:

• Change to a lighter weight paper.

• Check the environmental conditions: very dry conditions or a high level of humidity (higher than 80% RH) can 
increase the amount of background shading.

• Remove the old toner cartridge and install a new one.

Toner smear • Clean the inside of the machine.

• Check the paper type and quality.

• Remove the toner cartridge and install a new one.

Condition Suggested solutions
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Vertical repetitive defects If marks repeatedly appear on the printed side of the page at even intervals:

• The toner cartridge may be damaged. If you still have the same problem, remove the toner cartridge and, install 
a new one.

• Parts of the machine may have toner on them. If the defects occur on the back of the page, the problem will 
likely correct itself after a few more pages.

• The fusing assembly may be damaged. Contact a service representative.

Background scatter Background scatter results from bits of toner randomly distributed on the printed page. 

• The paper may be too damp. Try printing with a different batch of paper. Do not open packages of paper until 
necessary so that the paper does not absorb too much moisture.

• If background scatter occurs on an envelope, change the printing layout to avoid printing over areas that have 
overlapping seams on the reverse side. Printing on seams can cause problems.

• If background scatter covers the entire surface area of a printed page, adjust the print resolution through your 
software application or in Printing Preferences. Ensure the correct paper type is selected. For example: If 
Thicker Paper is selected, but Plain Paper actually used, an overcharging can occur causing this copy quality 
problem.

Toner particles are around 
bold characters or pictures

The toner might not adhere properly to this type of paper.

• Change the printer option and try again. Go to Printing Preferences, click the Paper tab, and set the paper type 
to Recycled. 

• Ensure the correct paper type is selected. For example: If Thicker Paper is selected, but Plain Paper actually used, 
an overcharging can occur causing this copy quality problem.

Condition Suggested solutions

A
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Misformed characters • If characters are improperly formed and producing hollow images, the paper stock may be too slick. Try 
different paper.

Page skew • Ensure that the paper is loaded properly.

• Check the paper type and quality.

• Ensure that the guides are not too tight or too loose against the paper stack.

Curl or wave • Ensure that the paper is loaded properly.

• Check the paper type and quality. Both high temperature and humidity can cause paper curl.

• Turn the stack of paper over in the tray. Also try rotating the paper 180° in the tray.

Condition Suggested solutions
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Wrinkles or creases • Ensure that the paper is loaded properly.

• Check the paper type and quality.

• Turn the stack of paper over in the tray. Also try rotating the paper 180° in the tray.

Back of printouts are dirty • Check for leaking toner. Clean the inside of the machine.

Solid color or black pages • The toner cartridge may not be installed properly. Remove the cartridge and reinsert it.

• The toner cartridge may be defective. Remove the toner cartridge and install a new one.

• The machine may require repairing. Contact a service representative.

Condition Suggested solutions

A
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Loose toner • Clean the inside of the machine.

• Check the paper type and quality.

• Remove the toner cartridge and then, install a new one.

If the problem persists, the machine may require repair. Contact a service representative.

Character voids Character voids are white areas within parts of characters that should be solid black:

• If you are using transparencies, try another type of transparency. Because of the composition of transparencies, 
some character voids are normal. 

• You may be printing on the wrong surface of the paper. Remove the paper and turn it around. 

• The paper may not meet paper specifications.

Horizontal stripes If horizontally aligned black streaks or smears appear:

• The toner cartridge may be installed improperly. Remove the cartridge and reinsert it.

• The toner cartridge may be defective. Remove the toner cartridge and install a new one.

If the problem persists, the machine may require repairing. Contact a service representative.

Condition Suggested solutions

A
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Curl If the printed paper is curled or paper does not feed into the machine:

• Turn the stack of paper over in the tray. Also try rotating the paper 180° in the tray. 

• Change the printer’s paper option and try again. Go to Printing Preferences, click the Paper tab, and set type 
to Thin.

• An unknown image 
repetitively appears on a 
few sheets

• Loose toner

• Light print or 
contamination occurs

Your machine is probably being used at an altitude of 1,000 m (3,281 ft) or above.

The high altitude may affect the print quality, such as loose toner or light imaging. Change the altitude setting for 
your machine (See "Altitude adjustment" on page 85).

Condition Suggested solutions
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Condition Suggested solutions

Copies are too light or too 
dark.

Adjust the darkness in copy feature to lighten or darken the backgrounds of copies.

Smears, lines, marks, or 
spots appear on copies.

• If the defects are on the original, adjust darkness in copy feature to lighten the background of your copies.

• If there are no defects on the original, clean the scan unit.

Copy image is skewed. • Ensure that the original is aligned with the registration guide .

• The transfer roller may be dirty. Clean the inside of your machine.

Blank copies print out. Ensure that the original is face down on the scanner glass or face up in the document feeder.

If these steps do not correct the problem, contact a service representative.

Image rubs off the copy 
easily.

• Replace the paper in the tray with paper from a new package.

• In high humidity areas, do not leave paper in the machine for extended periods of time.

Frequent copy paper jams 
occur.

• Fan the paper, then turn it over in the tray. Replace the paper in the tray with a fresh supply. Check/adjust the 
paper guides, if necessary.

• Ensure that the paper is the proper type and weight.

• Check for copy paper or pieces of copy paper remaining in the machine after a paper jam has been cleared.

Toner cartridge produces 
fewer copies than 
expected before running 
out of toner.

• Your originals may contain pictures, solids, or heavy lines. For example, your originals may be forms, 
newsletters, books, or other documents that use more toner.

• The scanner lid may be left open while copies are being made.

• Turn the machine off and back on.
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Condition Suggested solutions

The scanner does not 
work.

• Make sure that you place the original to be scanned face down on the scanner glass, or face up in the document 
feeder.

• There may not be enough available memory to hold the document you want to scan. Try the Prescan function 
to see if that works. Try lowering the scan resolution rate.

• Check that the machine printer cable is connected properly.

• Make sure that the machine printer cable is not defective. Switch the printer cable with a known good cable. If 
necessary, replace the printer cable.

• Check that the scanner is configured correctly. Check scan setting in the SmarThru Office or the application you 
want to use to make certain that the scanner job is being sent to the correct port (for example, USB001).

The unit scans very slowly. • Check if the machine is printing received data. If so, scan the document after the received data has been printed.

• Graphics are scanned more slowly than text.

• Communication speed slows in scan mode because of the large amount of memory required to analyze and 
reproduce the scanned image. Set your computer to the ECP printer mode through BIOS setting. It will help to 
increase the speed. For details about how to set BIOS, refer to your computer user’s guide.
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Message appears on your 
computer screen:

• Device can’t be set to the 
H/W mode you want.

• Port is being used by 
another program.

• Port is disabled.

• Scanner is busy receiving 
or printing data. When the 
current job is completed, 
try again.

• Invalid handle.

• Scanning has failed.

• There may be a copying or printing job in progress. Try your job again when that job is finished.

• The selected port is currently being used. Restart your computer and try again.

• The machine printer cable may be improperly connected or the power may be off.

• The scanner driver is not installed or the operating environment is not set up properly.

• Ensure that the machine is properly connected and the power is on, then restart your computer.

• The USB cable may be improperly connected or the power may be off.

Condition Suggested solutions
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Condition Suggested solutions

The machine is not 
working, there is no 
display, or the buttons are 
not working.

• Unplug the power cord and plug it in again.

• Ensure that there is power being supplied to the electrical outlet.

• Ensure that the power switch is turned on, and the soft power switch on the control panel is pressed.

No dial tone. • Check that the phone line is properly connected.

• Check that the phone socket on the wall is working by plugging in another phone.

The numbers stored in 
memory do not dial 
correctly.

Make sure that the numbers are stored in memory correctly. To check that, print an addess book list.

The original does not feed 
into the machine.

• Make sure that the paper is not wrinkled and you are inserting it in correctly. Check that the original is the right 
size, not too thick or thin.

• Make sure that the document feeder is firmly closed.

• The document feeder rubber pad may need to be replaced. Contact a service representative.

Faxes are not received 
automatically.

• The receiving mode should be set to fax.

• Make sure that there is paper in the tray.

• Check to see if the display shows any error message. If it does, clear the problem.

The machine does not 
send.

• Make sure that the original is loaded in the document feeder or on the scanner glass.

• Check the fax machine you are sending to, to see if it can receive your fax.



Faxing problems 1616. Troubleshooting

 

The incoming fax has 
blank spaces or is of poor-
quality.

• The fax machine sending you the fax may be faulty.

• A noisy phone line can cause line errors.

• Check your machine by making a copy.

• A toner cartridge has almost reached its estimated cartridge life. Replace the toner cartridge.

Some of the words on an 
incoming fax are 
stretched.

The fax machine sending the fax had a temporary document jam. 

There are lines on the 
originals you sent.

Check your scan unit for marks and clean it.

The machine dials a 
number, but the 
connection with the other 
fax machine fails.

The other fax machine may be turned off, out of paper, or cannot answer incoming calls. Speak with the other 
machine operator and ask them to solve the problem on their side.

Faxes do not store in 
memory.

There may not be enough memory space to store the fax. If the display indicating the memory status shows, delete 
any faxes you no longer need from the memory, and then try to store the fax again. Call for service.

Blank areas appear at the 
bottom of each page or on 
other pages, with a small 
strip of text at the top.

You may have chosen the wrong paper settings in the user option setting. Check the paper size and type again.

Condition Suggested solutions
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1 

Common Windows problems

 

 

 

Refer to the Microsoft Windows User’s Guide that came with your computer for further information on Windows error messages.

 

Condition Suggested solutions

“File in Use” message 
appears during 
installation.

Exit all software applications. Remove all software from the startup group, then restart Windows. Reinstall the 
printer driver.

“General Protection 
Fault”, “Exception OE”, 
“Spool 32”, or “Illegal 
Operation” messages 
appear.

Close all other applications, reboot Windows and try printing again.

“Fail To Print”, “A printer 
timeout error occurred” 
message appear.

These messages may appear during printing. Just keep waiting until the machine finishes printing. If the message 
appears in ready mode or after printing has completed, check the connection and/or whether an error has 
occurred.
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2 

Common Macintosh problems

 

 

 

Refer to the Macintosh User’s Guide that came with your computer for further information on Macintosh error messages.

 

Condition Suggested solutions

The machine does not print PDF 
files correctly. Some parts of 
graphics, text, or illustrations are 
missing.

Printing the PDF file as an image may enable the file to print. Turn on Print As Image from the Acrobat 
printing options. 

 

It will take longer to print when you print a PDF file as an image.

 

Some letters are not displayed 
normally during cover page 
printing.

Mac OS cannot create the font while printing the cover page. The English alphabet and numbers are 
displayed normally on the cover page.

When printing a document in 
Macintosh with Acrobat 
Reader 6.0 or higher, colors print 
incorrectly.

Make sure that the resolution setting in your machine driver matches the one in Acrobat Reader.
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3 

Common Linux problems

 

Condition Suggested solutions

The machine does not 
print.

• Check if the printer driver is installed in your system. Open Unified Driver Configurator and switch to the 
Printers tab in the Printers configuration window to look at the list of available machines. Make sure that 
your machine is displayed on the list. If not, open Add new printer wizard to set up your device.

• Check if the machine is started. Open Printers configuration and select your machine from the printers list. 
Look at the description in the Selected printer pane. If its status contains Stopped, press the Start button. 
Normal operation of the machine should be restored. The “stopped” status might be activated when some 
problems in printing occur. 

• Check if your application has special print options such as “-oraw”. If “-oraw” is specified in the command line 
parameter, then remove it to print properly. For Gimp front-end, select “print” -> “Setup printer” and edit the 
command line parameter in the command item.

Some color images come 
out all black.

This is a known bug in Ghostscript (until GNU Ghostscript version 7.05) when the base color space of the 
document is indexed color space and it is converted through CIE color space. Because Postscript uses CIE color 
space for Color Matching System, you should upgrade Ghostscript on your system to at least GNU Ghostscript 
version 7.06 or later. You can find recent Ghostscript versions at www.ghostscript.com.

Some color images come 
out in unexpected color.

This is a known bug in Ghostscript (until GNU Ghostscript version 7.xx) when the base color space of the 
document is indexed RGB color space and it is converted through CIE color space. Because Postscript uses CIE 
color space for Color Matching System, you should upgrade Ghostscript on your system to at least GNU 
Ghostscript version 8.xx or later. You can find recent Ghostscript versions at www.ghostscript.com.
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The machine does not 
print whole pages, and 
output is printed on half 
the page.

It is a known problem that occurs when a color machine is used on version 8.51 or earlier of Ghostscript, 64-bit 
Linux OS, and has been reported to bugs.ghostscript.com as Ghostscript Bug 688252.The problem is solved in 
AFPL Ghostscript v. 8.52 or above. Download the latest version of AFPL Ghostscript from http://sourceforge.net/
projects/ghostscript/ and install it to solve this problem.

I cannot scan via Gimp 
Front-end.

Check if Gimp Front-end has Xsane:Device dialog. on the Acquire menu. If not, you should install Xsane plug-in 
for Gimp on the your computer. You can find Xsane plug-in package for Gimp on Linux distribution CD or Gimp 
home page. For the detailed information, refer to the Help for Linux distribution CD or Gimp Front-end 
application. 

If you wish to use another kind of scan application, refer to application’s Help.

“Cannot open port device 
file” error message 
appears when printing a 
document.

Avoid changing print job parameters (e.q., via LPR GUI) while a print job is in progress. Known versions of CUPS 
server break the print job whenever print options are changed and then try to restart the job from the beginning. 
Since Unified Linux Driver locks the port while printing, the abrupt termination of the driver keeps the port locked 
and unavailable for subsequent print jobs. If this situation occurs, try to release the port by selecting Release port 
in the Port configuration window.

Condition Suggested solutions
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Refer to the Linux User’s Guide that came with your computer for further information on Linux error messages.

 

The machine does not 
appear on the scanners 
list.

• Ensure your machine is attached to your computer, connected properly via the USB port, and is turned on.

• Ensure the scanner driver for your machine is installed in your system. Open Unified Linux Driver configurator, 
switch to Scanners configuration, then press Drivers. Make sure that driver with a name corresponding to your 
machine's name is listed in the window. 

• Ensure the port is not busy. Since functional components of machine (printer and scanner) share the same I/O 
interface (port), the situation of simultaneous access of different user applications to the same port is possible. 
To avoid possible conflicts, only one of them at a time is allowed to gain control over the device. The other user 
will encounter “device busy” response. This usually happens when starting a scan procedure. An appropriate 
message box appears.
To identify the source of the problem, open the Ports configuration and select the port assigned to your 
scanner, port's symbol /dev/mfp0 corresponds to LP:0 designation displayed in the scanners’ options, /dev/
mfp1 relates to LP:1, and so on. USB ports start at /dev/mfp4, so scanner on USB:0 relates to /dev/mfp4 
respectively and so forth sequentially. In the Selected port pane, you can see if the port is occupied by another 
application. If this is the case, you should either wait for completion of the current job or press the Release port 
button, if you are sure that the present port applicaton is not functioning properly.

The machine does not 
scan.

• Ensure a document is loaded into the machine, ensure your machine is connected to the computer.

• If there is an I/O error while scanning.

Condition Suggested solutions
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4 

Common PostScript problems

The following situations are PS language specific and may occur when several printer languages are used.
 

 

Problem Possible cause Solution

The PostScript file cannot 
be printed

The PostScript driver may not be installed 
correctly.

• Install the PostScript driver (see "Software installation" on page 4).

• Print a configuration page and verify that the PS version is available 
for printing.

• If the problem persists, contact a service representative.

Limit Check Error report 
prints

The print job was too complex. You might need to reduce the complexity of the page or install more 
memory.

A PostScript error page 
prints

The print job may not be PostScript. Make sure that the print job is a PostScript job. Check to see whether 
the software application expected a setup or PostScript header file to 
be sent to the machine.

The optional tray is not 
selected in the driver

The printer driver has not been 
configured to recognize the optional tray.

Open the PostScript driver properties, select the Device Options tab, 
and set the tray option.

When printing a document 
in Macintosh with Acrobat 
Reader 6.0 or higher, 
colors print incorrectly

The resolution setting in the printer driver 
may not be matched with the one in 
Acrobat Reader.

Make sure that the resolution setting in your printer driver matches 
the one in Acrobat Reader.
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If you have any comments or questions regarding Samsung 
products, contact the Samsung customer care center.

Country/Region Customer Care Center Web Site

ALBANIA 42 27 5755

ARGENTINE 0800-333-3733 www.samsung.com

ARMENIA 0-800-05-555

AUSTRALIA 1300 362 603 www.samsung.com

AUSTRIA
0810-SAMSUNG (7267864, € 
0.07/min)

www.samsung.com

AZERBAIJAN 088-55-55-555

BAHRAIN 8000-4726 www.samsung.com

BELARUS 810-800-500-55-500

BELGIUM

02-201-24-18 www.samsung.com
/be (Dutch)

www.samsung.com
/be_fr (French)

BOSNIA 05 133 1999

BRAZIL
0800-124-421

4004-0000

www.samsung.com

BULGARIA 07001 33 11 www.samsung.com

CANADA 1-800-SAMSUNG (726-7864) www.samsung.com

CHILE 800-SAMSUNG (726-7864) www.samsung.com

CHINA 400-810-5858 www.samsung.com

COLOMBIA 01-8000112112 www.samsung.com

COSTA RICA 0-800-507-7267 www.samsung.com

CROATIA
062 SAMSUNG (062 726 
7864)

www.samsung.com

CZECH 
REPUBLIC

800-SAMSUNG (800-
726786)

www.samsung.com

Samsung Zrt., česká organizační složka, Oasis 
Florenc, Sokolovská394/17, 180 00, Praha 8

DENMARK 70 70 19 70 www.samsung.com

DOMINICA 1-800-751-2676 www.samsung.com

ECUADOR 1-800-10-7267 www.samsung.com

EGYPT 0800-726786 www.samsung.com

EIRE 0818 717100 www.samsung.com

EL SALVADOR 800-6225 www.samsung.com

ESTONIA 800-7267 www.samsung.com

FINLAND 030-6227 515 www.samsung.com

Country/Region Customer Care Center Web Site
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FRANCE 01 48 63 00 00 www.samsung.com

GERMANY
01805 - SAMSUNG (726-
7864 € 0,14/min)

www.samsung.com

GEORGIA 8-800-555-555

GREECE

IT and Mobile : 80111-
SAMSUNG (80111 7267864) 
from land line, local charge/ 
from mobile, 210 6897691 

Cameras, Camcorders, 
Televisions and Household 
Appliances

From mobile and fixed 
2106293100

www.samsung.com

GUATEMALA 1-800-299-0013 www.samsung.com

HONDURAS 800-27919267 www.samsung.com

HONG KONG

(852) 3698-4698 www.samsung.com
/hk

www.samsung.com
/hk_en/

HUNGARY 06-80-SAMSUNG (726-7864) www.samsung.com

Country/Region Customer Care Center Web Site

INDIA
3030 8282

1800 3000 8282 

www.samsung.com

INDONESIA
0800-112-8888

021-5699-7777

www.samsung.com

IRAN 021-8255 www.samsung.com

ITALY 800-SAMSUNG (726-7864) www.samsung.com

JAMAICA 1-800-234-7267 www.samsung.com

JAPAN 0120-327-527 www.samsung.com

JORDAN 800-22273 www.samsung.com

KAZAKHSTAN
8-10-800-500-55-500 
(GSM:7799)

www.samsung.com

KOSOVO +381 0113216899

KUWAIT 183-2255 www.samsung.com

KYRGYZSTAN 00-800-500-55-500 www.samsung.com

LATVIA 8000-7267 www.samsung.com

LITHUANIA 8-800-77777 www.samsung.com

LUXEMBURG 261 03 710 www.samsung.com

MALAYSIA 1800-88-9999 www.samsung.com

Country/Region Customer Care Center Web Site



Contact SAMSUNG worldwide 170

MACEDONIA 023 207 777

MEXICO
01-800-SAMSUNG (726-
7864)

www.samsung.com

MOLDOVA 00-800-500-55-500

MONTENEGRO 020 405 888

MOROCCO 080 100 2255 www.samsung.com

NIGERIA 080-SAMSUNG(726-7864) www.samsung.com

NETHERLANDS
0900-SAMSUNG (0900-
7267864) (€ 0,10/min)

www.samsung.com

NEW ZEALAND
 0800 SAMSUNG (0800 726 
786)

www.samsung.com

NICARAGUA 00-1800-5077267 www.samsung.com

NORWAY 815-56 480 www.samsung.com

OMAN 800-SAMSUNG (726-7864) www.samsung.com

PANAMA 800-7267 www.samsung.com

PERU 0-800-777-08 www.samsung.com

Country/Region Customer Care Center Web Site

PHILIPPINES

1800-10-SAMSUNG (726-
7864)

1-800-3-SAMSUNG (726-
7864)

1-800-8-SAMSUNG (726-
7864)

02-5805777

www.samsung.com

POLAND
0 801 1SAMSUNG (172678)

022-607-93-33

www.samsung.com

PORTUGAL
80820-SAMSUNG (726-
7864)

www.samsung.com

PUERTO RICO 1-800-682-3180 www.samsung.com

RUMANIA

08010 SAMSUNG (08010 
726 7864) only from 
landline, local network 
Romtelecom - local tariff /

021 206 01 10 for landline 
and mobile, normal tariff.

www.samsung.com

RUSSIA 8-800-555-55-55 www.samsung.com

SAUDI ARABIA 9200-21230 www.samsung.com

SERBIA
0700 SAMSUNG (0700 726 
7864)

www.samsung.com

Country/Region Customer Care Center Web Site
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SINGAPORE 1800-SAMSUNG (726-7864) www.samsung.com

SLOVAKIA 0800-SAMSUNG (726-7864) www.samsung.com

SOUTH AFRICA 0860 SAMSUNG (726-7864) www.samsung.com

SPAIN
902-1-SAMSUNG(902 172 
678)

www.samsung.com

SWEDEN 0771 726 7864 (SAMSUNG) www.samsung.com

SWITZERLAND

0848-SAMSUNG (7267864, 
CHF 0.08/min)

www.samsung.com
/ch

www.samsung.com
/ch_fr/

TADJIKISTAN 8-10-800-500-55-500 www.samsung.com

TAIWAN 0800-329-999 www.samsung.com

THAILAND
1800-29-3232

02-689-3232

www.samsung.com

TRINIDAD & 
TOBAGO

1-800-SAMSUNG (726-7864) www.samsung.com

TURKEY 444 77 11 www.samsung.com

U.A.E 800-SAMSUNG (726-7864) www.samsung.com

U.K 0330 SAMSUNG (726-7864) www.samsung.com

Country/Region Customer Care Center Web Site

U.S.A 1-800-SAMSUNG (726-7864) www.samsung.com

UKRAINE
0-800-502-000 www.samsung.ua

www.samsung.com
/ua_ru

UZBEKISTAN 8-10-800-500-55-500 www.samsung.com

VENEZUELA 0-800-100-5303 www.samsung.com

VIETNAM 1 800 588 889 www.samsung.com

Country/Region Customer Care Center Web Site
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The following glossary helps you get familiar with the 
product by understanding the terminologies commonly 
used with printing as well as mentioned in this user’s guide.

 

802.11

802.11 is a set of standards for wireless local area network (WLAN) 
communication, developed by the IEEE LAN/MAN Standards 
Committee (IEEE 802). 

802.11b/g/n

802.11b/g/n can share same hardware and use the 2.4 GHz band. 
802.11b supports bandwidth up to 11 Mbps, 802.11n supports 
bandwidth up to 150 Mbps. 802.11b/g/n devices may occasionally 
suffer interference from microwave ovens, cordless telephones, and 
Bluetooth devices.

Access point

Access Point or Wireless Access Point (AP or WAP) is a device that 
connects wireless communication devices together on wireless local 
area networks (WLAN), and acts as a central transmitter and receiver 
of WLAN radio signals. 

ADF

An Automatic Document Feeder (ADF) is a scanning unit that will 
automatically feed an original sheet of paper so that the machine 
can scan some amount of the paper at once. 

AppleTalk

AppleTalk is a proprietary suite of protocols developed by Apple, Inc 
for computer networking. It was included in the original Macintosh 
(1984) and is now deprecated by Apple in favor of TCP/IP 
networking.

BIT Depth

A computer graphics term describing the number of bits used to 
represent the color of a single pixel in a bitmapped image. Higher 
color depth gives a broader range of distinct colors. As the number 
of bits increases, the number of possible colors becomes 
impractically large for a color map. 1-bit color is commonly called as 
monochrome or black and white.

BMP

A bitmapped graphics format used internally by the Microsoft 
Windows graphics subsystem (GDI), and used commonly as a simple 
graphics file format on that platform.
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BOOTP

Bootstrap Protocol. A network protocol used by a network client to 
obtain its IP address automatically. This is usually done in the 
bootstrap process of computers or operating systems running on 
them. The BOOTP servers assign the IP address from a pool of 
addresses to each client. BOOTP enables 'diskless workstation' 
computers to obtain an IP address prior to loading any advanced 
operating system.

CCD

Charge Coupled Device (CCD) is a hardware which enables the scan 
job. CCD Locking mechanism is also used to hold the CCD module to 
prevent any damage when you move the machine.

Collation

Collation is a process of printing a multiple-copy job in sets. When 
collation is selected, the device prints an entire set before printing 
additional copies.

Control Panel

A control panel is a flat, typically vertical, area where control or 
monitoring instruments are displayed. They are typically found in 
front of the machine. 

Coverage

It is the printing term used for a toner usage measurement on 
printing. For example, 5% coverage means that an A4 sided paper 
has about 5% image or text on it. So, if the paper or original has 
complicated images or lots of text on it, the coverage will be higher 
and at the same time, a toner usage will be as much as the coverage.

CSV

Comma Separated Values (CSV). A type of file format, CSV is used to 
exchange data between disparate applications. The file format, as it 
is used in Microsoft Excel, has become a de facto standard 
throughout the industry, even among non-Microsoft platforms.

DADF

A Duplex Automatic Document Feeder (DADF) is a scanning unit that 
will automatically feed and turn over an original sheet of paper so 
that the machine can scan on both sides of the paper.

Default

The value or setting that is in effect when taking a printer out of its 
box state, reset, or initialized.
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DHCP

A Dynamic Host Configuration Protocol (DHCP) is a client-server 
networking protocol. A DHCP server provides configuration 
parameters specific to the DHCP client host requesting, generally, 
information required by the client host to participate on an IP 
network. DHCP also provides a mechanism for allocation of IP 
addresses to client hosts.

DIMM

Dual Inline Memory Module (DIMM), a small circuit board that holds 
memory. DIMM stores all the data within the machine like printing 
data, received fax data.

DLNA

The Digital Living Network Alliance (DLNA) is a standard that allows 
devices on a home network to share information with each other 
across the network.

DNS

The Domain Name Server (DNS) is a system that stores information 
associated with domain names in a distributed database on 
networks, such as the Internet.

Dot Matrix Printer

A dot matrix printer refers to a type of computer printer with a print 
head that runs back and forth on the page and prints by impact, 
striking an ink-soaked cloth ribbon against the paper, much like a 
typewriter.

DPI

Dots Per Inch (DPI) is a measurement of resolution that is used for 
scanning and printing. Generally, higher DPI results in a higher 
resolution, more visible detail in the image, and a larger file size.

DRPD 

Distinctive Ring Pattern Detection. Distinctive Ring is a telephone 
company service which enables a user to use a single telephone line 
to answer several different telephone numbers.

Duplex

A mechanism that will automatically turn over a sheet of paper so 
that the machine can print (or scan) on both sides of the paper. A 
printer equipped with a Duplex Unit can print on both sides of paper 
during one print cycle.
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Duty Cycle

Duty cycle is the page quantity which does not affect printer 
performance for a month. Generally the printer has the lifespan 
limitation such as pages per year. The lifespan means the average 
capacity of print-outs, usually within the warranty period. For 
example, if the duty cycle is 48,000 pages per month assuming 20 
working days, a printer limits 2,400 pages a day.

ECM

Error Correction Mode (ECM) is an optional transmission mode built 
into Class 1 fax machines or fax modems. It automatically detects 
and corrects errors in the fax transmission process that are 
sometimes caused by telephone line noise.

Emulation

Emulation is a technique of one machine obtaining the same results 
as another.

An emulator duplicates the functions of one system with a different 
system, so that the second system behaves like the first system. 
Emulation focuses on exact reproduction of external behavior, 
which is in contrast to simulation, which concerns an abstract model 
of the system being simulated, often considering its internal state.

Ethernet

Ethernet is a frame-based computer networking technology for local 
area networks (LANs). It defines wiring and signaling for the physical 
layer, and frame formats and protocols for the media access control 
(MAC)/data link layer of the OSI model. Ethernet is mostly 
standardized as IEEE 802.3. It has become the most widespread LAN 
technology in use during the 1990s to the present.

EtherTalk

A suite of protocols developed by Apple Computer for computer 
networking. It was included in the original Macintosh (1984) and is 
now deprecated by Apple in favor of TCP/IP networking. 

FDI

Foreign Device Interface (FDI) is a card installed inside the machine 
to allow a third party device such as a coin operated device or a card 
reader. Those devices allow the pay-for-print service on your 
machine.

FTP

A File Transfer Protocol (FTP) is a commonly used protocol for 
exchanging files over any network that supports the TCP/IP protocol 
(such as the Internet or an intranet).
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Fuser Unit 

The part of a laser printer that fuses the toner onto the print media. 
It consists of a heat roller and a pressure roller. After toner is 
transferred onto the paper, the fuser unit applies heat and pressure 
to ensure that the toner stays on the paper permanently, which is 
why paper is warm when it comes out of a laser printer.

Gateway

A connection between computer networks, or between a computer 
network and a telephone line. It is very popular, as it is a computer or 
a network that allows access to another computer or network.

Grayscale

A shades of gray that represent light and dark portions of an image 
when color images are converted to grayscale; colors are 
represented by various shades of gray.

Halftone

An image type that simulates grayscale by varying the number of 
dots. Highly colored areas consist of a large number of dots, while 
lighter areas consist of a smaller number of dots.

HDD

Hard Disk Drive (HDD), commonly referred to as a hard drive or hard 
disk, is a non-volatile storage device which stores digitally-encoded 
data on rapidly rotating platters with magnetic surfaces.

IEEE

The Institute of Electrical and Electronics Engineers (IEEE) is an 
international non-profit, professional organization for the 
advancement of technology related to electricity.

IEEE 1284

The 1284 parallel port standard was developed by the Institute of 
Electrical and Electronics Engineers (IEEE). The term "1284-B" refers 
to a specific connector type on the end of the parallel cable that 
attaches to the peripheral (for example, a printer). 

Intranet

A private network that uses Internet Protocols, network connectivity, 
and possibly the public telecommunication system to securely share 
part of an organization's information or operations with its 
employees. Sometimes the term refers only to the most visible 
service, the internal website.
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IP address

An Internet Protocol (IP) address is a unique number that devices use 
in order to identify and communicate with each other on a network 
utilizing the Internet Protocol standard.

IPM

The Images Per Minute (IPM) is a way of measuring the speed of a 
printer. An IPM rate indicates the number of single-sided sheets a 
printer can complete within one minute.

IPP

The Internet Printing Protocol (IPP) defines a standard protocol for 
printing as well as managing print jobs, media size, resolution, and 
so forth. IPP can be used locally or over the Internet to hundreds of 
printers, and also supports access control, authentication, and 
encryption, making it a much more capable and secure printing 
solution than older ones.

IPX/SPX

IPX/SPX stands for Internet Packet Exchange/Sequenced Packet 
Exchange. It is a networking protocol used by the Novell NetWare 
operating systems. IPX and SPX both provide connection services 
similar to TCP/IP, with the IPX protocol having similarities to IP, and 
SPX having similarities to TCP. IPX/SPX was primarily designed for 
local area networks (LANs), and is a very efficient protocol for this 
purpose (typically its performance exceeds that of TCP/IP on a LAN).

ISO

The International Organization for Standardization (ISO) is an 
international standard-setting body composed of representatives 
from national standards bodies. It produces world-wide industrial 
and commercial standards.

ITU-T

The International Telecommunication Union is an international 
organization established to standardize and regulate international 
radio and telecommunications. Its main tasks include 
standardization, allocation of the radio spectrum, and organizing 
interconnection arrangements between different countries to allow 
international phone calls. A -T out of ITU-T indicates 
telecommunication.
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ITU-T No. 1 chart

Standardized test chart published by ITU-T for document facsimile 
transmissions.

JBIG

Joint Bi-level Image Experts Group (JBIG) is an image compression 
standard with no loss of accuracy or quality, which was designed for 
compression of binary images, particularly for faxes, but can also be 
used on other images.

JPEG

Joint Photographic Experts Group (JPEG) is a most commonly used 
standard method of lossy compression for photographic images. It is 
the format used for storing and transmitting photographs on the 
World Wide Web.

LDAP

The Lightweight Directory Access Protocol (LDAP) is a networking 
protocol for querying and modifying directory services running over 
TCP/IP.

LED

A Light-Emitting Diode (LED) is a semiconductor device that 
indicates the status of a machine.

MAC address

Media Access Control (MAC) address is a unique identifier associated 
with a network adapter. MAC address is a unique 48-bit identifier 
usually written as 12 hexadecimal characters grouped in pairs (e. g., 
00-00-0c-34-11-4e). This address is usually hard-coded into a 
Network Interface Card (NIC) by its manufacturer, and used as an aid 
for routers trying to locate machines on large networks.

MFP

Multi Function Peripheral (MFP) is an office machine that includes 
the following functionality in one physical body, so as to have a 
printer, a copier, a fax, a scanner and etc.
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MH

Modified Huffman (MH) is a compression method for decreasing the 
amount of data that needs to be transmitted between the fax 
machines to transfer the image recommended by ITU-T T.4. MH is a 
codebook-based run-length encoding scheme optimized to 
efficiently compress white space. As most faxes consist mostly of 
white space, this minimizes the transmission time of most faxes. 

MMR

Modified Modified READ (MMR) is a compression method 
recommended by ITU-T T.6.

Modem

A device that modulates a carrier signal to encode digital 
information, and also demodulates such a carrier signal to decode 
transmitted information.

MR

Modified Read (MR) is a compression method recommended by ITU-
T T.4. MR encodes the first scanned line using MH. The next line is 
compared to the first, the differences determined, and then the 
differences are encoded and transmitted.

NetWare

A network operating system developed by Novell, Inc. It initially used 
cooperative multitasking to run various services on a PC, and the 
network protocols were based on the archetypal Xerox XNS stack. 
Today NetWare supports TCP/IP as well as IPX/SPX.

OPC

Organic Photo Conductor (OPC) is a mechanism that makes a virtual 
image for print using a laser beam emitted from a laser printer, and 
it is usually green or rust colored and has a cylinder shape. 

An imaging unit containing a drum slowly wears the drum surface by 
its usage in the printer, and it should be replaced appropriately since 
it gets worn from contact with the cartridge development brush, 
cleaning mechanism, and paper.

Originals

The first example of something, such as a document, photograph or 
text, etc, which is copied, reproduced or translated to produce 
others, but which is not itself copied or derived from something else.
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OSI

Open Systems Interconnection (OSI) is a model developed by the 
International Organization for Standardization (ISO) for 
communications. OSI offers a standard, modular approach to 
network design that divides the required set of complex functions 
into manageable, self-contained, functional layers. The layers are, 
from top to bottom, Application, Presentation, Session, Transport, 
Network, Data Link and Physical.

PABX 

A private automatic branch exchange (PABX) is an automatic 
telephone switching system within a private enterprise.

PCL

Printer Command Language (PCL) is a Page Description Language 
(PDL) developed by HP as a printer protocol and has become an 
industry standard. Originally developed for early inkjet printers, PCL 
has been released in varying levels for thermal, dot matrix printer, 
and laser printers.

PDF

Portable Document Format (PDF) is a proprietary file format 
developed by Adobe Systems for representing two dimensional 
documents in a device independent and resolution independent 
format.

PostScript

PostScript (PS) is a page description language and programming 
language used primarily in the electronic and desktop publishing 
areas. - that is run in an interpreter to generate an image.

Printer Driver

A program used to send commands and transfer data from the 
computer to the printer.

Print Media

The media like paper, envelopes, labels, and transparencies which 
can be used in a printer, a scanner, a fax or, a copier.
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PPM

Pages Per Minute (PPM) is a method of measurement for 
determining how fast a printer works, meaning the number of pages 
a printer can produce in one minute.

PRN file

An interface for a device driver, this allows software to interact with 
the device driver using standard input/output system calls, which 
simplifies many tasks. 

Protocol

A convention or standard that controls or enables the connection, 
communication, and data transfer between two computing 
endpoints.

PS

See PostScript.

PSTN

The Public-Switched Telephone Network (PSTN) is the network of 
the world's public circuit-switched telephone networks which, on 
industrial premises, is usually routed through the switchboard.

RADIUS

Remote Authentication Dial In User Service (RADIUS) is a protocol for 
remote user authentication and accounting. RADIUS enables 
centralized management of authentication data such as usernames 
and passwords using an AAA (authentication, authorization, and 
accounting) concept to manage network access.

Resolution

The sharpness of an image, measured in Dots Per Inch (DPI). The 
higher the dpi, the greater the resolution.

SMB

Server Message Block (SMB) is a network protocol mainly applied to 
share files, printers, serial ports, and miscellaneous communications 
between nodes on a network. It also provides an authenticated Inter-
process communication mechanism.
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SMTP

Simple Mail Transfer Protocol (SMTP) is the standard for e-mail 
transmissions across the Internet. SMTP is a relatively simple, text-
based protocol, where one or more recipients of a message are 
specified, and then the message text is transferred. It is a client-
server protocol, where the client transmits an email message to the 
server.

SSID

Service Set Identifier (SSID) is a name of a wireless local area network 
(WLAN). All wireless devices in a WLAN use the same SSID in order to 
communicate with each other. The SSIDs are case-sensitive and have 
a maximum length of 32 characters.

Subnet Mask 

The subnet mask is used in conjunction with the network address to 
determine which part of the address is the network address and 
which part is the host address.

TCP/IP

The Transmission Control Protocol (TCP) and the Internet Protocol 
(IP); the set of communications protocols that implement the 
protocol stack on which the Internet and most commercial networks 
run.

TCR

Transmission Confirmation Report (TCR) provides details of each 
transmission such as job status, transmission result and number of 
pages sent. This report can be set to print after each job or only after 
failed transmissions.

TIFF

Tagged Image File Format (TIFF) is a variable-resolution bitmapped 
image format. TIFF describes image data that typically come from 
scanners. TIFF images make use of tags, keywords defining the 
characteristics of the image that is included in the file. This flexible 
and platform-independent format can be used for pictures that have 
been made by various image processing applications.
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Toner Cartridge

A kind of bottle or container used in a machine like a printer which 
contains toner. Toner is a powder used in laser printers and 
photocopiers, which forms the text and images on the printed paper. 
Toner can be fused by by a combination of heat/pressure from the 
fuser, causing it to bind to the fibers in the paper.

TWAIN

An industry standard for scanners and software. By using a TWAIN-
compliant scanner with a TWAIN-compliant program, a scan can be 
initiated from within the program. It is an image capture API for 
Microsoft Windows and Apple Macintosh operating systems.

UNC Path

Uniform Naming Convention (UNC) is a standard way to access 
network shares in Window NT and other Microsoft products. The 
format of a UNC path is: \\<servername>\<sharename>\<Additional 
directory>

URL

Uniform Resource Locator (URL) is the global address of documents 
and resources on the Internet. The first part of the address indicates 
what protocol to use, the second part specifies the IP address or the 
domain name where the resource is located.

USB

Universal Serial Bus (USB) is a standard that was developed by the 
USB Implementers Forum, Inc., to connect computers and 
peripherals. Unlike the parallel port, USB is designed to concurrently 
connect a single computer USB port to multiple peripherals.

Watermark

A watermark is a recognizable image or pattern in paper that 
appears lighter when viewed by transmitted light. Watermarks were 
first introduced in Bologna, Italy in 1282; they have been used by 
papermakers to identify their product, and also on postage stamps, 
currency, and other government documents to discourage 
counterfeiting.
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WEP

Wired Equivalent Privacy (WEP) is a security protocol specified in IEEE 
802.11 to provide the same level of security as that of a wired LAN. 
WEP provides security by encrypting data over radio so that it is 
protected as it is transmitted from one end point to another.

WIA

Windows Imaging Architecture (WIA) is an imaging architecture that 
is originally introduced in Windows Me and Windows XP. A scan can 
be initiated from within these operating systems by using a WIA-
compliant scanner.

WPA

Wi-Fi Protected Access (WPA) is a class of systems to secure wireless 
(Wi-Fi) computer networks, which was created to improve upon the 
security features of WEP.

WPA-PSK

WPA-PSK (WPA Pre-Shared Key) is special mode of WPA for small 
business or home users. A shared key, or password, is configured in 
the wireless access point (WAP) and any wireless laptop or desktop 
devices. WPA-PSK generates a unique key for each session between 
a wireless client and the associated WAP for more advanced security.

WPS

The Wi-Fi Protected Setup (WPS) is a standard for establishing a 
wireless home network. If your wireless access point supports WPS, 
you can configure the wireless network connection easily without a 
computer.

XPS

XML Paper Specification (XPS) is a specification for a Page 
Description Language (PDL) and a new document format, which has 
benefits for portable document and electronic document, 
developed by Microsoft. It is an XML-based specification, based on a 
new print path and a vector-based device-independent document 
format.



185Index

A

address book
editing 91

general setup 80

group editing 92

group registering 91

registering 90

using 90

address book setup 90

administrator’s setup 82

AnyWeb Print 129

authorized users
registering 93

C

Changing 86

copy
general setup 61

custom setup 83

D

direct printing utility 103

document box 80

general setup 80

driver installation

Unix 25

E

email
general setup 79

email address 87

searching 87

storing 87

emulation
general setup 79

Emulation setup 79

entering character 89

F

fax
automatic redialing 111

general setup 66

receiving in Answering Machine mode 111

receiving in DRPD mode 112

receiving in Fax mode 111

receiving in secure mode 113

receiving in Tel mode 111

receiving with ext. telephone 112

redialing the last number 111

fax feature 111

features

machine features 59

font setting 86

G

general settings 71

glossary 172

L

LCD display
browsing the machine status 61 65 66 69

75

Linux
common Linux problems 164

driver installation for network connected 23

driver installation for USB cable connected
8

driver reinstallation for USB cable connected
10

printer properties 108

printing 106

scanning 121

unifled driver configurator 139

using SetIP 15

Linux scanning 121



Index 186

M

machine information 61 65 66 69 75

machine setup
machine status 61 65 66 69 75

Macintosh
common Macintosh problems 163

driver installation for network connected 22

driver installation for USB cable connected
5

driver reinstallation for USB cable connected
7

printing 104

scanning 119

using SetIP 14

Macintosh scanning 119

memory/hard drive feature 123 124

N

network
driver installation

Linux 23
Macintosh 22
UNIX 25
Windows 17

general setup 80

introducing network programs 12

IPv6 configuration 28

SetIP program 13 14 15 53

wired network setup 13

wireless network setup 31

N-up printing
Macintosh 105

O

overlay printing
create 100

delete 101

print 101

P

placing a machine
adjusting the altitude 85

PostScript driver
troubleshooting 167

print
general setup 60

Print Menu 60

print resolution set
Linux 107

printer preferences
Linux 108

Printer Status
general information 136 137

printing
changing the default print settings 94

Linux 106

Macintosh 104

multiple pages on one sheet of paper
Macintosh 105

printing on both sides of paper
Macintosh 105

printing to a file 95

setting as a default machine 94

special printer features 95

UNIX 108

using direct printing utility 103

printing a document
Linux 106

Macintosh 104

UNIX 108

printing feature 94

problem
operating system problems 162

problems
copying problems 157

faxing problems 160

paper feeding problems 143



Index 187

power problems 144

printing problems 145

printing quality problems 149

scanning problems 158

R

reports
machine information 61 66 67 68 70 71

72 75 76

S

Samsung Printer Status 136

scan
general setup 69

Scan Assitant 117

scan feature 114

Scanning
Scanning with Samsung Scan Assitant 117

Scanning with SmarThru 4 118

scanning
Linux scanning 121

Macintosh scanning 119

Scanning from image editing program 116

Scanning from network connected machine
114

Scanning to email 114

Scanning to FTP/SMB server 115

Scanning using the WIA driver 117

Scanning with SmarThru Office 119

service contact numbers 168

SetIP program 13 53

SmarThru 4 118

SmarThru Office 119

Special features 84

Storing 87

supplies
estimated toner cartridge life 127

SyncThru Web Service
general information 130

SyncThru™ Web Service 130

T

toner cartridge
estimated life 127

handling instructions 126

non-Samsung and refilled 126

storing 126

U

UNIX
driver installation for network connected 25

printing 108

usb 79

general setupusb 79

USB cable
driver installation 5 8

driver reinstallation 7 10

using help 106

W

watermark
create 99

delete 99

edit 99

Windows
common Windows problems 162

driver installation for network connected 17

using SetIP 13 53

wireless
ad hoc mode 31

computer 31

control panel 31

Infrastructure mode 31

installation 31

USB cable 38

WPS
disconnectiong 34



Index 188

PBC mode 33

WPS (the machine does not have a display 
screen)

PBC 34
PIN 35

wireless network
network cable 52




